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XP-830 User's Guide

Welcome to the XP-830 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics

See these sections to learn about the basic features of your product.

Using the Control Panel

Product Parts Locations

The Sleep Timer

Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint

Using Google Cloud Print

Using the Mopria Print Service

Using the Control Panel

See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights

Using the LCD Screen

Adjusting Control Panel Position

Changing LCD Screen Language

Turning Off Control Panel Sounds

Turning Off Auto Selection Mode

Turning On Quiet Mode

Parent topic: Product Basics
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Control Panel Buttons and Lights

12 A
A .
[5 <>

I

The O power button and the O power light
The M home button

The LCD screen

The up and down arrows

The A Output Tray button

The 3 Back button

The < Start button

N O o WN -

Parent topic: Using the Control Panel
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Using the LCD Screen

Print
Lopy Photos

Output Tray

1 Displays the screen name
2  Displays network status; tap the icons to check the current status
3  Tap the arrows to display other features or menus

You can also swipe the center of the screen to scroll up or down.
To view a list of the icons and a description of their use, select Help > Icon List.
Parent topic: Using the Control Panel
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Adjusting Control Panel Position

You can adjust the position of the control panel to make it easier to access. Raise or lower it to the
desired angle as shown.

Note: The control panel rises and the output tray slides out automatically when printing starts.
Parent topic: Using the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.
1. Press the M home button, if necessary.
2. Select Setup.
You see this screen:

Setup

ﬁ Ink Levels

* Hamtenance

Printer Setup
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Select Language.
Select a language.

o a0 bk w

Press the M home button to exit.
Parent topic: Using the Control Panel

Turning Off Control Panel Sounds

Scroll down and select Basic Setup.

You can turn off the sound heard when you press buttons on the control panel.

1. Press the M home button, if necessary.

2. Select Setup.
3. Select Printer Setup.
You see this screen:
Printer Setup

Paper Source Setting

CO/DVD Migrment

Thick Paper

4. Scroll down and select Sound.

5. Select Button Press.

6. Select the Off setting.

7. Press the & home button to exit.
Parent topic: Using the Control Panel

v
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Turning Off Auto Selection Mode

Auto Selection Mode changes the menu options on the LCD screen automatically depending on the
action you perform. For instance, loading a memory card displays memory card-related menu options on
the screen. You can turn off this feature from the control panel.

1. Press the f home button, if necessary.
2. Select Setup.
You see this screen:

Setup

@ Ink Levels

* Hamtenance

Printer Setup

Scroll down and select Guide Functions.
Select Auto Selection Mode.
Turn off the desired options displayed on the screen.

o a0 bk w

Press the M home button to exit.
Parent topic: Using the Control Panel

Turning On Quiet Mode

You can reduce the noise the product makes by turning on the Quiet Mode option.
Note: Turning on this setting may reduce print speed.
1. Press the M home button, if necessary.

2. Select Setup.
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3. Select Printer Setup.
You see this screen:
Printer Setup

Paper Source Setting

CO/DVD dligriment L J

Thick Pager

4. Scroll down and select Quiet Mode.
5. Select On.

6. Press the M home button to exit.
Parent topic: Using the Control Panel

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Front
Product Parts - Top
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics
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Product Parts - Front

Paper cassette 1

Paper cassette 2
Front cover

A WODN -~

Edge guide




1

2
3

Output tray
Cassette 1
Cassette 2/front cover

Parent topic: Product Parts Locations

Product Parts - Top

N OO oA WN -

ADF (Automatic Document Feeder)

ADF cover

ADF edge guide

ADF input tray

ADF output tray extension

ADF output tray

CD/DVD tray (shown removed and in storage position)
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Document cover
Scanner glass
Memory card slot and access light

A WO DN -

74 USB Type A port for external devices

Parent topic: Product Parts Locations
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Product Parts - Inside

Print head/ink cartridge holder
Scanner unit

Control panel

A WODN -~

Output tray

Parent topic: Product Parts Locations

26



Product Parts - Back

A WODN -~

AC inlet
Rear cover (duplexer)

Vents
LINE port
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Rear paper feed slot

Paper support
Rear paper feed slot cover

A W N -

Edge guides
Parent topic: Product Parts Locations

The Sleep Timer

The product enters sleep mode if it is not used for a period of time. You can adjust the time period before
sleep mode, but increasing the time reduces the product's energy efficiency.

Changing the Sleep Timer Setting From the Control Panel
Changing the Sleep Timer Setting - Windows
Changing the Sleep Timer Setting - OS X

Parent topic: Product Basics

Changing the Sleep Timer Setting From the Control Panel

You can use the product's control panel to change the time period before the product enters sleep mode.
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Press the M home button, if necessary.
Select Setup.
Select Printer Setup.

o nh =~

Scroll down and select Sleep Timer.
You see this screen:

Gleep Timer

Jminutes

aminutes

10minutes

5. Select the time period you want before the product goes to sleep.
6. Press the M home button to exit.
Parent topic: The Sleep Timer

Changing the Sleep Timer Setting - Windows
You can use the printer software to change the time period before the printer enters sleep mode.
1. Make sure your product is turned on.

2. Access the Windows Desktop, right-click the product icon in the Windows taskbar, and select
Printer Settings.

3. Click the Maintenance tab.
4. Click the Printer and Option Information button.
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You see this screen:

Printer and Option Information

Sleep Timer

Current Printer Setting : 10 mnutes

10 minutes W Send

Printer ID

D 185 Settings Sheet...

Option information has aready been stored, Therefore, you do notneed to
enter any information.

CK Cancel Help

5. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
6. Click Send.

7. Click OK to close the program windows.

Parent topic: The Sleep Timer

Changing the Sleep Timer Setting - OS X
You can use the printer software to change the time period before the printer enters sleep mode.
1. Make sure your product is turned on.

2. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

3. Select Printer Settings.
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You see this screen:

a8 0 Epson Printer Utility 4

BEuy Epson Ink

10 minutes

Cancel | Apply |

4. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
5. Click Apply.

6. Close the Printer Settings window.

Parent topic: The Sleep Timer

Epson Connect Solutions for Smartphones, Tablets, and More

You can print documents, photos, emails, and web pages from your home, office, or even across the
globe. You can use your smartphone, tablet, or computer. Epson offers these solutions to print from
anywhere: Epson Email Print, Epson iPrint Mobile App, Epson Remote Print, and Epson Scan to Cloud.

Using Epson Email Print

Using the Epson iPrint Mobile App
Using Epson Remote Print

Using Epson Scan to Cloud

Parent topic: Product Basics
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Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product.

1. Set up your product for network printing. See the link below.

2. If you did not already set up Email Print when you installed your product software, visit
epson.com/connect to learn more about Email Print, check compatibility, and get detailed setup
instructions.

3. Send an email with attachments to your product's Email Print address.

Note: Both the email and any attachments print by default. You can change these printing options by
logging into your Epson Connect account.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App

Use this free Apple and Android app to print to nearby Epson networked products. The Epson iPrint
Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless
network. You can even scan and save a file on your device, send it as an email, or upload it to an online
service such as Box, Dropbox, Evernote, or Google Drive.

1. Set up your product on a network. See the link below.

2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile
device.

3. Download Epson iPrint from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network that your product is using.
5. Print from your mobile device to your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking
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Using Epson Remote Print

With Epson Remote Print software, you can print to an Epson Email-enabled product anywhere in the
world.

1. Set up your product for network printing. See the link below.

2. \Visit epson.com/connect to learn more about Remote Print and how to download the software.
3. Download and install the Remote Print software.
4

Obtain the email address and optional access key of the Epson product you want to use for printing,
and enter this address during Remote Print setup.

5. Select the print command in your application and choose the Remote Print driver for your Epson
product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Scan to Cloud

The Epson Scan to Cloud service sends your scanned files to a destination that you have registered with
Epson Connect.

1. Set up your product for network scanning. See the link below.

2. \Visit epson.com/connect for instructions on registering an account and your product with Epson
Connect.

3. After registering, sign in to the Epson Connect web page with the email address and password you
selected.

4. Select Destination List for Scan to Cloud.
Click Add, then follow the instructions on the screen to create your destination list.

6. When you're ready to scan, select the setting for the Scan to Cloud service on your product control
panel.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking
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Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of
iOS, and Mac with the latest version of OS X.

AirPrint

Note: If you disabled paper configuration messages on your product control panel, you cannot use
AirPrint. See the link below to enable the messages, if necessary.

Load paper in your product.
Set up your product for wireless printing. See the link below.
Connect your Apple device to the same wireless network that your product is using.

b=

Print from your device to your product.
Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics

Related tasks
Selecting the Paper Settings for Each Source - Control Panel

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson printer and computer are connected to the same network before starting
the Google Cloud Print setup.

1. Connect your device to the same network that your Epson product is using.
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Print a network status sheet.
Locate your product's IP address on the network status sheet.
Enter the IP address into the address bar of a web browser.

L S

Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.
Select the checkbox to agree to the Usage Advisory and click Next.
Click OK to launch the sign-in page.
A separate browser window opens.

9. Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Setting Up Google Cloud Print on a Chromebook
Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
Set up your Epson product for network printing. See the link below.

Note: Make sure your Epson product is connected to your wireless network before starting the Google
Cloud Print setup.
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1. Turn on your Chromebook and connect it to the same wireless network as your product.
Note: See your Chromebook's documentation for details on connecting to a network.

2. Do one of the following:

» Click Add to Cloud Print in the natification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

* Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
+ If you see a registration confirmation screen instead, click Register.

3. Click Add Device.

4. Click the Register button that appears next to your product.

5. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation
message.

6. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
iPhone, or Android phone with Internet access. For more information on using Google Cloud Print,
visit Epson Support.

Parent topic: Using Google Cloud Print

Related tasks
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Using the Mopria Print Service

You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to
your Epson product or any Mopria-certified product from other manufacturers. You can download the
Mopria Print Service from Google Play.
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Note: For details on the Mopria Print Service, click here .

Parent topic: Product Basics
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Wired Network Setup

Printing a Network Status Sheet

Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
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Wireless router or access point
Computer with a wireless interface
Computer

Internet

o o0~ W DN

Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings From the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Press the M home button, if necessary.
Select Setup.

Select Network Settings.

Select Wi-Fi Setup.

o nh =~

39



You see this screen:

Wi-Fi Setup

Wi=Fi Fetup Mizard

Push Button Setup (NFS) ¥

PIN Code Setup (NPS)

5. Select Wi-Fi Setup Wizard.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
scroll down and select Disable Wi-Fi instead. Then follow the instructions on changing to a wired
network connection in this guide.

6. Select the name of your wireless network or enter the name manually.

Note: To enter the wireless network name manually, scroll down and then select Other Networks.
Use the displayed keypad to enter your network name, as described in the next step.

40



7. Enter your wireless password (or network name and then password) using the displayed keypad.

| P =

B b Space

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

* Press the touch screen buttons repeatedly to scroll through characters.
* Press &= or =3 to move the cursor.
* Press 1 Symb. to enter symbols.
* Press k=a1to delete the previous character.
Press Done when you finish entering your password.
9. Confirm the displayed network settings and select Proceed to save them.

Note: If you need to change a setting, press the 5 Back button.

10. If you want to print a network setup report, press the < Start button. (Otherwise, select Done.)
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If the network connection is successful, the Network icon on the right side of the LCD screen is blue
as shown:

# Home

Frimt

Copy Photos scan

=T

< & @ i »

Parent topic: Wi-Fi Infrastructure Mode Setup

Related tasks

Changing a Wi-Fi Connection to a Wired Network Connection
Printing a Network Status Sheet

Printing Fax Reports

Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.

L7 (ks
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1 Epson product
2  Computer with a wireless interface
3  Other wireless device

You can select one of these modes to communicate with your computer or device:

Access point mode
The product itself acts as the network access point for up to 4 devices. When operating in this mode,
your product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
The product communicates one-to-one with another Wi-Fi Direct capable device. When operating in
this mode, your product displays a Direct or D connection symbol on the LCD screen.

To disconnect a peer-to-peer mode connection, release the connection to your product from your
computer or other device.

To enable peer-to-peer mode, you must select it from the Web Config Utility, under WiFi/Network
Settings > Services > Wi-Fi Direct.

Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi or Wired Networking

Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point.

1. Press the M home button, if necessary.
2. Select Network.

3. Select Setup.

4. Select Wi-Fi Direct Setup.
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You see this screen:

Wi-Fi Direct Setup

Connection Setup
e —

Disconnac

Defete Registered Device

Select Connection Setup.
Select Change Password and select OK.

Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they will
be disconnected when you change the password.
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7. Enter your Wi-Fi Direct password.

Note: Your password must be at least 8 and no more than 22 characters long.

R A
| st | 2 s 3 e

[ S, - F

4 za o b e Space

* Press the touch screen buttons repeatedly to scroll through characters.
* Press g or =2 to move the cursor.
* Press 1 Symb. to enter symbols.
* Press k=1 to delete the previous character.
8. Press Done when you finish entering your password.
You see this screen:

wouterless Setup

| |r||::|:1_'tc-r|
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9. Scroll down to view the SSID (Wi-Fi network name) and password.

10. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the
LCD screen, then enter the password shown.

11. Press the M home button to exit.

You see either an AP or Direct Wi-Fi symbol on the LCD screen and should be able to print directly
to your product from your computer or device.

Note: If the AP or Direct Wi-Fi symbol is not displayed on the LCD screen, Wi-Fi Direct mode is not
enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the  home button, if necessary.
2. Select Setup.

3. Select Network Settings.

4. Select Wi-Fi Setup.
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You see this screen:

Wi-Fi Setup

Wi=Fi Setup Bizard

Push Button Setup (NFS) ¥

PIN Code Setup (MPS)

5. Select Push Button Setup (WPS).
6. Follow the instructions on the LCD screen to complete WPS setup.
7. Select OK if necessary.

If the network connection is successful, the Network icon on the right side of the LCD screen is blue
as shown:

A Home
Copy ::Ir1ln:r:ll.|:- . Scan

Dgtpasi Tra - QP P
S =

e gl =]

< @ B

Parent topic: Wi-Fi Protected Setup (WPS)
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Wired Network Setup

You can set up your product to communicate with your computer over a wired network by connecting it to
the router or hub using an Ethernet cable.

Epson product

Ethernet cable

Ethernet hub

Computers with a wired network interfaces
Router

oo o0~ WDN -

Internet

Parent topic: Wi-Fi or Wired Networking

Related tasks
Disabling Wi-Fi Features

48



Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

Press the % home button, if necessary.

Select Network.

Select See Connection Details.

Select Details.

Scroll down and select Print Status Sheet.

Press the <& Start button to print the network status sheet.

o g bk wbd -~

(Select Cancel if you want to cancel the operation.)
Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Related tasks
Selecting Wireless Network Settings From the Control Panel

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

1. Print a network status sheet.
2. Locate the IP Address for your product that is listed on the network status sheet.
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3. On acomputer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.

3. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

Disable your product's Wi-Fi features.

Connect one end of an Ethernet network cable to the product's LAN port.

Connect the other end to any available LAN port on your router or access point.
Uninstall your product software.

Download and install your product software from the Epson website.

Follow the on-screen instructions to install the software.

When you see the Select Your Connection screen, select Wired network connection.
If you see a Select Setup Option screen, select Set up printer for the first time.

© o N Ok 0N~

Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections
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Related tasks
Disabling Wi-Fi Features

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
* Windows: Uninstall your product software.
+ 0OS X: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

Press the M home button, if necessary.
Select Setup.

Select Network Settings.

Select Wi-Fi Setup.

b~
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You see this screen:

Wi-Fi Setup

Wi=Fi Fetup Mizard

Push Button Setup (NFS) ¥

PIN Code Setup (NPS)

5. Scroll down and select Disable Wi-Fi.
6. Select Yes to disable Wi-Fi.
Parent topic: Changing or Updating Network Connections
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Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Selecting the Paper Settings for Each Source - Control Panel
Printing on Thick Paper

Turning Off the Paper Setting Alert

Paper Loading Capacity

Available Epson Papers

Borderless Paper Type Compatibility

Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Printer Software

Loading Paper in Cassette 1 (Upper Cassette)
You can load photo paper and other media in these sizes in the upper paper cassette:
* 4 x6inches (102 x 152 mm)
* 5x7inches (127 x 178 mm)

Note: Do not remove or insert the paper cassette during printing.

1. Raise the control panel, if necessary.
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2. Close the output tray by pressing the A Output Tray button or by hand, if necessary.

Note: If the upper cassette is too far inside to reach, turn the product off and on again.

4. Slide the edge guides outward.
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5. Set the front edge guide to the position for the paper size you are using.

4x6”
10x15cm
5x7”
13x18cm
2 R e

6. Insert paper with the glossy or printable side facedown.

Note: Make sure the paper is loaded against the front edge guide and not overlapping the rear of the
cassette.

7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.
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8. Keep the cassette flat as you insert it until the arrow marks on the tray and product line up.

9. If prompted by the product's LCD screen, select the size and type of the paper you loaded, and
select Done.

Note: The output tray opens automatically when you print.

Always follow these paper loading guidelines:
* Load only the recommended number of sheets.
» Load paper short edge first and printable side down.

* Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the
cassette.

» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper in Cassette 2 (Lower Cassette)

Loading Paper in the Rear Paper Feed Slot
Loading Envelopes
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Loading Paper in Cassette 2 (Lower Cassette)
You can load paper up to this size in the lower paper cassette: Legal (8.5 x 14 inches [216 x 356 mm]).

Note: Do not remove or insert the paper cassette during printing.

1. Raise the control panel, if necessary.
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3. Open the front cover and pull on it to remove the lower cassette.

Note: If you are using legal-size paper, remove the CD/DVD tray from the bottom of the lower
cassette. Press the button on the lower cassette and then extend it as shown.
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5. Set the front edge guide to the paper size you are using.

LTR t
A4 ‘
TN D

6. Insert paper with the glossy or printable side facedown.

Note: Make sure the paper is loaded against the edge guide and not sticking out from the end of the
cassette.
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7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.

8. Keep the cassette flat as you insert it.

9. If prompted by the product's LCD screen, select the size and type of the paper you loaded, and
select Done.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected.

60



Always follow these paper loading guidelines:
* Load only the recommended number of sheets.
» Load paper short edge first and printable side down.

» Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the
cassette.

» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper in Cassette 1 (Upper Cassette)

Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Loading Paper in the Rear Paper Feed Slot

You can load one sheet of paper, card stock, or other thick media, or one envelope in the rear paper feed
slot.

Note: Paper that is too stiff may not load correctly. Check the paper specifications.

1. Send your print job from a computer or using the product's touch screen.

« If printing from a computer, select Rear Paper Feed Slot for the Source (Windows) or Paper
Source (OS X) setting.

« If printing from the product's touch screen, select Rear Paper Feed Slot for the Paper Source
setting.

2. Do one of the following:
* If you are printing from a computer, click Print.
« If you are printing from the product's control panel, press the & Start button.
You see a message on the LCD screen, then you see instructions for loading paper.
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3. Flip open the rear paper feed slot cover.

5. Slide the edge guides outward.

e

4
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6. Do one of the following:

» Load a single sheet of paper or thick media, printable side up and short edge first, in the center of
the rear paper feed slot. Push it approximately 2 inches (5 cm) into the slot.

\

* Load an envelope, short edge first with the flap facing down and to the left, in the center of the rear
paper feed slot. Push it approximately 2 inches (5 cm) into the slot.
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» Load a sheet of loose-leaf or other paper with holes as shown, and push it approximately 2 inches
(5 cm) into the slot.

~

8. When you are ready to print, press the <& Start button.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected.

Always follow these loading guidelines:

* Load one sheet or envelope at a time.

» Load the paper or envelope short edge first and printable side faceup.
» Check the paper package for any additional loading instructions.
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Note: If ink smears when you print on thick paper, you can select the Thick Paper setting to improve
print quality.

Parent topic: Loading Paper

Related references

Paper Loading Capacity

Paper Specifications

Related tasks

Loading Envelopes

Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Printing on Thick Paper

Loading Envelopes

You can load envelopes in Cassette 2 (lower cassette) as described here. You can print on plain paper
envelopes in this size: No. 10 (4.1 x 9.5 inches [105 x 241 mm]).

You can also load a single envelope in the rear paper feed slot, as described in that section.
Note: Do not remove or insert the paper cassette during printing.

1. Raise the control panel, if necessary.
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2. Close the output tray by pressing the A Output Tray button or by hand, if necessary.
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Insert up to 10 envelopes, printable side down and flap edge left, as shown.

Note: Make sure the envelopes are not sticking out from the end of the cassette.

Slide the edge guides against the envelopes, but not too tightly.

Note: Make sure the envelopes are under the tabs on the edge guides.
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7. Keep the cassette flat as you insert it.

8. If prompted by the product's LCD screen, select Envelope #10 for the Paper Size and Envelope for
the Paper Type, and select Done.

Note: The output tray opens automatically when you print.

Always follow these envelope loading guidelines:

 If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one
envelope at a time.

» Do not load envelopes that are curled, folded, or too thin.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper in Cassette 2 (Lower Cassette)

Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in the Rear Paper Feed Slot

Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the
product.
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Press the M home button, if necessary.
Select Setup.
Select Printer Setup.

o nh =~

Select Paper Source Setting.
You see this screen:

Paper Source Setting

|1,-:||;|r;!r I::E'I up

Paper Configuration

Note: To turn off the automatic display of the paper settings selection screen after paper is loaded in
the cassettes, set the Paper Configuration setting to Off. If you do this, you will not be able to use
AirPrint.

Select Paper Setup.
Select the paper source you want to change.
Select Paper Size.
Select the paper size you loaded.
Select Paper Type.
. Select the paper type you loaded.

o2 © 0N oo

- O

. Press the 3 Back button to select another paper source to change, or press the f home button to
exit.

Parent topic: Loading Paper
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Printing on Thick Paper

If ink smears when you print on thick paper, you can select the Thick Paper setting to improve print
quality. Printing is slower with this setting.

1. Press the M home button, if necessary.
2. Select Setup.
3. Select Printer Setup.

You see this screen:

Printer Setup

Faper Source Setting

COYDVD Migrnment L J

Thick Paper

4. Select Thick Paper.

5. Select On.

6. Press the f home button to exit.
Parent topic: Loading Paper

Turning Off the Paper Setting Alert

The Paper Setting Alert warns you when the paper settings do not match the paper you loaded. You can
turn off this feature from the control panel.

1. Press the M home button, if necessary.
2. Select Setup.
3. Scroll down and select Guide Functions.

70



You see this screen:

Guide Functions

Papeer Setting Alert

Document #lert

v

fiuto Selection Mode

4. Select Paper Setting Alert.
5. Select Off.

6. Press the M home button to exit.

Parent topic: Loading Paper

Paper Loading Capacity

Load one sheet of paper or one envelope at a time in the rear paper feed slot. See the table here for the
loading capacity of the paper cassettes.

[216 x 279 mm]), A4 (8.3 x 11.7
inches [210 x 297 mm]), or Legal
(8.5 x 14 inches [216 x 356 mm])
size: 100 sheets

Paper type Load up to this many sheets
Cassette 2 (lower cassette) Cassette 1 (upper cassette)
Plain paper Letter (8.5 x 11 inches —

Epson Bright White Paper

Epson Presentation Paper Matte

80 sheets
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Paper type

Load up to this many sheets

Cassette 2 (lower cassette)

Cassette 1 (upper cassette)

Epson Premium Presentation
Paper Matte

Epson Ultra Premium Presentation
Paper Matte

20 sheets

Epson Photo Paper Glossy

Epson Premium Photo Paper
Glossy

Epson Ultra Premium Photo Paper
Glossy

Epson Premium Photo Paper
Semi-gloss

Epson Ultra Premium Photo Paper
Luster

20 sheets

20 sheets

Epson Premium Presentation
Paper Matte Double-sided

Epson Photo Quality Self-adhesive
Sheets

Epson Iron-on Cool Peel Transfer
paper
Epson Velvet Fine Art Paper

Epson Brochure & Flyer Paper
Matte Double-sided

1 sheet

Envelopes

10 envelopes

Parent topic: Loading Paper

Available Epson Papers

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).
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Paper Type

Size

Part number

Sheet count

Epson Bright White Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])
Epson Photo Paper Glossy 4 x 6 inches (102 x 152 mm) | S041809 50
S042038 100
Letter (8.5 x 11 inches S041141 20
[216 x 279 mm]) S041649 50
S041271 100
Epson Premium Photo Paper 4 x 6 inches (102 x 152 mm) | S041808 40
Glossy S041727 100
5x 7 inches (127 x 178 mm) | S041464 20
8 x 10 inches (203 x 254 mm) | S041465 20
Letter (8.5 x 11 inches S042183 25
[216 x 279 mmy) 5041667 50
Epson Ultra Premium Photo Paper |4 x 6 inches (102 x 152 mm) [S042181 60
Glossy S042174 100
5x 7inches (127 x 178 mm) | S041945 20
8 x 10 inches (203 x 254 mm) |S041946 20
Letter (8.5 x 11 inches S042182 25
[216 > 279 mm]) S042175 50
Epson Ultra Premium Photo Paper | Letter (8.5 x 11 inches S041405 50
Luster [216 x 279 mm])
Epso_n Premium Photo Paper 4 x 6inches (102 x 152 mm) | S041982 40
Semi-gloss Letter (8.5 x 11 inches S041331 20
[216 x 279 mm])
Epson Presentation Paper Matte | Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100

[216 x 356 mm])
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Paper Type Size Part number Sheet count

Epson Premium Presentation 8 x 10 inches (203 x 254 mm) | S041467 50

Paper Matte Letter (8.5 x 11 inches S041257 50
[216 > 279 mm]) 5042180 100

Epson Premium Presentation Letter (8.5 x 11 inches S041568 50

Paper Matte Double-sided [216 x 279 mm])

Epson Ultra Premium Presentation | Letter (8.5 x 11 inches S041341 50

Paper Matte [216 x 279 mm])

Epson Brochure & Flyer Paper Letter (8.5 x 11 inches S042384 150

Matte Double-sided [216 x 279 mm])

Epson Photo Quality Self-adhesive | A4 (8.3 x 11.7 inches S041106 10

Sheets [210 x 297 mm])

Epson Iron-on Cool Peel Transfer |Letter (8.5 % 11 inches S041153 10

paper [216 x 279 mm])

Epson Velvet Fine Art Paper Letter (8.5 x 11 inches S041636 20

[216 x 279 mm])

Parent topic: Loading Paper

Borderless Paper Type Compatibility

You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types

Epson Photo Paper Glossy

Epson Premium Photo Paper Glossy

Epson Ultra Premium Photo Paper Glossy

Epson Premium Photo Paper Semi-gloss

Epson Ultra Premium Photo Paper Luster

Epson Premium Presentation Paper Matte

Epson Ultra Premium Presentation Paper Matte
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Borderless Paper Sizes

* 4 x6inches (102 x 152 mm)

16:9 wide (4 x 7.1 inches [102 x 181 mm])
5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

Letter (8.5 x 11 inches [216 x 279 mm])

* A4 (8.3 x 11.7 inches [210 x 297 mm])
Parent topic: Loading Paper

Paper or Media Type Settings - Control Panel

For this paper

Select this Paper Type setting

Plain paper Plain Paper
Epson Bright White Paper

Epson Iron-on Cool Peel Transfer paper

Epson Photo Quality Self-adhesive Sheets

Epson Ultra Premium Photo Paper Glossy Ultra Glossy

Epson Premium Photo Paper Glossy

Prem. Glossy

Epson Photo Paper Glossy

Glossy

Epson Presentation Paper Matte

Presentation Matte

Epson Premium Photo Paper Semi-gloss

Prem. Semi-Gloss

Epson Ultra Premium Photo Paper Luster

Ultra Luster

Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided

Prem. Matte

Epson Velvet Fine Art Paper

Velvet Fine Art Paper

Envelopes

Envelope

75




Parent topic: Loading Paper

Paper or Media Type Settings - Printer Software

For this paper

Select this paper Type or Media Type setting

Plain paper

Epson Bright White Paper

Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Plain Paper/Bright White Paper

Epson Ultra Premium Photo Paper Glossy

Ultra Premium Photo Paper Glossy

Epson Premium Photo Paper Glossy

Premium Photo Paper Glossy

Epson Photo Paper Glossy

Photo Paper Glossy

Epson Presentation Paper Matte

Presentation Paper Matte

Epson Premium Photo Paper Semi-gloss

Premium Photo Paper Semi-Gloss

Epson Ultra Premium Photo Paper Luster

Ultra Premium Photo Paper Luster

Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided

Premium Presentation Paper Matte

Epson Velvet Fine Art Paper

Velvet Fine Art Paper

Envelopes

Envelope

Note: The settings listed here are available only when printing from your computer; they do not apply to

your product's control panel settings.

Parent topic: Loading Paper
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Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damagingit.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder
Turning Off the Document Alert

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: Letter (8.5 x 11 inches [216 x 279 mm]) or
A4 (8.3 x 11.7 inches [210 x 297 mm]).

1. Open the document cover.
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2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the
original to the edges of the indicated corner.

Note: You can place multiple originals on the scanner glass. Just make sure they are at least
0.8 inch (20 mm) away from each other.

Note: The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the
scanner glass. If you are scanning in Full Auto mode or using thumbnail preview in another mode in
Epson Scan, the edges of your original may be cropped by about 0.2 inch (4.5 mm) from the top and
side edges. Manually position your original away from the edges to prevent cropping.

3. Close the document cover gently to keep your original in place.
Parent topic: Placing Originals on the Product

Related topics
Copying
Scanning
Faxing

Placing Originals in the Automatic Document Feeder

You can place multi-page original documents in the Automatic Document Feeder (ADF). Make sure the
originals meet the Automatic Document Feeder specifications before loading them.
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Caution: Make sure your originals are not thermal transfer paper or carbon backed, creased or folded,
are cut irregularly or not at a right angle, and do not contain holes, staples, tape, or other materials that
could obstruct the feeder.

1. Open the ADF paper support and slide out the ADF output tray extension.
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3. Fan your stack of originals and tap them gently on a flat surface to even the edges.

-
\ 4

4. Insert the originals into the ADF face-up and top-edge first. Then slide the edge guide against the
originals, but not too tightly.
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Note: If you're using the Letter, 2-up Copy or A4, 2-up Copy layout, make sure the originals are
loaded as shown.

X
=®

Parent topic: Placing Originals on the Product

Related references
Automatic Document Feeder (ADF) Specifications

Related topics
Copying
Scanning
Faxing

Turning Off the Document Alert

The Document Alert warns you that an original has been left on the scanner glass. You can turn off this
feature from the product's control panel.

1. Press the f home button, if necessary.
2. Select Setup.
3. Scroll down and select Guide Functions.
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You see this screen:

Guide Functions

Papeer Setting Alert

Document #lert L J

fiuto Selection Mode

4. Select Document Alert.

5. Select Off.

6. Press the M home button to exit.

Parent topic: Placing Originals on the Product
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Copying

See the information here to copy documents or photos using your product.
Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying and Restoring Photos

Related tasks
Copying onto a CD/DVD

Copying Documents or Photos

You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.

1. Place your original document or photo on the scanner glass, or load your documents in the ADF.
2. Load the paper you want to print on.

Note: Load only the recommended number of sheets.

3. Press the M home button, if necessary.
4. Select Copy.

1> 1=5ided, with Border

—._ 1—+ Preview

Density
w
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To print more than one copy, press the + or — button to select the number (up to 99).
Select Color or B&W.
Scroll down to view and change additional copy settings, if necessary.

® N o O

When you are ready to copy, press the < Start button.
Note: To cancel copying, select Cancel.

Paper Type Settings - Copying
Paper Size Settings - Copying
Copying Options

Parent topic: Copying

Related references

Paper Loading Capacity
Available Epson Papers
Related topics

Placing Originals on the Product
Loading Paper

Paper Type Settings - Copying

Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting

Plain paper Plain Paper
Epson Bright White Paper

Epson High Quality Ink Jet Paper

Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Epson Presentation Paper Matte Presentation Matte

Epson Premium Presentation Paper Matte Prem. Matte
Epson Ultra Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-sided
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Paper type loaded

Paper Type setting

Epson Premium Photo Paper Glossy
Epson Ultra Premium Photo Paper Luster

Prem. Glossy

Epson Ultra Premium Photo Paper Glossy

Ultra Glossy

Epson Photo Paper Glossy

Glossy

Epson Premium Photo Paper Semi-gloss

Prem. Semi-Gloss

Epson Velvet Fine Art Paper

Velvet Fine Art paper

Parent topic: Copying Documents or Photos

Paper Size Settings - Copying

Select the Paper Size setting that matches the paper you loaded.

Note: You can copy photos only on these paper sizes.

* 4 x6inches (102 x 152 mm)
* 5x7inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)
Letter (8.5 x 11 inches [216 x 279 mm])
A4 (8.3 x 11.7 inches [210 x 297 mm])

* Legal (8.5 x 14 inches [216 x 356 mm])
Parent topic: Copying Documents or Photos

Copying Options

Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Copying option

Available settings

Description

Density

Varying levels

Adjusts the lightness or darkness of copies
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Copying option

Available settings

Description

Remove Background

Off

Removes or lightens the background color. May
not remove very dark or vivid colors.

On
2-Sided Copying 1>1-Sided Selects 1-sided or 2-sided copies
2>2-Sided
1>2-Sided
2>1-Sided
Layout With Border Leaves a small margin around the image
Borderless Expands the image to the edge of the paper
(slight cropping may occur)
A4, 2-up Copy Copies 2 originals onto a single A4-size sheet

Letter, 2-up Copy

Copies 2 originals onto a single letter-size sheet

A4, Book/2-up

Copies 2 pages of a book or magazine onto a
single A4-size sheet

Letter, Book/2-up

Copies 2 pages of a book or magazine onto a
single letter-size sheet

Reduce/Enlarge

Custom Size

Automatically sizes the image by the percentage
you select

Actual Size

Copies at 100% size

Auto Fit Page

Automatically sizes the image to fit the selected
paper size setting

Letter->4x6in and other

conversions

Automatically converts from one size to another

Paper Size

Various sizes

Selects the paper size for the copy printout

Paper Type

Various types

Adjusts printer settings for the selected paper
type
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Copying option

Available settings

Description

Paper Source

Cassette 1 Copies onto paper loaded in Cassette 1 (upper
cassette)
Cassette 2 Copies onto paper loaded in Cassette 2 (lower

cassette)

Rear Paper Feed Slot

Copies onto paper or card stock loaded in the
rear paper feed slot

Document Type Text Copies a text document
Text & Image _Copies a document that includes text and
images
Photo Copies a photograph
Quality Draft Provides lower quality for draft copies (plain

paper only)

Standard Quality

Provides good quality for most copies

Best

Provides the highest quality for special copies

Documentation Portrait Specifies the orientation of your originals (only
Orientation available when 2>1-Sided or 1>2-Sided is
Landscape selected)
Binding Direction Left Edge Specifies the binding edge of your double-sided
originals (only available when 2>1-Sided is
Top Edge selected)
Binding Margin Left Edge Specifies the binding edge of your double-sided
copies (only available when 1>2-Sided is
Top Edge selected)
Expansion Standard Adjusts the amount of expansion for printing
Medium borderless photos
Minimum
Dry Time Standard Provides longer drying time for 2-sided copies, if
Lon smudges or marks appear on the front of the
9 paper when you print on the second side
Longer

Clear All Settings

Restores the copy settings to the default settings
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Parent topic: Copying Documents or Photos

Copying and Restoring Photos
You can restore the colors in faded photos as you copy them.
1. Load photo paper in the product.
2. Press the M home button, if necessary.
3. Select More Functions.
4. Select Copy/Restore Photos.

Copy/Restore Photos

I wour photo s Faded,
sebect On.

5. Select On.
6. Place up to two original photos on the product.

Note: View the LCD screen for instructions on placing your photos on the product.

Press the <& Start button.
Press the + or — button to select one or more copies of the photo (up to 99).

9. If you placed two originals on the scanner, press the left or right arrow button to view the second
original. Then press the + or — button to select one or more copies of the photo (up to 99).

10. To adjust your print and copy settings, do one or more of the following:
* To change the print settings, select Settings and select the necessary settings.
* To adjust the copy image, select Edit > Photo Adjustments, then select your settings.

88



+ To add a B&W filter to the copy, select Edit > Filter and select the B&W setting.

» To crop or zoom into your photo, select Edit > Crop/Zoom and press the icons displayed on the
LCD screen to crop your image.

11. When you are ready to copy, press the < Start button.
Note: To cancel copying, select Cancel.

Parent topic: Copying

Related references

Available Epson Papers

Paper Loading Capacity

Paper Loading Capacity

Paper Type Settings - Copying

Paper Size Settings - Copying

Copying Options

Related tasks

Placing Originals on the Scanner Glass

Related topics
Loading Paper
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with OS X
Cancelling Printing Using a Product Button

Printing with Windows
You can print with your product using any Windows application, as described in these sections.

Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows

Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows

Changing Automatic Update Options

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.
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3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

L Printing Preferences H
Main | Moes Optors | Mantenancs
Friting Fresets Paper Soroe Auby Casse the Selecton w
M REmiree Preseds... Dourmeent Sire Liteer (B 122 11 W
= Dooument - Fast [[]Borderless
& Document - Standard Quality Crientalien ) Parirait —
= Doosment - Hgh Qualty
: Dooument - 2-Sided Paper Type Plairy Pagesr | Brighl Wiibe Paper w
B Photo - 4 x &0 Portrait
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4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size, but you will not
be able to use the Borderless setting.
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11.
12.

13.
14.

15.
16.

If you are printing a borderless photo, select Borderless. You can click Settings to access
additional options for borderless printing.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

Select the orientation of your document.
Note: If you are printing an envelope, select Landscape.
Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Select the Quality setting that matches the print quality you want to use.

. Select a Color option:

» To print a color document or photo, select the Color setting.
» To print text and graphics in black or shades of gray, select the Black/Grayscale setting.
To print on both sides of the paper, select a 2-Sided Printing option.

To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

To print multiple copies and arrange their print order, select the Copies options.

To reduce noise during printing when you select Plain Paper/Bright White Paper, select Quiet
Mode (printing will be slower).

To preview your job before printing, select Print Preview.

To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows

Parent topic: Printing with Windows

Related references
Borderless Paper Type Compatibility
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Paper or Media Type Settings - Printer Software

Related tasks

Selecting Double-sided Printing Settings - Windows
Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Cassette Selection
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Cassette 1 > Cassette 2
Selects the paper in cassette 1 as the paper source and automatically switches to cassette 2 when
cassette 1 is empty.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

CD/DVD Tray
Selects the CD or DVD loaded in the CD/DVD tray.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on plain paper.

Standard
For everyday text and image printing.

High
For photos and graphics with high print quality.

More Settings
Opens a window that lets you choose among levels of speed and quality.

Parent topic: Selecting Basic Print Settings - Windows
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Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

2-Up and 4-Up
Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2x1 Poster, 2x2 Poster, 3x3 Poster, 4x4 Poster

Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

2-Sided Printing | Off W

1. Select one of the following options for 2-Sided Printing:

+ Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper
on the long edge.

» Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper
on the short edge.

* Manual (Long-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the long edge to print the other side (recommended for
paper types that do not support automatic duplexing).

* Manual (Short-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the short edge to print the other side (recommended for
paper types that do not support automatic duplexing).

2. Click the Settings button.
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You see this window:

2-Sided Printing Settings
Binding Edge
eleft ~ Top -~ Right
= iong-edge: ' Shart-edge * Long-edge
=== — S
Binding Margin
Front Page 0.00 & [0.00... 1.18]
Back Page 0.00 = [0.00... 1.18]
Linit ) mm ®inch
Start Page
(®) From Front
(") From Back
Create Folded Booklet
[ Booket
Center Binding Side Binding
FF_‘
o ] [ | [ 1o

Select the double-sided printing options you want to use.
Click OK to return to the Main tab.
Click the Print Density button.
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You see this window:

Print Density Adjustment
Select Dooument Type
) Taxt Text with Photo Phato Manual
Adjustrments
Print Density 1] [3&)
=50 1]
Increase Ink Drying Time 0 [sec)
0 &0
K Cancel Help

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.

8. Click OK to return to the Main tab.

9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with Windows

Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.
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Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More

Options tab.
i Printing Preferences n-
Main | Mo Opiora Manterance
Frnting Fresets Document Sire | Lether {8 172 x 11in) -
Add Renorve Presets.... Dustpuit Paper Carn Bl Daocursiri!l Sine “
=] Dogument - Fast Reduce Eniar gi Dot

=] Dooument - Standard Qualty

= Dotument - High Gualty

£ Doument - 2:Sded

B Photo - 45 6 Porbai

wl Phabo - 4 & in Landscape
Prertaie OOV Brotreg

B Fhoto - 8% 10 in Porrat Image Cipbions. ..

- Pt -8 x 10 B Landacage

Cofor Coereschion
Avitowm b ) Cuesiom Advanced. ..

Waiermark Fastned. ..

-

— N I
P Rotate 150
m |

of | High Speed
— _dﬂ_{}_{_‘ﬂ_ﬂ Mamor Image

e T

Reset Defpids

QK Cancoel iy

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

» Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the
your document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:

» Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation
for your image.
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+ Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

+ Select Image Options to access additional settings for improving printed images.
Note: You can also select Color Universal Print settings.

3. To add the following features, click the Watermark Features button:
+ Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

* Header/Footer: adds information such as the date and time to the top or bottom of your printout.
Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.

Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Parent topic: Printing with Windows
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Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Correction
Color Hanspement
) Cgker Conclal
e iy e
oM +
ot |
Ciskor Macks EPS0 Wric W
e dean
Coler Addpmtment Metd gl Puatas L
& Color Cirdle Sl B
¥
Eigset Conrols
Bragrvredd 0
(it aet 0
Saturabon 0o
+
Pt Lal sl
SR n * L]
(5 4 Cancsl Helg

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.
Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye
Reduces or removes red-eye in photos.

Print Text in Black
Prints colored text in black.

For Color Text
Prints colored text on a background pattern or underlined.

For Color Graphs and Images
Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images
Prints colored text, graphics, and images with overlay patterns.

Enhancement Options
Specifies Color Universal Print enhancement settings for text, graphics, and images.
Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.
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High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.

Header/Footer Settings
Top Left Top Center Top Right
User Mame W Hone L Date,Time L
Bottom Left Bottom Centar Battom Right
Mone W Hone W None w
Reset Defaults oK Cancel Help

You can select to print the following information:
* User Name

* Computer Name

« Date

* Date/Time

» Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

102



Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
You see the available Printing Presets on the left:

Main | More Options | Mantenance
Printing Presets
AddRemaove Presets...

Document - Fast
Document - Standand Quality
Dooument - High Quality
Document = 2-Sided
Photo - 4 x 6 in Portrait
Photo - 4% 6 in Landscape
(=) Printable CO/OVD Printing
B Photo - 8 x 10 in Portrait
& Phato - 8 % 10 in Landscape

({2

) ]t

i
Show Settings
Reset Defaults Ink Levels

2. Place your cursor over one of the Printing Presets to view its list of settings.
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3. Click on a preset to change its settings, or use any of the available options on the screen to control
your printing presets.

4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:

o Printing Preferences H

Mo | Moo Optora  Mantensnce

E} Morde Check E@ EFSOM Status Monitor 3

Wi | ead Cleaning [gﬂ Monaorng Frefererces
P, | Frnt Head ddgrment
B s
& reicne

®
5
{

o

Frinter and Opbion Informasion

Language Englsh, (Enghish] w o Sofrmare Lipdabe
Ol Orider
Venson 1, 20,00 e ——
oK Cancnd g
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4. Click the Extended Settings button.
You see this window:

Extended Se1mags
Gt Lritres
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Sl Bl Fage
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Sl s gt 1 P e = 00 Comy Mptriumg
iy e Bia Crover's Paper Souroe Srting

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows
Extended Settings - Windows
You can select from these settings on the Extended Settings window.

Show Progress Meter
Displays the progress of print jobs as they are being printed.

Enable EPSON Status Monitor 3
Enables product monitoring for ink and paper supplies and other issues.

Check Paper Width Before Printing
Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print
speed.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.
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Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

General |
Sedect Prirer

% Add Printer
=5 EPSON
== EPSOM (Fax)

Ready

L
Status
Location
Coemement
Page Range
I
Selection

2. Click OK or Print to start printing.
Checking Print Status - Windows
Parent topic: Printing with Windows
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Checking Print Status - Windows

During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink cartridge status.

™ -

E pSO N hittp: fift.mvesn, com/

Page:0 37
I_

Paper Type : Plain Paper [ Bright ivhite Paper
Faper Size 1 Lether (8 1/2x 11in)

Show Ink Levels

Print Quews Cancel

» To cancel printing, click Cancel.

* To see print jobs waiting to print, click Print Queue.
* To check ink status, click Consumables Status.

Parent topic: Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that

program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
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You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
You see the printer settings window.
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3. Click the Maintenance tab.
You see the maintenance options:

Printing Preferences H
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4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.
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You see this window:

Software Update Settings “-
Check for Software Updates on the Internet
(@) Chedk every 7 weeks v
() Never
b O] | concel

3. Do one of the following:
» To change how often the software checks for updates, select a setting in the Check every menu.
+ To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows

Printing with OS X

You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - OS X

Selecting Page Setup Settings - OS X
Selecting Print Layout Options - OS X

Selecting Double-sided Printing Settings - OS X
Managing Color - OS X

111



Selecting Printing Preferences - OS X
Printing Your Document or Photo - OS X

Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSOMN

[~
Presats: Default Settings d

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.

112



You see the expanded printer settings window for your product:

Printer: | EPSON

(ol

Presets: Default Settings

Copies: 1

Pages: 0 Al
From: 1 to: 1

Paper Size: | US Letter k5 8506y 11.00 inches
Orientation: I f Ta
Praview H
Auto Rotate

O Scale: 100%:
Scale to Fit: .

[ <3

Coples per page: 1

Cancel | (LI

Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

Select Print Settings from the pop-up menu.

v Preview

Layout

Color Matching
Paper Handling
Cover Page

Print Settings
Color Options
Two-sided Printing Settings

Supply Levels
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You see these settings:

Print Settings

Paper Source: | Cassette 2 -

Media Type: | Plain Paper / Bright White Paper E

ik

Print Quality: | Normal

Crayscale

Mirror Image

Cancel Print

9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.

Paper Source Options - Mac OS X

Print Quality Settings - OS X

Print Options - OS X

Parent topic: Printing with OS X

Related references

Paper or Media Type Settings - Printer Software

Related tasks
Selecting Page Setup Settings - OS X
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Printing Your Document or Photo - OS X
Paper Source Options - Mac OS X

You can select any of the available options in the Paper Source menu to print from paper loaded in that
source.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - OS X
Print Quality Settings - OS X

You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on photo paper.

Fast Economy
For the fastest printing with draft quality.

Economy
For fast printing with reduced quality.

Normal
For everyday text and image printing.

Fine
For text and graphics with good quality and print speed.

Quality
For photos and graphics with good quality and print speed.

Best Quality
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - OS X
Print Options - OS X

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
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Expansion
If you selected a borderless paper size setting, this option adjusts the image expansion settings to
control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - OS X

Selecting Page Setup Settings - OS X

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter d B.50 by 11.00 inches

Orientation: [l W Ts

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size, but the Quality setting will be limited to
Normal.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

le

Note: If you are printing an envelope, select the "= icon.
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Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with OS X

Related references
Borderless Paper Type Compatibility

Selecting Print Layout Options - OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout u
Pages per Shest: 1 |~ |
| action: {_} N, / \

Border:  None |~ |

Reverse page orientation
Flip horizontally

Cancel | | SUCILEN

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
« Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with OS X
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Selecting Double-sided Printing Settings - OS X

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Two-sided Printing Settings

Two-sided Printing: | Off

Cancel Print

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the
version of OS X you are using.

1. Select one of the Two-sided Printing options.
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2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings
Twa-sided Printing: | Long-Edge binding
Document Type: | Text

¥ Adjustments

Pring Density

[V
=50 ]
ncreaded Ink Drying Time:
1 (E114]
1] -1

whan printing a photo or documant containing a kot of selid image
areas, redwce the density of the ink and increase its drying time.

Cancel | | Print |

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options and Adjustments - OS X
Parent topic: Printing with OS X
Double-sided Printing Options and Adjustments - OS X
You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.
Two-sided Printing Options

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.
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Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.
Adjustments

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - OS X

Managing Color - OS X

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

Color Matching |

ColorSync ) EPSON Color Controls

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Color Options =

* | Manual Settings
Fix Photo
Off (No Color Adjustment)

F Advanced Settings:

Cance Print

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - OS X

Parent topic: Printing with OS X
Color Matching and Color Options - OS X

You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can

customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings

Manual Settings
Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.
Parent topic: Managing Color - OS X

Selecting Printing Preferences - OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
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You see a screen like this:

General Supply Levels  Utility

To take full advantage of your printers cptions, confirm that they are accurately
sheown here. For information on your printer and its optional hardware, check the
PrIFEErs GOCuUrmeration

Thick paper and envelopes: | OF

Skip Mank Page: | OH

Quilet Mode: | O

Perenit temporary black pringing: | O
Automatic Casserte Switching: | Off
High Speed Printing: | On

Warning hotifications: | On

Establish bidirectional communication: | On

Cancel | | OK |

4. Select any of the available printing preferences.
5. Click OKOK or OK.
Printing Preferences - OS X
Parent topic: Printing with OS X
Printing Preferences - OS X
You can select from these settings on the Options or Driver tab.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

Permit temporary black printing
Allows you to print using black ink when color ink is expended.
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Automatic Cassette Switching
Automatically switches to the other cassette when one of the cassettes runs out of paper.

High Speed Printing
Speeds up printing but may reduce print quality.

Warning Notifications

Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Print Settings :

Paper Source: | Cassette 2 B
Media Type: | Plain Paper / Bright White Paper

Print Quality: | Mormal

Crayscale

Mirror Image

Cancel Print

Checking Print Status - OS X
Parent topic: Printing with OS X
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Related tasks
Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X
Selecting Print Layout Options - OS X
Selecting Double-sided Printing Settings - OS X
Managing Color - OS X
Selecting Printing Preferences - OS X
Checking Print Status - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:

[ BN & EFSON

W LF
Paush Soltings
1836131_12T0960758910_6552316_n.jpg

a

2. Select the following options as necessary for your version of OS X:
* To cancel printing, click the print job and click I:l or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - OS X
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Cancelling Printing Using a Product Button
If you need to cancel printing, select Cancel on the LCD screen.
Parent topic: Printing from a Computer
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Scanning

You can scan original documents or photos and save them as digital files.

Starting a Scan

Selecting Epson Scan Settings

Scanning with OS X Using Image Capture
Scanning Special Projects

Starting a Scan

After placing your original documents or photos on your product for scanning, start scanning using one of
these methods.

Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan Icon
Starting a Scan from a Scanning Program

Parent topic: Scanning

Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel
You can scan an image to your computer using your product's touch panel buttons.

Your product automatically selects suitable default scan settings, but you can view or change them as
necessary.

1. Make sure you installed the product software and connected the product to your computer or
network.

Note: Restart your computer after installing the product software to enable scanning from the control

panel. Also make sure the Event Manager program is not being blocked by your firewall or security
software.

Press the M home button, if necessary.
3. Select Scan.
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The scan options are displayed:

acan

=8 Scan to Hemory Card

B Scean to Cloud

=3 Scan to Computer (JPEG)

Scroll down to view additional scan options, then select the one you want.

Scan to Memory Card saves your scan file on a memory card and lets you select the file format,
quality, and other settings.

Scan to Cloud sends your scanned files to a destination that you have registered with Epson
Connect.

Note: To use this feature, you must have registered a cloud account with Epson Connect.
Scan to Computer (JPEG) saves your scan file directly to your computer or as an image capture

in OS X.

Scan to Computer (PDF) saves your scan as a PDF file to your computer or as an image capture
in OS X.

Scan to Computer (Email) scans your original and attaches it to a message in your e-mail
program. You can select the e-mail program you want to use and resize your image, if necessary,
from an option screen on your computer.

Note: This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail,
and Entourage, but not web-based email such as Gmail.

Scan to Computer (WSD) lets you manage wireless scanning in Windows 8.x, Windows 7, or
Windows Vista (English only).
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Note: To use this feature, you must first set up WSD (Web Services for Devices) on the computer

you want to scan to.

5. To scan to your computer, select how you connected your product to your computer:

« If your product is connected directly to your computer with a USB cable, select USB Connection.

« If your product is connected to your computer over a network, select the computer name from the

list.
6. Press the <& Start button to start scanning.

Scan to Memory Card Options
Changing Default Scan Button Settings

Parent topic: Starting a Scan

Related tasks
Using Epson Scan to Cloud

Scan to Memory Card Options

Select the Scan to Memory Card options you want to use.

Scan to Memory Card Available options Description

setting

JPG — Selects the scanned file type

PDF JPG: for photos
PDF: for documents

Color — Selects color or black-and-white

B&W scans

Contrast Various levels Decreases or increases image
contrast

2-Sided Scanning Off Controls automatic 2-sided

On scanning for documents in the ADF
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Scan to Memory Card Available options Description
setting
Scan Area Letter Selects the page size for documents
Legal or special settings for photos
Auto Cropping: for photos with
A4
_ dark edges
Auto Cropping Max Area: for most photos
Max Area
Document Text Selects the type of original you are
Photograph scanning
Resolution 200 dpi Selects the scanned image
300 dpi resolution
600 dpi 200 dpi: for e-mailing or posting on
the web
300 dpi: for printing or OCR
600 dpi: for highest quality printing
Document Orientation Portrait Specifies the orientation of your
Landscape originals
Binding Direction Left Edge Specifies the binding edge of your
Top Edge double-sided originals

Parent topic: Starting a Scan Using the Product Control Panel
Changing Default Scan Button Settings

You can view or change the default scan settings your product uses when you scan to your computer
using the product buttons. You do this using the Event Manager program.

1. Do one of the following to open Event Manager:

+ Windows 8.x: Navigate to the Apps screen and select Event Manager.

* Windows (other versions): Click © or Start > All Programs or Programs > EPSON Software

> Event Manager.

» OS X: Open the Applications folder, click Epson Software, and click Event Manager.
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6.
7.

Open the Scanner (Windows) or Select Scanner (OS X) drop-down list and select your product, if
necessary.

Click Make Job Settings.

Open the Edit Job Settings drop-down list and select the scan button settings you want to view or
change.

Change the settings as necessary.
Click OK.
Click Close to close the Event Manager window.

Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using the Epson Scan Icon

You can start the Epson Scan program to select scan settings, scan, and save the scanned image to a
file.

Windows 8.x: Navigate to the Apps screen and select EPSON Scan under EPSON or EPSON
Software.

Windows (other versions): Click © or Start, and select All Programs or Programs. Select EPSON
or EPSON Software and click EPSON Scan.

OS X: Open the Applications folder, open the Epson Software folder, and double-click the EPSON
Scan icon.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).
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You see an Epson Scan window like this:

4

' EP&DN Scan [ifice Mode =l
~ Image Type 1
% Cobx " Grayscale  BlackEwhite

~ Destination
Document Sournce; |ﬁ.uto Detect ll

Sige: [Letier(85 511 in) |

Drientation: p E‘ - E‘
dpi

Reszalutian: Iam d

r~ Image Adjusiments
[~ Unshaip Mask

[T Image Option
% Teut Erhancement

€ Auto Area Segmentation

" Colot Enhance: Red

Erightress:
Cogheast:

Qe | @ = [@

| Corfiguration... | Close |

Parent topic: Starting a Scan

Related tasks
Scanning with OS X Using Image Capture
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Related topics
Selecting Epson Scan Settings

Starting a Scan from a Scanning Program

You can start Epson Scan from a scanning program to select scan settings, scan, and open the scanned
image in the program.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; it will not work correctly.
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You see an Epson Scan window like this:

o ;
i EPSONScan o

~ Image Type
% Colg O Grayscale " Blackiwhite

~ Destination
Document Sounce; |ﬁ.uto Detect LI

Sige: [LeteB5 % 11in) -~

Driertation: - 'E] p E|
dpi

Rezalution: |3'I' d

r~ Image Adjustrments
[~ Unshaip Mask

[ Image Option
% Teut Erhancement

€ Autodrea Segmentation

" Color Enhance: Red

Brightress:

Conlrast

Qe | @ = @

Hep | gose |

Note: Epson Scan may start in a different mode when you first access it.

Parent topic: Starting a Scan
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Selecting Epson Scan Settings
After starting Epson Scan, you can select settings in various modes to customize your scan.

Scan Modes

Selecting the Scan Mode
Scanning in Office Mode
Scanning in Home Mode
Scanning in Professional Mode
Image Preview Guidelines
Scan Resolution Guidelines
Selecting Scan File Settings

Parent topic: Scanning

Scan Modes

Epson Scan provides a choice of scan modes with different levels of control over your settings.

Office Mode
You can quickly scan text documents and adjust them on a preview screen. You can also select
various image adjustment options and preview your scanned image.

Home Mode
You can select setting groups based on the type of content you are scanning. You can also select
various image adjustment options, and preview and size your scanned image.

Professional Mode
You can manually customize all available settings, and preview and size your scanned image.

Note: You must place your original on the scanner glass when using Home Mode.

Parent topic: Selecting Epson Scan Settings

Related topics
Selecting Epson Scan Settings
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Selecting the Scan Mode

Select the Epson Scan mode you want to use from the Mode box in the upper right corner of the Epson
Scan window:

i EPSON Scan - oIl
2 ode
ks EPSON Scan [Office Mode =l

Ik
I Tope ?pr W ok
% Colos " Grayscale | Professsonal Mode

Destnation

Parent topic: Selecting Epson Scan Settings

Related tasks

Scanning in Office Mode
Scanning in Home Mode
Scanning in Professional Mode

Scanning in Office Mode

When you scan in Office Mode, Epson Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Office Mode as the Mode setting.

137



You see this window:

Letter[85 x 11 in.)

- &

[300 v| ®

Image Adjustments
L] Unshaip Mask [ ] Degscreening
[[] Image Option

® Text Enhancement

) Auite Ares Segmentation

! Color Enbhance:

Enighfness:
Contrast:

2. Select the Image Type setting that matches your original.
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3. Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF-Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.

4. Select the Size and Orientation settings that match your original.
. Select the Resolution setting you want to use for your scan.
6. Click the Preview button.
Epson Scan previews your original and displays the result in a separate Preview window.
7. If you are using the ADF, reinsert your original into the ADF.
8. If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

9. Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

10. Click Scan.
You see the File Save Settings window.
11. Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.

Available Document Source Settings - Office Mode
Selecting a Scan Area - Office Mode

Available Image Adjustments - Office Mode
Parent topic: Selecting Epson Scan Settings
Related concepts

Image Preview Guidelines

Scan Resolution Guidelines

Related tasks

Selecting Scan File Settings
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Available Document Source Settings - Office Mode
You can select these Document Source options in Epson Scan Office Mode.

Scanner Glass
Selects the scanner glass as the location where the originals are placed on your product for scanning.
ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Auto Detect
Automatically detects where the originals are placed on your product for scanning.

Parent topic: Scanning in Office Mode
Selecting a Scan Area - Office Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas.

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. In the Preview window, click the .ﬂ Auto Locate icon to create a marquee (dotted line) on the
preview image.
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2. Do the following, as necessary, to work with the selected scan area:
+ If the marquee is correct, continue with the next step.
+ To move the marquee, click inside the scan area and drag the marquee where you want it.
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* To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

» To create additional marquees (up to 50, if available), click the = ] Copy Marquee icon to copy the
existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

* To delete a marquee, click the marquee, then click the = Delete Marquee icon.
3. Click inside each scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Office Mode
Available Image Adjustments - Office Mode

You can select these Image Adjustments options in Epson Scan Office Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

Image Adustments
Unzhaip Mask Descreening
Image Option
Teut Enhancemnment

Ao Area Seamentation

Colar Enhance: Fed
Brightness: [ 0
Contrast; { 0

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments
beneath the checkbox. Not all adjustment settings may be available, depending on the Image Type
setting.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
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Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Color Enhance
Enhances the red, green, or blue shades in the scanned image.

Brightness

Adjusts the overall lightness and darkness of the scanned image.
Contrast

Adjusts the difference between the light and dark areas of the overall scanned image.
Threshold

Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Office Mode

Scanning in Home Mode

When you scan in Home Mode, Epson Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

Note: You must place your original on the scanner glass when using Home Mode.

1. Start Epson Scan and select Home Mode as the Mode setting.
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You see this window:
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2. Select the Document Type setting that matches your original, such as Photograph or Text/Line
Art.

3. Select the Image Type setting that matches your original.

144



4. Select the way you plan to use your scanned image as the Destination setting. (The Resolution
setting is selected automatically based on the Destination setting you choose.)

+ Screen/Web: Select this option for images you will email, view on a computer screen, or post on
the web.

» Printer: Select this option for images you will print or documents you will convert to editable text
using OCR (Optical Character Recognition) software.

+ Other: Select this option if you want to select a custom resolution for your image.
5. If you selected Other in the last step, select the Resolution setting you want to use for your scan.
6. Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
7. If desired, select the area in your preview image that you want to scan (scan area).

8. Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

9. If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to
use.

10. Click Scan.
You see the File Save Settings window.
11. Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.

Selecting a Scan Area - Home Mode
Available Image Adjustments - Home Mode
Selecting a Scan Size - Home Mode

Parent topic: Selecting Epson Scan Settings
Related concepts

Image Preview Guidelines

Scan Resolution Guidelines

Related tasks

Selecting Scan File Settings
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Selecting a Scan Area - Home Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. Do one of the following to select your scan area in the Preview image:

« Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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* Normal preview: Click the ﬂ Auto Locate icon to create a marquee (dotted line) on the preview
image.
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2. Do the following, as necessary, to work with the selected scan area:
+ If the marquee is correct, continue with the next step.
+ To move the marquee, click inside the scan area and drag the marquee where you want it.
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* To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

* Normal preview: To create additional marquees (up to 50), click the = ] Copy Marquee icon to
copy the existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

* To delete a marquee, click the marquee, then click the = Delete Marquee icon.
3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Home Mode
Available Image Adjustments - Home Mode

You can select these Image Adjustments options in Epson Scan Home Mode.

Image Adjustments
| Descresring | Backlight Carrection
| Color Rrestoration | Dusst Rermoval
Image Option(z]
Tt Enhancemant
Auto Area Segmeantation
I Brightness...

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments.
Not all adjustment settings may be available, depending on the Document Type and Image Type setting.
Click the Brightness button to access additional settings.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.
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Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Home Mode
Selecting a Scan Size - Home Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 x 6 inches (102 x 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.

2. Inthe Epson Scan window, select the size you want your scanned image to be from the Target Size
list.

Target Size: 5 %7 N, '] _'EI

Note: If you need to rotate the orientation of the target size for your image, click the A Orientation
icon.
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A marquee (dotted line) appears on your preview image proportioned for the size you selected.
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3. Do the following, as necessary, to work with the selected scan area:
* To move the marquee, click inside the scan area and drag the marquee where you want it.
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» To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.

4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.

You see this window:

Tanget Size Mame:

|Jser Defined

5. Name the custom size, enter the size, click Save, and click OK. Then adjust the marquee on the
preview image.

The marquee is automatically proportioned for your custom scan size.
Parent topic: Scanning in Home Mode
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Scanning in Professional Mode

When you scan in Professional Mode, Epson Scan automatically saves your scanned file in JPEG
format in your operating system's Pictures or My Pictures folder, or opens it in your scanning program.
You can select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Professional Mode as the Mode setting.
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You see this window:

Mode:
Professional Mode

| Curent Setling

Reflective

|5wmﬁlaas

Fhoto

Destination

Image Type: | 24:bi Colo

Reslin: ™ v %

Documert Size: W B50 H| 11.70| in W

[#] Target Size: Original W _'l

V| |

[+ [#] Unsharp Mask
[+| [ Descreening
[] Collog Restoration

B e |
[] Thumbnai

| Hep || Configuration.
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10.

11.

12.

13.

Select the Document Type setting that matches your original, such as Reflective for documents or
photos.

Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF - Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.

Select the specific type of original you are scanning as the Auto Exposure Type setting: Document
or Photo.

Select the details of your original and how you want it scanned as the Image Type setting.
Select the Resolution setting you want to use for your scan.

Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
If you are using the ADF, reinsert your original into the ADF.

If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to
use.

Note: You cannot select a target size if you chose ADF-Double-sided as the Document Source
setting.

Click Scan.

You see the File Save Settings window.

Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.

Available Document Source Settings - Professional Mode
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Available Image Types - Professional Mode
Selecting a Scan Area - Professional Mode
Available Image Adjustments - Professional Mode
Selecting a Scan Size - Professional Mode
Parent topic: Selecting Epson Scan Settings
Related concepts

Image Preview Guidelines

Scan Resolution Guidelines

Related tasks

Selecting Scan File Settings

Available Document Source Settings - Professional Mode

You can select these Document Source options in Epson Scan Professional Mode.

Scanner Glass
Selects the scanner glass as the location where the originals are placed on your product for scanning.

ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided

Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Parent topic: Scanning in Professional Mode
Available Image Types - Professional Mode
You can select these Image Type options in Epson Scan Professional Mode.

24-bit Color
Select this setting for color photos.

Color Smoothing
Select this setting for color graphic images, such as charts or graphs.

8-bit Grayscale
Select this setting for black-and-white photos.

Black & White
Select this setting for black text documents or line art.

Parent topic: Scanning in Professional Mode
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Selecting a Scan Area - Professional Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.

Note: In Professional Mode, the default Preview mode is Normal Preview mode. To use Thumbnail
Preview mode instead, select the Thumbnail checkbox beneath the Preview button (if available), then
click the Preview button to preview your image again.

157



1. Do one of the following to select your scan area in the Preview image:

* Normal preview: Click the E_ﬁ. Auto Locate icon to create a marquee (dotted line) on the preview
image.
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+ Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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2. Do the following, as necessary, to work with the selected scan area:
+ If the marquee is correct, continue with the next step.
+ To move the marquee, click inside the scan area and drag the marquee where you want it.
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* To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

* Normal preview: To create additional marquees (up to 50, if available), click the ] Copy
Marquee icon to copy the existing marquee and paste it on the preview image.

* To delete a marquee, click the marquee, then click the -15 Delete Marquee icon.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Professional Mode
Available Image Adjustments - Professional Mode

You can select these Adjustments options in Epson Scan Professional Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

Adjustments

Q) ) |k

(4] [¥] Unshamp Mask

@ [ |

[+] || Descreening

Color Restoration
|| Backhight Comection

[+] [C] Dust Removal

Click the | ™ image adjustment icon to access additional settings.
Click the + (Windows) or » (OS X) icon next to a setting to change the level of adjustment.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
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Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Auto Exposure

Automatically adjusts the image exposure settings when you click the 4 Auto Exposure icon. To
automatically adjust image exposure settings continuously, click the Configuration button, click the
Color tab, and select Continuous auto exposure. You can adjust the level of auto exposure using a
slider.

Histogram Adjustment
Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually. (For

advanced users only.) Click the w histogram icon to access the settings.

Tone Correction
Provides a graphical interface for adjusting tone levels individually. (For advanced users only.) Click

the & tone correction icon to access the settings.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Saturation
Adjusts the density of colors in the overall image.

Color Balance
Adjusts the balance of colors in the overall image.

Color Palette
Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the

highlight and shadow areas of the image. (For advanced users only.) Click the ¥ Color Palette icon
to access the settings.
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Threshold

Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Professional Mode
Selecting a Scan Size - Professional Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 x 6 inches (102 x 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.

2. Inthe Epson Scan window, select the size you want your scanned image to be from the Target Size
list.

+] Target Sige Brin___ 1 ~][A]

Note: If you need to rotate the orientation of the target size for your image, click the M orientation
icon.
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A marquee (dotted line) appears on your preview image proportioned for the size you selected.
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3. Do the following, as necessary, to work with the selected scan area:
* To move the marquee, click inside the scan area and drag the marquee where you want it.
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» To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.

4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.

You see this window:

Tanget Size Mame:

|Jser Defined

5. Name the custom size, enter the size, click Save, and click OK. Then adjust the marquee on the
preview image.

The marquee is automatically proportioned for your custom scan size.
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6. To use additional sizing tools, click the + (Windows) or » (OS X) icon next to the Target Size setting
and select options as desired.

(=] Target Size: 5x7in. v|1 .

w [ 500 H 700| in - ﬁ

Scale: 150 20 & o
Trimming i & On

» Scale: Reduces or enlarges your image by the percentage you enter.

* Trimming: Turns automatic image cropping on or off.

- |2 Unlock icon: Unlocks the width/height proportions of the scanned image size so you can adjust
it without constraint.

Parent topic: Scanning in Professional Mode

Image Preview Guidelines

You can preview your scanned image so you can adjust the scan settings using the preview as a guide.
There are two types of preview available, depending on the scan mode and selected settings:

Thumbnail preview

A thumbnail preview displays your previewed images as thumbnails with the scanned image area and

exposure automatically selected. If the Thumbnail checkbox is selected, clicking the Preview button
opens a thumbnail preview.

Normal preview

A normal preview displays your previewed images in their entirety so you can select the scanned
image area and other settings manually. If the Thumbnail checkbox is deselected, clicking the
Preview button opens a normal preview.

Parent topic: Selecting Epson Scan Settings
Scan Resolution Guidelines
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the

resolution from the default resolution set by Epson Scan. Follow these guidelines to determine the
resolution setting you need:

* You will enlarge the image as you scan it.
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If you will enlarge the image using Epson Scan's Target Size setting, you do not need to increase the
Resolution setting.

* You will scan the image at its original size but enlarge it later in an image-editing program.

Increase Epson Scan's Resolution setting in your scan. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

* You will scan the image at 100% or smaller size.
Select Epson Scan's Resolution setting based on how you will use the scanned image:
» Email/view on a computer screen/post on the web: 96 to 150 dpi
* Print/convert to editable text (OCR): 300 dpi
» Fax: 200 dpi
Parent topic: Selecting Epson Scan Settings
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Selecting Scan File Settings

You can select the location, name, and format of your scan file on the File Save Settings window. You
can also select various optional settings that control how Epson Scan behaves when you scan and save
files.

& File Save Settings “
Location

() My Documents
®)Pictures
() Otherr  Desklop

File M ame [Prefix + 3-digh rumbes)

Predin: mg Shant Mumber: 00 =

Irmage Fomat
Type JPEG [ipal

Oplionz...
Dretails:

Compression Levet [16)
Encoding: Standard
Embed ICC Profle: OH

_ Drverwerite ang files with the same name
[¥] Show this dislog box before nest scan
[+ Dpen image fokder aiter scanning

[+] Show idd Page dislog after scanning

ok | Cancel

The File Save Settings window may appear after you click Scan on the Epson Scan window. You may

also be able to access the window by clicking the 9 icon on the Epson Scan window.
1. Do one of the following to select the folder in which you want to save your scanned image:

* Click the button for one of the displayed folders.
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» Click the Other button, click the Browse or Choose button, and select a folder.

2. Type in afile name in the Prefix field. This name is used along with numbers to automatically name
your scanned files.

Select a different number as the Start Number setting, if you like.

Select the file format you want to use in the Image Format Type menu.

If your file format provides optional settings, click the Options button to select them.
Choose any of the optional settings you want to use by selecting their checkboxes.
Click OK.

Available Scanned File Types and Optional Settings

No o bk o

Parent topic: Selecting Epson Scan Settings
Available Scanned File Types and Optional Settings

You can select from a variety of scanned file types and optional settings on the File Save Settings
window in Epson Scan.

File Formats

Bitmap (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and OS X systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

PICT (*.pct)
A standard image file format for most OS X programs.

PRINT Image Matching Il (*.jpg or *.tif)

File formats that include Epson PRINT Image Matching Il data for enhanced quality and a wider color
range (does not affect the way the image displays on the screen).
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TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Optional Settings

Overwrite any files with the same name
Select to overwrite previous files with the same names.

Show this dialog box before next scan

Select to have the File Save Settings window appear automatically before you scan (in certain Epson
Scan modes).

Open image folder after scanning

Select to have Windows Explorer or OS X Finder automatically open to the folder where your scanned
image is saved after scanning.

Show Add Page dialog after scanning
If you are scanning a multi-page document using the PDF or Multi-TIFF format, select to display a
prompt for scanning additional pages after the first page is scanned.

Parent topic: Selecting Scan File Settings

Scanning with OS X Using Image Capture

With OS X, you can scan with your product using an image-editing application such as Image Capture.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Open an image editing application, such as Image Capture.

2. Select your Epson product from the DEVICES or SHARED list in the Finder, if necessary. (You may
need to hover over the DEVICES or SHARED list, click Show, and select your product.)

3. Ifyou see the Show Details button, click it.

If you are scanning an item on the scanner glass, your product begins a preview scan.
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Select the Scan Mode setting indicating where you placed your original (if available). Select any

other available scan settings as necessary.

Kind:

Resolution:

Size:
Rotation Angle:

Auto Selection:

Scan To:
Name:

Format:

Image Correction:

Unsharp Mask
Descreening
Backlight Correction

Dust Removal

Hide Details

Color

50 & dpi

Use Custom Size

0 0
Oﬂ
Detect Separate Items

|&5] Pictures

Scan

JPEG
None

None
None
None

None

| Color Restoration

Overview

B

inches &

> il

G B O

Scan

Select the folder in which you want to save your scanned file in the Scan To pop-up menu.

Click Scan.
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Your scanned file is saved in the folder you selected.
Available Scan Settings - OS X Image Capture
Parent topic: Scanning

Available Scan Settings - OS X Image Capture

You can select these scan settings in your imaging editing application for OS X, if available.

Image Correction
Provides a graphical interface for adjusting brightness, tint, temperature, and saturation.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening

Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Color Restoration
Restores the colors in faded photos automatically.

Parent topic: Scanning with OS X Using Image Capture

Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan
projects.

Scanning to a PDF File
Restoring Photo Colors as You Scan
Scanning to Online Destinations Using Easy Photo Scan

Parent topic: Scanning

Scanning to a PDF File

Using Epson Scan, you can scan a multi-page document and save it in one PDF (Portable Document
Format) file on your computer.
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Place your original on your product for scanning.
Start Epson Scan.

Select the scan mode you want to use.

Select the scan settings for your scan.

Preview your image.

o 0k W N~

When you finish selecting all your settings, click Scan.
You see the File Save Settings window.

Lacation
" My Documents

= My Fichuss

" Other  Deskiop Browse

— File Mare [Prefis + 3-digh nunibet)

Prefix img StatMurber. | 001=]

Image Fomat 1
Type: [PDF [~.pdi] - Dptions...

Detail: Paper Size: Actual Image Size
Onertabon: Poitrait
Margic (Ledt, Top]( 0,00, 0.00in)
Page Number: 5ave File With A1 Pages
Compression Level : Standard Compression
Text Setling: ‘Yes

[ Dwensiite any fles with the same nare
¥ Show thiz dislog box before nest scan

[¥ Oper image folder alter scanring
[¥ Show Add Page dialog after scanning

| 0k I Cancel

7. Select PDF as the Type setting.

172



8. Select any other settings you want to use on the File Save Settings window. Click the Options
button to access additional settings.

9. Click OK.
Epson Scan scans your document and you see this window:

Add Page Confirmation

. Scanning cormplete.
)| Do you want to continue scanning and add more pages?

-

Select Edit Page to finizh scanning and edit the pages
before zaving the file.

Select Save File to finish scanning and save the file
withaut editing the pages.

Chddpsge | [ Edtpage | Saverie

10. Choose one of the following options:
* If you are scanning only one page, click Save File.

+ If you need to scan additional pages in a document, click Add page. Place additional pages on
the product for scanning, click Scan, and repeat until you have scanned all the pages. When you
are finished, click Save File.

* If you need to delete or reorder the scanned pages, click Edit page. Delete or reorder the pages
using the icons that appear on the bottom of the editing window. When you are finished, click OK.

Note: If you installed an OCR (Optical Character Recognition) program, you may see a screen
indicating the program is converting your page to text. Wait until the program re-scans the page and
close the program, if necessary.

11. Click Close to exit the Epson Scan window, if necessary.

Epson Scan scans your original, and saves the PDF file in the selected folder or opens it in your
scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or OS X Finder, where you can view and print the document, if desired.

173



Parent topic: Scanning Special Projects

Related tasks

Starting a Scan Using the Epson Scan Icon
Selecting the Scan Mode

Placing Originals on the Scanner Glass

Restoring Photo Colors as You Scan

You can restore the colors in faded photos as you scan them using Epson Scan's Color Restoration
setting. You can select this setting in any of the available scan modes.

Note: Color restoration is not available in Office Mode, if Epson Scan offers that mode.

Place your original on your product for scanning.
Start Epson Scan.

Select the scan mode you want to use.

Select the scan settings for your scan.

Preview your image.

Locate or access the image adjustment settings.

No o bk owbhd=

Select the Color Restoration checkbox.

V] Color Restoratiors

8. When you finish selecting all your settings, click Scan.
9. Click Close to exit the Epson Scan window, if necessary.

Epson Scan scans your original, and saves the color-restored file in the selected folder or opens it in
your scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or OS X Finder, where you can view and print the image, if desired.

Parent topic: Scanning Special Projects

Related tasks
Placing Originals on the Scanner Glass
Selecting the Scan Mode
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Starting a Scan Using the Epson Scan Icon

Related topics
Selecting Epson Scan Settings

Scanning to Online Destinations Using Easy Photo Scan

You can scan documents or photos and upload them to Facebook and other online destinations, such as
photo-sharing sites, web servers, or network folders using Easy Photo Scan.
Scanning Using Easy Photo Scan

Uploading Scanned Images to Facebook

Uploading Scanned Images to Picasa

Uploading Scanned Images to Evernote

Uploading Scanned Images to SugarSync

Uploading Scanned Images to a Web Folder

Uploading Scanned Images to Email

Saving Scanned Images to a Folder

Epson JPEG File Settings

Epson TIFF and Multi-TIFF File Settings

Parent topic: Scanning Special Projects

Related references
Epson JPEG File Settings
Epson TIFF and Multi-TIFF File Settings

Related tasks
Placing Originals on the Scanner Glass

Scanning Using Easy Photo Scan

You can use Easy Photo Scan to easily scan your originals, edit the scanned images, and upload them
to Facebook or other online destinations.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

1. Place your original on your product for scanning.
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2. Do one of the following to open Easy Photo Scan:
+ Windows 8.x: Navigate to the Apps screen and select Easy Photo Scan. Select your product
and click OK, if necessary.
* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson Software and click Easy Photo Scan. Select your product and click OK, if necessary.

* 0OS X: Open the Applications folder, click Epson Software, and click Easy Photo Scan. Select
your product and click OK, if necessary.

You see a window like this:

3. Click the [2] Scan icon.
Your scanning program launches.

4. Click Scan in the window that appears to scan your original.
The scanned image is displayed in the Easy Photo Scan window with an automatically generated
name.

Note: You may need to click the Close button to display Easy Photo Scan.
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5. To edit the name of the file, select the image thumbnail at the bottom of the screen, click the :L
icon, and enter the new filename.

6. To edit the scanned image, click the Q Edit icon and select one of the displayed options.
Note: See the Easy Photo Scan help for additional information on image editing options.

7. Repeat these steps for each image you want to upload.
8. When you finish scanning, click one of the destination icons to upload the images.

- CE e @9 «

Note: You may need to click the arrow next to the icons in order to see all of them. The available
icons may vary, depending on the software version you are using.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Uploading Scanned Images to Facebook

You can configure a Facebook account for use with Easy Photo Scan and upload your scanned images
toit.

1. Scan your original using Easy Photo Scan.

2. Click the icon.
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You see a window like this:

Transfer Settings -

Deestination

[i Facebook

Sefting Name: (Mo Selection) - ER -

| :

Abum
Fila

JPEG v Oplions

[[] Copy the image(s)to 8 local folder

Note: If you have already configured a Facebook account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account, click Login if necessary, and click Send to
upload your images.

Click Login.
On the Application Authentication screen, log in to your Facebook account.

Note: To enable automatic image uploading, select the option for staying logged in.
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5. Select an album from the Album list.

Note: If you cannot select an album, make sure the Setting Name is set to (No Selection), click
Login to log in to your Facebook account, and try again. If you want to create a new album, you
must create it directly in Facebook.

6. Select the image format for the uploaded files from the File or File Type list.

7. |If there are options for the selected file format, click Options or Option and select the options you
want.

8. If you also want to save the images to a local folder, select the Copy the image(s) to a local folder
checkbox and select a folder.

9. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,
and select Save As. Enter a name for the setting and click OK.

10. Click Send to upload the images to your Facebook account, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan

Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to Picasa
You can configure a Picasa account for use with Easy Photo Scan and upload your scanned images.
1. Scan your original using Easy Photo Scan.

[
2. Click the F_.., icon.
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You see a window like this:

Transfer Settings
Deestination
- ]
{' Ficasa
Setting Name: (Mo Selection) » Edt -

Flease kogin to your account from login button

Logn
Abum
Imaga Size:
20438 pieels W
Fia
JPEG W Ciplians

[] Copy the imageis) to a local folder

Note: If you have already configured a Picasa account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account, click Login if necessary, and click Send to

upload your images.

Click Login.

On the Application Authentication screen, log into your Google account.
Click Accept to allow Easy Photo Scan to upload images to your account.

An authentication code is generated.

Copy the authentication code into the Please enter authentication code field and click OK.
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7. Select an album from the Album list.

Note: If you cannot select an album, make sure the Setting Name is set to (No Selection), click the
Login button to log into your Picasa account, and try again. If you want to create a new album, you
must create it directly in Picasa.

8. Select an Image Size option for the uploaded images.
9. Select the image format for the uploaded files from the File or File Type list.

10. If there are options for the selected file format, click Options or Option and select the options you
want.

11. If you also want to save the images to a local folder, select the Copy the image(s) to a local folder
checkbox and select a folder.

12. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,
and select Save As. Enter a name for the setting and click OK.

13. Click Send to upload the images to your Picasa account, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan

Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to Evernote

You can configure an Evernote account for use with Easy Photo Scan and upload your scanned images
to it (Windows only).

Note: You must install Evernote before you can use it with Easy Photo Scan.

1. Scan your original using Easy Photo Scan.

2. Click the @ icon.
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You see a window like this:

Transfer Settings -

Deestination

@ Ewvemote

Setting Name: (Mo Selection) » Edt -

Notebook::

o

Fie

JPEG hd Optione

[] Copy the imageis) to a local folder

Note: If you have already configured an Evernote account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account and click Send to upload your images.

Select a notebook from the Notebook list.
Note: If you want to create a new notebook, you must create it directly in Evernote.

Select the image format for the uploaded files from the File or File Type list.

If there are options for the selected file format, click Options or Option and select the options you
want.

If you also want to save the images to a local folder, select the Copy the image(s) to a local folder
checkbox and select a folder.
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7. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,
and select Save As. Enter a name for the setting and click OK.

8. Click Send to upload the images to your Evernote account, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan

Related tasks

Scanning Using Easy Photo Scan

Uploading Scanned Images to SugarSync

You can configure a SugarSync account for use with Easy Photo Scan and upload your scanned
images.

1. Scan your original using Easy Photo Scan.

2. Click the | ¥l icon.
You see a window like this:

Transfer Settings -
Deestination
* SugarSync
Sefting Name: (Mo Selection) - ER -
E-Mal Address: Password:
Flace: Folder
| Magic Brefcase v

[] Owenvema filejz) with the sama name
| Check Connection
Fiie
[ JPEG v | Options
[] Copy the image(s) to a local folder

183



10.

11.

12.

Note: If you have already configured a SugarSync account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account and click Send to upload your images.

Enter the account information in the E-Mail Address and Password fields.
Select a Place option for the uploaded images.

Note: In SugarSync, the Magic Briefcase is now called "My SugarSync". Uploads to the Magic
Briefcase appear in the My SugarSync folder.

Enter a folder name in the Folder field.

If you enter the name of an existing folder, the images are uploaded to that folder. If the folder does
not exist, a new folder with that name is created.

If you want to replace existing files with the same name with the uploaded images, click the
Overwrite file(s) with the same name checkbox.

Click Check Connection to test whether the SugarSync account information is correct.
Select the image format for the uploaded files from the File or File Type list.

If there are options for the selected file format, click Options or Option and select the options you
want.

If you also want to save the images to a local folder, select the Copy the image(s) to a local folder
checkbox and select a folder.

If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,
and select Save As. Enter a name for the setting and click OK.

Click Send to upload the images to your SugarSync account, or click Cancel to cancel the
operation.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan

Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to a Web Folder

You can upload your scanned images to a Web Folder (WebDAV) using Easy Photo Scan.

1.

2.

Scan your original using Easy Photo Scan.

Click the icon.
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You see a window like this:

Transfer Settings -

Diestination
@ wes Foder twetDAY

Setting Name: (Mo Selection) » Edt -
Pddress:

| hittp Y campile: com//upload

User Name Password:
. |
[ Crerwrite fileis) wih the same name

Check Connection |

Fil=
JPEG W Oplions

[] Copy the image(s)to a local folder

Note: If you have already configured a Web Folder account in Easy Photo Scan, you can select the
Setting Name or Destination Name for the account and click Send to upload your pictures.

Enter the Web Folder URL in the Address field.
Enter the login information in the User Name and Password fields.

If you want to replace existing files with the same name with the uploaded images, click the
Overwrite file(s) with the same name checkbox.

Click Check Connection to test whether the account information is correct.
Select the image format for the uploaded files from the File or File Type list.

If there are options for the selected file format, click Options or Option and select the options you
want.
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9. Ifyou also want to save the images to a local folder, select the Copy the image(s) to a local folder
checkbox and select a folder.

10. If you want to save the current settings, click Edit, or the Setting Name or Destination Name field,
and select Save As. Enter a name for the setting and click OK.

11. Click Send to upload the images to your Web Folder, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan

Related tasks
Scanning Using Easy Photo Scan

Uploading Scanned Images to Email

You can save your scanned images to a local network folder and send them by email using Easy Photo
Scan.

Note: With Windows, Easy Photo Scan supports Microsoft Outlook 2000/2002/2003/2007/2010
(x86)/2013 (x86) and Windows Mail/Windows Live Mail. If you do not have one of these email
applications, Easy Photo Scan saves the images, but the email application does not open.

1. Scan your original using Easy Photo Scan.

2. Click the D icon.
You see a window like this:

Folder I&t
Fie
JPEG W Oiptionz
Location:
C:\Users\BanditPictures Browse
Help . QK | Cancel
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Note: With OS X, you also enter an email address and email text in the window. If you have already
configured email settings in Easy Photo Scan, you can select them using the Destination Name
field.

3. Select the image format for the saved files from the File or File Type list.

If there are options for the selected file format, click Options or Option and select the options you
want.

5. Do one of the following:

* Windows: Click Browse to choose the folder where you want to save the images. Then click OK
to save the images to the folder and launch your email program, or click Cancel to cancel the
operation.

+ OS X: If you also want to save the images to a local folder, select the Copy the image(s) to a
local folder checkbox and select a folder. Then click Send, or click Cancel to cancel the
operation.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan

Related tasks
Scanning Using Easy Photo Scan

Saving Scanned Images to a Folder
You can save your scanned images to a local network folder using Easy Photo Scan.
1. Scan your original using Easy Photo Scan.

2. Click the = icon.
You see a window like this:

Folder I&i
Fia
JPEG L Options
Location:
C:\Users\Bandit\Pictures Browse
Help . QK | Cancel
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Select the image format for the saved files from the File or File Type list.
If there are options for the selected file format, click Options and select the options you want.
Click Browse or the Save in field to choose the folder where you want to save the images.

o o bk w

Click OK to save the images to the folder, or click Cancel to cancel the operation.
Parent topic: Scanning to Online Destinations Using Easy Photo Scan

Related tasks
Scanning Using Easy Photo Scan

Epson JPEG File Settings
You can select from the following settings in the JPEG settings window in Easy Photo Scan.

Note: The available settings may vary, depending on the operating system you are using.

EPSON JPEG Plug-in Settings =]
Image Qualty Oplions lT'
it | BT L ey
High Cormpression High Quadity lT‘
Encoding
(®) Standard
() Progressive
[ ] Embed ICT Profile
Setting Description
Image Quality Options Specifies the compression level. The file size
increases with higher quality.
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Setting Description

Encoding Specifies the encoding method.

Standard: Images are rendered from the top to the
bottom when displayed on a web browser.

Progressive: Images are rendered in low
resolution in a web browser, then replaced with a
higher resolution.

Embed ICC Profile Allows the ICC profile (information on color
reproducibility of scanned image) to be embedded
in the image. Programs that use color
management software will display the colors of the
image using the ICC profile.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan
Epson TIFF and Multi-TIFF File Settings
You can select from the following settings in the TIFF settings window in Easy Photo Scan.

Note: The available settings may vary, depending on the operating system you are using.

EPSON TIFF Plug-in Settings [ ]
Byt Order K
®) hwindowed
Cancel
Maciiosh
Help
Coompee:an
Color/Gragscaby [Mane v|
Image Qualhy
84/ (0-33)
High Ciampression High Chusity
Bt [Hone v
Embed ICC Profie
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Setting

Description

Byte Order

Specifies the operating system where the scanned
image will be used.

Compression

Specifies the compression format and level for
Color/Grayscale and B&W images. The file size
increases with higher quality.

Embed ICC Profile

Allows the ICC profile (information on color
reproducibility of scanned image) to be embedded
in the image. Programs that use color
management software will display the colors of the
image using the ICC profile.

Parent topic: Scanning to Online Destinations Using Easy Photo Scan
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Faxing

See these sections to fax using your product.

Note: This product allows you to store names, telephone numbers, and fax data in its memory even
when the power is turned off. Make sure you restore all of the default settings if you give away or dispose
of the product. This will erase all of your network settings and fax data.

Connecting a Telephone or Answering Machine
Setting Up Fax Features

Setting Up Speed Dial and Group Dial Lists
Sending Faxes

Receiving Faxes

Connecting a Telephone or Answering Machine

You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the
same telephone line to receive calls, you can connect a telephone or answering machine to your product
using an additional phone cable.

Note: If you do not connect a telephone to your product, make sure to turn on Auto Answer mode.
Otherwise, you cannot receive faxes.

1. Connect a phone cable to your telephone wall jack and to the LINE port on your product.

@ ., LINE ﬂ’ﬂ

| /77
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Note: If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN
terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your
product. Contact your DSL or ISDN provider for the necessary equipment.

DSL connection

1  Telephone wall jack
DSL filter
3 DSL modem

ISDN connection

N
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1 ISDN wall jack
2  Terminal adapter or ISDN router

If you are connecting a telephone or answering machine to your product using a second phone
cable, remove the cap from the EXT port on your product.

@ .. LINE

Connect a second phone cable to your telephone or answering machine and to the EXT port on your
product.

LINE

AN 2NN P
TN

EXT.

Note: If you connect an answering machine and Auto Answer mode is turned on, set the number of
rings before your product answers a call to a number that is higher than your answering machine's
setting for the number of rings.
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Any phone or answering machine must be connected to the EXT port for your product to detect an
incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VoIP,
cable phone systems, or fiberoptic digital services such as FIOS.

Parent topic: Faxing

Related tasks
Selecting Fax Send and Receive Settings
Receiving Faxes Automatically (Auto Answer)

Setting Up Fax Features

Before faxing with your product, set up your fax header and select the fax features you want to use.

Note: If you leave your product unplugged for a long period of time, you may need to reset the date and
time settings for faxes.

Setting Up Fax Features Using the Product Control Panel
Setting Up Fax Features Using the Fax Ultility - Windows
Setting Up Fax Features Using the Fax Utility - OS X

Parent topic: Faxing

Setting Up Fax Features Using the Product Control Panel
See these sections to set up fax features using the product control panel.

Selecting Your Country or Region
Selecting the Date and Time

Entering Fax Header Information
Entering Numbers and Characters for Faxing
Selecting Fax Send and Receive Settings
Selecting Fax Communication Settings
Printing Fax Reports

Restoring Default Fax Settings

Fax Send Options

Fax Receive Options

Fax Print Options

Fax Report Options
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Fax Communications Options
Fax Security Options
Restore Default Settings Options

Parent topic: Setting Up Fax Features

Related tasks
Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - OS X

Selecting Your Country or Region
Before faxing, select the country or region in which you are using your product.

Note: If you change the country or region, your fax settings return to their defaults and you must select
them again.

1. Press the M home button, if necessary.
2. Select Setup.

Setup

@ Ink Levels

* Hamtenance

Printer Setup
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3. Select Basic Setup.

Basic Setup

DatesTime

Daylight Sading Time ¥

CountryRegion

4. Select Country/Region.

5. Scroll up or down, if necessary, and select your country or region.
You see a confirmation screen.

6. Ifthe setting is correct, select Yes. (If not, select No and retry.)

Note: Changing the country or region restores the fax settings to the default settings.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Selecting the Date and Time

Before faxing, select the current date, time, and daylight saving phase in your area, and choose your
preferred date and time format.

1. Press the M home button, if necessary.
2. Select Setup.
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3. Select Basic Setup.

Basic Setup

DatesTime

Daylight Sading Time ¥

CountryRegion

4. Select Daylight Saving Time.

5. Select the setting that applies to your area:
» Winter: it is winter or your region does not use Daylight Saving Time (DST)
* Summer: it is spring or summer and your region uses Daylight Saving Time (DST)
After making a selection, you return to the Basic Setup screen.

Note: If your region uses Daylight Saving Time (DST), you must change this setting to match the
season. When you change from Winter to Summer, your product automatically sets its clock ahead
one hour. When you change from Summer to Winter, it sets its clock back one hour.
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6. Select Date/Time.
Date Format
ma.dd. yyyy

yyyy.am.dd

B

5

did.mm.yyyy

7. Select the date format you want to use.
8. Use the numeric keypad to enter the current date and select Done.
9. Select the time format you want to use.

10. Use the numeric keypad to enter the current time, select AM or PM if you selected a 12-hour time
format, and select Done.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Entering Fax Header Information

Before faxing, add your sender name and fax number to the fax header to identify the source of the faxes
you send.

1. Press the M home button, if necessary.
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2. Select Setup.
3. Scroll down and select Fax Settings.

Fax Settings

Send Setti ngs

Recerwe Settings

Print Sottings

4. Select Communication.
5. Select Header.
6. Select Fax Header.

Fax Header

| 7 e 3 e
= T
4 za o o

I P  re W e g L X |

7. Use the keypad to enter the sender name for your fax source, such as your name or a business
name. You can enter up to 40 characters.

8. Select Done.
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You return to the Header screen.
9. Select Your Phone Number.

Your Phone Humber

1 y

| 5 ki Space

10. Use the numeric keypad to enter your fax number, up to 20 characters. For international numbers
that require use of a + symbol, press the # key.

Note: When entering a fax number, the * key does not work.

11. Select Done.
Parent topic: Setting Up Fax Features Using the Product Control Panel

Related tasks
Entering Numbers and Characters for Faxing
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Entering Numbers and Characters for Faxing
Follow these guidelines to enter numbers and characters for faxing and setting up your fax settings.

Enter Fax Nusber

1 9 3 -r

4 5 h Space

* To enter text or characters, press the keys on the numeric keypad until the desired character or
number appears.

* To enter symbols, press the 1 Symb. key until the desired symbol appears.
» To enter a pause symbol (=) in phone numbers requiring a brief pause during dialing, press 3.
* To move the cursor to the next space, press .
* To delete the previous character, press .
Parent topic: Setting Up Fax Features Using the Product Control Panel
Selecting Fax Send and Receive Settings
You can select the fax quality and other settings for incoming and outgoing faxes.
1. Press the f home button, if necessary.
2. Select Setup.
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3. Scroll down and select Fax Settings.

Send Settngs

Recore Settings

Print Settings

4. Select Send Settings or Receive Settings.
5. Change any of the available settings.
6. Pressthe f home button to exit.

Parent topic: Setting Up Fax Features Using the Product Control Panel

Related references
Fax Send Options
Fax Receive Options

Selecting Fax Communication Settings
You can customize how your product sends and receives faxes over your phone line.
1. Press the M home button, if necessary.
2. Select Setup.
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3. Scroll down and select Fax Settings.

Fax Settings

Send Settngs

Recore Settings

Print Settings

4. Scroll down and select Communication.
5. Change any of the available settings.
6. Press the M home button to exit.

Parent topic: Setting Up Fax Features Using the Product Control Panel

Related references
Fax Communications Options

Printing Fax Reports

You can run a variety of reports on your fax transmissions and print your speed and group dial lists.
Note: You can also view the fax log on the LCD screen.

1. Make sure you loaded letter-size or larger paper in your product.
2. Press the M home button, if necessary.
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3. Select Fax.

e
ﬂ Enter Fax Nusber

Jan 00,2004 1200 K Y

Contacts Redial

fidvanced Dptions

4. Select Advanced Options.
5. Scroll down and select Fax Report.

Fax Report

Fax Settings List

6. Select one of the available reports.
7. Press the & Start button to print the report.
Parent topic: Setting Up Fax Features Using the Product Control Panel

Related references
Fax Report Options
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Restoring Default Fax Settings

You can restore your fax settings to their default options, if necessary.
1.

Press the M home button, if necessary.

2. Select Setup.
3. Scroll down and select Restore Default Settings.

Kestore Default Settings

Fax Send/Becene Settngs

Fax Data Settings

Hetwork Settings

4. Select one of the available options.

You see a confirmation screen.

5. Select Yes or No.

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Send Options
Set the Send Settings options you want to use for outgoing faxes.
Setting Options Description
Resolution Standard Provides good scan resolution and print quality for
most faxes
Fine Provides best scan resolution and print quality for
faxes of small print and line art
Photo Provides best scan resolution and print quality for
faxed photos
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Setting Options Description
Contrast Auto Automatically adjusts the contrast for faxes
Manual Manually adjusts the contrast for faxes; negative
—41t0 +4 settings make faxes lighter and positive settings make
faxes darker
2-Sided Faxing Off Lets you fax 2-sided originals placed in the ADF
On
Direct Send Off Sends a monochrome fax to a single recipient as
on soon as the connection is made without saving the
scanned image to memory
You cannot use this setting when sending a color fax
or to multiple recipients.
Send Preview Off Lets you view the scanned image before sending
On

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Receive Options

Set the options you want to use for incoming faxes.

Double & Triple

Setting Options Description
Auto Answer Off Allows you to confirm if an incoming fax should be
printed; A telephone must be connected to the
product
On Automatically receive and print faxes
DRD All If you are using a Distinctive Ring Service on your
Sinale phone line, your telephone company can assign two
9 or more phone numbers to the same line and assign
Double different ring patterns to each. If you use this service,
Triple select the number of rings for your fax number as the

DRD setting so your product can receive faxes on the
correct number of rings. All is the default setting and
works for phone lines that do not use this service.
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Setting

Options

Description

Rings to Answer

1t09

Sets the number of rings before your product receives
a fax. The default setting is 4. If Auto Answer is turned
on and an answering machine is connected to the
product, make sure this setting is set higher than the
number of rings your answering machine is set to
answer a call.

Fax Output

Save to Inbox

Save to Computer

Save to External
Device

Create Folder to
Save

Lets you save received faxes in the product's
memory, on a computer, or on an external USB
storage device

Remote Receive

Off

On

Lets you receive faxes from a cordless handset
whose base is connected to the product. You must
first enter the start code.

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Print Options

Set the Print Settings options you want to use for incoming faxes.

Setting Options Description
Auto Reduction On Reduces size of incoming faxes to fit on the size of
paper selected as the Paper Size setting
Off Prints incoming faxes in original size or on multiple
sheets, if loaded paper size is smaller
Collation Stack Off Select On to print received faxes in descending order
On
Print Suspend Time Off Lets you stop automatic printing of faxes during a
on specified period of time; received faxes are saved in

the product's memory

Parent topic: Setting Up Fax Features Using the Product Control Panel

207




Fax Report Options

Set the options to use for printing reports.

On (Small Image)

On (Large Image)

Setting Options Description
Last Transmission On Error Prints a report on the last transmitted fax only if a fax
Report error occurs (default setting)
On Send Prints a report on the last transmitted fax after every
fax you send
Off Does not print a report on the last transmitted fax
after you send a fax
Attach Image to Report | Off Lets you print the Last Transmission Report with an

image of the first page of the document

Fax Log Auto Print

Off

Does not print a log report

On (Every 30)

Prints a log report each time 30 fax transmissions
are completed

On (Time) Prints a log report at a specified time
Report Format Simple Lets you choose to print fax log reports in simple or
Detail detailed format

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Communications Options

Set the communication options you want to use for faxing over your phone line.

Setting Options Description

Header Fax Header Lets you add the header information to outgoing
Your Phone faxes
Number
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Setting Options Description
Dial Tone Detection On Automatically dials the phone number you enter to
send a fax when the product detects a dial tone on
the line
Off Turns off automatic dial tone detection; this is

necessary if you connected your product to a phone
line on a Private Branch Exchange (PBX) or
Terminal Adapter (TA) system

Fax Speed Fast(33,600bps) Transmits faxes at 33.6 Kbps
Medium(14,400bps) | Transmits faxes at 14.4 Kbps (default setting)
Slow(9,600bps) Transmits faxes at 9.6 Kbps
ECM On Turns on Error Correction Mode (ECM) to
automatically request retransmission of faxes
received with detected errors (default setting)
Off Turns off Error Correction Mode (ECM)
Line Type PSTN Lets you change the line type for your product; PSTN
PBX (default) is a standard phone line; PBX is used in

office environments where an access code such as
"9" must be dialed to call an outside line

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Security Options

Set the Security Settings options you want to use for fax data.

Setting Options Description

Auto Erase Backup Off Select On to automatically erase sent or received fax

Data on data remaining in your product's memory

Erase Backup Data Yes Deletes all sent or received fax data remaining in your
No product's memory; select Yes if you are giving away

or disposing of your product

Parent topic: Setting Up Fax Features Using the Product Control Panel
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Restore Default Settings Options
Select the product settings you want to restore.

Fax Send/Receive Settings
Restores all of the default fax settings on the Send Settings, Receive Settings, and
Communication screens.

Fax Data Settings
Erases the speed dial list, group dial list, header, and fax log.

Network Settings
Restores all of the default network settings.

All Except Network & Fax Settings
Restores all of the default settings on the control panel, except for the network and fax settings.

All Settings
Restores all of the default settings on the control panel.

Parent topic: Setting Up Fax Features Using the Product Control Panel

Related tasks
Restoring Default Fax Settings

Setting Up Fax Features Using the Fax Utility - Windows
You can set up your fax header and select your fax settings using the FAX Utility for Windows.
1. Do one of the following:
* Windows 8.x: Navigate to the Apps screen.

* Windows (other versions): Click E’ or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
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You see this window:

3. Select Fax Settings for Printer. (Select your product, if prompted.)
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You see this window:

- Fax Settings for Printer - o IEN

Tool Check Fax Connection

Fao: Setings

Receved Fax Ouiput Sethings

Speed Dial/Group Dial List

Halp [ Help

4. Select Fax Settings.
5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.

Note: For detailed information, select the FAX Utility Help option.

Parent topic: Setting Up Fax Features

Related topics
Setting Up Fax Features Using the Product Control Panel

Setting Up Fax Features Using the Fax Utility - OS X
You can set up your fax header and select your fax settings using the FAX Utility for OS X.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select the FAX option for your product, and select Options & Supplies.
Select Utility and select Open Printer Utility.
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2. Double-click FAX Utility, if necessary.
You see this window:

a0 FAXY, Litility
Printer FAX EFS0OMN
Taol \ II. m
— 23
: X e
Fas Transmigs-on Syfalapend I Fas Retewt Monnor
Eecard Comacss
Fax Settings - \ 1 A
R, ;\ ||l
Check Fax Fax Semsgs S D)) Crowes
5 Confection Dhial Lit

3. Select your FAX product in the Printer list.
4. Select Fax Settings.

5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.

Note: For detailed information, select the FAX Utility ? icon.

Parent topic: Setting Up Fax Features

Related topics
Setting Up Fax Features Using the Product Control Panel

Setting Up Speed Dial and Group Dial Lists

You can set up a speed dial list of fax numbers so you can quickly select them for faxing. You can also
set up a group dial list to send a fax message to multiple speed dial numbers.

See these sections to set up speed dial and group dial lists.

Setting Up Speed/Group Dial Lists Using the Product Control Panel
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
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Setting Up Speed/Group Dial Lists Using the Fax Utility - OS X
Parent topic: Faxing

Setting Up Speed/Group Dial Lists Using the Product Control Panel
You can set up your speed dial and group dial lists using the control panel on your product.

Creating Speed Dial List Entries
Printing Your Speed Dial List
Creating Group Dial List Entries
Printing Your Group Dial List

Parent topic: Setting Up Speed Dial and Group Dial Lists

Related tasks
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - OS X

Creating Speed Dial List Entries
You can create a speed dial list of fax numbers to help you quickly send faxes.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Press the M home button, if necessary.
2. Select Fax.

|
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3. Select Contacts.
4. Select Add/Edit Contacts.
5. Select Speed Dial Setup.

fidd Speed Dial

Select the speed dial entry number you want to use for the fax number you are adding.

Use the numeric keypad to enter the fax number. You can enter up to 64 characters.
8. Select Done.

You see this screen:

9. Use the keypad to enter a name for the speed dial entry. You can enter up to 30 characters.
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10. Select Done.
You see a confirmation screen.
11. Do one of the following:
+ Select Options to enter a fax speed for the entry.
+ Select Done.
12. Select OK to return to the Add/Edit Contacts screen.
13. Do the following as necessary:
* To create additional entries, select Speed Dial Setup and repeat the steps above.
» To create a group dial entry, select Group Dial Setup.
+ To edit an existing entry, select Edit Contacts, select the entry, and change the information.

» To delete an entry, select Delete Contacts, select the entry, select Proceed, and confirm the
deletion.

Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel

Related tasks
Printing Your Speed Dial List

Printing Your Speed Dial List
You can print your speed dial list for easy reference.
1. Load paper in your product.
2. Press the M home button, if necessary.
3. Select Fax.

f
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4. Select Advanced Options.
5. Scroll down and select Fax Report.

Fax Report

Fux Settings List

Fi Log

Last Transmissi

6. Scroll down and select Speed Dial List.
7. Press the & Start button to print the report.
Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel
Creating Group Dial List Entries
You can create a group dial list after creating a speed dial list. Each group dial list can include up to 30
fax numbers.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Press the M home button, if necessary.

217



2.
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Select Fax.
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Select Contacts.

Select Add/Edit Contacts.

Select Group Dial Setup.

Select the number you want to use for the group dial entry you are adding.

Use the numeric keypad to enter a name for the group dial entry. You can enter up to 30 characters.
Select Done.

Select the speed dial entry you want to add to the group and press ¥ to select it.

10. Continue selecting speed dial entries as necessary.

11. When you are finished, select Done.

You return to the Add/Edit Contacts screen.

12. Do the following as necessary:

» To create additional entries, select Group Dial Setup and repeat the steps above.
+ To edit an existing entry, select Edit Contacts, select the entry, and change the information.

* To delete an entry, select Delete Contacts, select the entry, select Proceed, and confirm the
deletion.

Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel
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Related tasks
Printing Your Group Dial List
Creating Speed Dial List Entries

Printing Your Group Dial List
You can print your group dial list for easy reference.
1. Load paper in your product.
2. Press the M home button, if necessary.
3. Select Fax.

e
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4. Select Advanced Options.
5. Scroll down and select Fax Report.

Fax Report

Fax Settings List

Fa Log

Last Tramsmissi
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6. Scroll down and select Group Dial List.
7. Press the & Start button to print the report.
Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows

You can set up your speed dial and group dial lists using the FAX Utility for Windows. The ultility also lets
you import fax numbers from the Windows Address Book and back up fax numbers stored in your
product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Do one of the following:
» Windows 8.x: Navigate to the Apps screen.

* Windows (other versions): Click B or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.

You see this window:

- FAX Utility - olEN

Fax Transmussesn Send Cover Shesst Onily

Tzl PC-FAX Phone Baok

Fax Transmusson Record

Fax Setfings FOFAX Settings
Fax Settings for Printer
Others Add Anathar Prirter {Fax)

Onbine Hap
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3. Select Fax Settings for Printer. (Select your product, if prompted.)

You see this window:

4. Select Speed Dial/Group Dial List.
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You see this window:

wi Speed Dial/Group Dial List m

Fe [t Yaw Heg [r——
rlr.

Ermtry Musmbsty | Marvet Gioap Nisne | b Woed | Fan Mureler |Fa Speed Lo

aomume 150 Speond Daak 0 Groupe 0

5. Select an empty entry and click the # icon.

Note: To edit an entry, select it and click the # icon. To delete an entry, select it and click the "
icon.

6. Do one of the following:
» To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.

» To create a group dial entry, select Group, enter a name, select your desired fax numbers, and
click OK.

7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.
&
8. When you are finished, click the £= icon to save the entries to your product's memory.

Parent topic: Setting Up Speed Dial and Group Dial Lists

Related topics
Setting Up Speed/Group Dial Lists Using the Product Control Panel
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Setting Up Speed/Group Dial Lists Using the Fax Utility - OS X

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import
fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select the FAX option for your product, and select Options & Supplies.
Select Utility and select Open Printer Utility.

2. Double-click FAX Utility, if necessary.
You see this window:

an FAX Lhility
Printer FAX EPSON
Taool \ II- —
— . 3
r —=3
Fam Tramemasson Srrainpe T Fan Recess Monnor
Esind Comueni
Fax Settings . % 1 | r
W : ll
Check Fas Fix Seimsgs Speed D4l ) Crow
? Cannsction Diial L

3. Select your FAX product in the Printer list.
Select Speed Dial/Group Dial List.
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7.
8.
9.

You see this window:
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To add an entry, double-click an empty entry.

Note: To edit an entry, select it and change the information. To delete an entry, select it and press
the Delete key on your keyboard.

Do one of the following:
» To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.

» To create a group dial entry, select Group Dial, enter a name, select your desired fax numbers,
and click OK.

Repeat the previous steps as necessary to add all your speed dial or group dial entries.
IR
To import entries from your MacAddress book, click the L icon.

When you are finished, click the - icon to save the entries to your product's memory.

Parent topic: Setting Up Speed Dial and Group Dial Lists
Related topics
Setting Up Speed/Group Dial Lists Using the Product Control Panel

Sending Faxes

See these sections to send faxes using your product.
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Sending Faxes from the Product Control Panel
Sending Faxes Using the Fax Utility - Windows
Sending Faxes Using the Fax Utility - OS X

Parent topic: Faxing

Sending Faxes from the Product Control Panel
See these sections to send faxes using the product's control panel.

Manually Dialing or Redialing Fax Numbers
Selecting Fax Numbers from Speed or Group Dial Lists
Dialing Fax Numbers from a Connected Telephone
Broadcasting a Fax
Sending a Fax at a Specified Time
Fax Sending Options
Parent topic: Sending Faxes
Manually Dialing or Redialing Fax Numbers

You can send a fax from your product control panel by manually dialing the fax number or redialing the
last dialed fax number.

1. Place your original on the product for faxing.
2. Press the M home button, if necessary.
3. Select Fax.

f
ﬂ Enter Fax Number |
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4. Do one of the following:

+ Select the Enter Fax Number area on the LCD display, then use the numeric keypad to enter the
fax number. You can enter up to 64 characters.

+ Select Redial to redial the last dialed fax number.
5. If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

6. Pressthe <& Start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Send Options

Related tasks
Entering Numbers and Characters for Faxing

Related topics
Placing Originals on the Product

Selecting Fax Numbers from Speed or Group Dial Lists

You can send a fax from your product control panel by selecting a speed dial or group dial entry from the
list.

1. Place your original on the product for faxing.

2. Press the M home button, if necessary.
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3. Select Fax.
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4. Select Contacts.

5. Select the speed dial or group dial entry you want to use.

6. If you need to change any fax settings, scroll down and select your settings.
Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

7. Press the <& Start button. If prompted, select where you placed your document (ADF or scanner

glass).
Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options
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Related topics
Placing Originals on the Product
Setting Up Speed Dial and Group Dial Lists

Dialing Fax Numbers from a Connected Telephone

If you have connected a telephone to the EXT port on your product, you can send a fax by dialing the fax
number from the connected telephone.

1. Place your original on the product for faxing.
2. Press the M home button, if necessary.
3. Select Fax.

e
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4. Dial the fax number from the connected telephone.

Note: If you are using a pre-paid calling card, enter the number and password required to use the
card before entering the destination fax number.

5. Select Send on the LCD screen.

Note: Your product now communicates with the recipient's fax machine. Do not hang up the
telephone.
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6. If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

7. Press the & Start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
8. Hang up the telephone.
After scanning your originals, your product sends the fax.
Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Broadcasting a Fax

You can easily send a fax to several recipients at the same time using your speed dial list or group dial
list, or by entering phone numbers. You can send the same fax to up to 30 phone numbers.

Note: You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.
2. Pressthe M home button, if necessary.
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3. Select Fax.
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4. Select Advanced Options.

5. Select Broadcast Fax.

6. Select Add New and select one of the following:
* Enter Fax Number to use the numeric keypad to manually enter fax numbers.
» Select From Contacts to select a speed or group dial entry.

7. Repeat the step above to add additional fax recipients, if necessary.

8. When you have finished selecting your recipients, select Done.

9. If you need to change any fax settings, scroll down and select your settings.

10. Press the & Start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel
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Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending a Fax at a Specified Time

You can send a fax at a time of your choice.

Note: You can only send faxes in black-and-white when you use this option.

1.
2.
3.

® N o o A

Place your original on the product for faxing.
Press the M home button, if necessary.
Select Fax.

e
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Enter a phone number or select a number from a speed or group dial list.
Select Advanced Options.

Select Send Fax Later.

Select On, use the number pad to enter your desired time, then select Done.
If you need to change any fax settings, scroll down and select your settings.
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9. Press the < Start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.

After scanning your originals, your product dials the number and sends the fax at the specified time. You
cannot send additional faxes until the timed fax has been sent.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel

Related topics
Placing Originals on the Product

Fax Sending Options
While sending a fax, you can select these options.

Setting Options Description
Resolution Standard Provides good scan resolution and print quality for
most faxes
Fine Provides best scan resolution and print quality for
faxes of small print and line art
Photo Provides best scan resolution and print quality for
faxed photos
Contrast Auto Automatically adjusts the contrast for faxes
Manual Adjusts the contrast for faxes; negative settings make
faxes lighter and positive settings make faxes darker
—-4to+4
2-Sided Faxing Off Lets you fax 2-sided originals placed in the ADF
On
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Setting Options Description
Direct Send Off Sends a monochrome fax to a single recipient as
on soon as the connection is made without saving the
scanned image to memory
You cannot use this setting when sending a color fax
or to multiple recipients
Send Preview Off Lets you view the scanned image before sending
On

Parent topic: Sending Faxes from the Product Control Panel

Sending Faxes Using the Fax Utility - Windows

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time,

including a cover sheet.

1. Open the file you want to fax and select the print command.
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You see a window like this:

General

Selact Prinder
% Add Printer
=5 EPSON
(S EPSON (FAX)

<

Status: Oz
Location
Coemment :

Faga Range
oL

Selection

Pages

Select your product with the FAX option as the printer.

To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the
Preferences or Properties button.

Note: If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties
on the next screen. For more information about selecting fax print settings, click Help.

Select the Page Range as necessary. (Leave the Number of copies setto 1.)
Click Print or OK.
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If you're faxing for the first time, you see a window like this one:

Enter Sender Information ﬂ

Naclkonamee:
Nearme:
Phone Humber: Fax Humber:

Addriss:

Company)/Corp.:
Divicion) Tithe:

QK I Cancel

6. Enter your sender information so that recipients can identify the origin of the fax. Then click OK to
save the sender information.
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You see a window like this:

Faix Mumissr:

Becmuse *-" actt a5 & pause, do not use it b
punCtuabe phons rumbens,

DevisionTite:

|

7. Enter the recipient's name and fax number or select a recipient from the phonebook, then click Next.
Note: For detailed instructions on using the Epson FAX Utility, click Help.

8. Select a cover sheet and enter a subject and message, then click Next.

9. Click Send to transmit your fax.
Parent topic: Sending Faxes

Sending Faxes Using the Fax Utility - OS X
You can send a fax from a OS X printing program using the FAX Utility. You can fax up to 100 pages at a
time, including a cover sheet.

1. Open the file you want to fax.
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Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

Printer:  FAX [T
Presets:  Default Settings kd
Copias: 1
Pages: £ Al
From: 1 to: (1
Paper Size: US Letter kJ 8500y 11.00 inches
Oriantation: ' * f » Scale: 100 %

Select your product FAX option as the Printer setting.

If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.

Select the number of pages you are faxing as the Pages setting.
Note: Leave the Copies setting set to 1.

Select Recipient Settings from the pop-up menu.
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You see this window:

Raciplant Settings ﬂ
Recipient List:
Marma Company/Carp. Fax Murmber
1
Add:

MName:;

Company/Corp.:

Fax Mumber:

A nyphen (-] ls evailable only at the
beginning of the phone number bacause
it acts as a pausa in dialing.

External Access Prefix:

Cancel

Do one of the following to choose your recipient:

» Select a name or group from the Recipient List.

* Enter a name, company, and fax number and click the + button.
» Click the |1| icon and select a recipient from your address book.
Select Fax Settings from the pop-up menu.
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You see this window:

Fax Settings % |
Color: ) Black & White

Colar

Image Quality:  MNormal [+ |

Cancel

9. Select the Color and Image Quality settings you want to use for your fax.
10. Click Fax.

Parent topic: Sending Faxes

Receiving Faxes

See these sections to receive faxes with your product.

Fax Reception

Receiving Faxes Automatically (Auto Answer)
Receiving Faxes Manually

Viewing Faxes on the LCD Screen

Parent topic: Faxing

Fax Reception

Your product will automatically receive and print faxes when you set fax reception to Auto Answer mode.

If you connected a telephone to your product so you can use the same phone line for faxes and voice
calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone
using the telephone and press a button on your product to receive the fax.

Make sure to load paper in your product and select your fax settings before receiving a fax.
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Note: If you run out of paper during fax printing, load more paper and press the button indicated on your
product's LCD screen to continue.

Parent topic: Receiving Faxes

Receiving Faxes Automatically (Auto Answer)
To receive and print faxes automatically, you can turn on Auto Answer mode.

Check the ¥ auto answer icon in the upper right corner of your product's Home screen to see if Auto
Answer mode is turned on or not.

 Home

Primt

Copy Fhotos Scan

Dt Tess - TR
o =

To turn Auto Answer mode on or off, select Setup > Fax Settings > Receive Settings > Auto Answer.

If an answering machine is connected, make sure the product's Rings to Answer setting is set higher
than the number of rings your answering machine is set to answer a call. For example, if the answering
machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

If a telephone is connected, and you use it to answer a call that turns out to be a fax, wait until the
product's LCD screen displays a message that a connection has been made before hanging up.

Parent topic: Receiving Faxes

Related references
Fax Receive Options
Fax Communications Options

Related tasks
Receiving Faxes Manually
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Receiving Faxes Manually

You can set up your product to receive faxes manually by turning off Auto Answer mode. This lets you
check for a fax tone on the connected telephone before receiving a fax.

1. When the connected telephone rings, answer the call.

2. Ifyou hear a fax tone, select Receive on the LCD screen.
3. Press the & Start button, then hang up the phone.

4. Press the & Start button again to print the fax.

Parent topic: Receiving Faxes

Viewing Faxes on the LCD Screen

You can save received faxes in your product's memory and view them on the LCD screen. To save faxes
rather than printing them, select Setup > Fax Settings > Receive Settings > Fax Output > Change
Settings > Save to Inbox.

1. Press the M home button, if necessary.
If faxes have been received, you see a message on the home screen.
Select Open Inbox.
3. Select the fax you want to view.
You see the fax displayed on the screen.
4. Do the following, as necessary:
* To view the next fax, select the right arrow icon.
« To print the fax, press the <& Start button.
+ To display the menu for printing and deleting, select the v= icon.

Note: You can also select Menu on the main Inbox screen to print or delete all faxes at the same time.
Delete faxes after you print or view them to prevent the product's memory from filling up. When the
memory is full, you cannot receive or send faxes.

Parent topic: Receiving Faxes

Related references
Fax Receive Options
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Using Memory Cards With Your Product

Follow the instructions here to work with a memory card inserted into your product.

Inserting a Memory Card
Printing from a Memory Card
Transferring Photos on a Memory Card

Inserting a Memory Card
Insert only one memory card at a time into the memory card slot on your product.

1. Make sure the memory card and the files on it are compatible with your product before inserting the
card.

2. Insert your memory card into the slot, making sure the card is oriented correctly.

1 Memory card access light

Note: Do not force the card all the way into the slot. Insert it only until it meets resistance.
The memory card access light flashes and then stays lit.

Caution: Do not remove the memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.
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Memory Card Types
Memory Card File Specifications
Removing a Memory Card

Parent topic: Using Memory Cards With Your Product

Memory Card Types

You can insert these types of memory cards in your product.

Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.

You can insert the following cards in the memory card slot:
+ SD

+ SDHC

+ SDXC

* miniSD*

* miniSDHC*

* microSD*

* microSDHC*

* microSDXC*

Parent topic: Inserting a Memory Card

Memory Card File Specifications

You can insert memory cards in your product containing files that meet these specifications.

File format JPEG with the Exif version 2.3 standard (taken with digital camera
using DCF (Design rule for Camera File system) version 1.0 or 2.0
compliant)

Image size 80 x 80 pixels to 10200 x 10200 pixels

File size Up to 2GB

Number of files Up to 9990
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Note: DCF 2.0 files stored in a camera's built-in memory are not supported.
Parent topic: Inserting a Memory Card

Removing a Memory Card

After you finish working with a memory card, check to make sure it is safe to remove it from your product.

Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.

1. Make sure the memory card access light is not flashing.

2. If your product is connected to your computer using a USB cable, do one of the following:

* Windows: Open the My Computer, Computer, Windows Explorer, or File Explorer utility.
Then right-click the name of your memory card (listed as a removable disk) and select Eject.

» OS X: Drag the removable disk icon for your memory card from the desktop or computer window
into the trash.

3. Pull the memory card straight out of its slot.
Parent topic: Inserting a Memory Card

Printing from a Memory Card

See these sections to print photos from a memory card inserted into your product:
Viewing and Printing Photos

Printing Photo Layouts from a Memory Card
Printing Photo Greeting Cards
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Parent topic: Using Memory Cards With Your Product

Viewing and Printing Photos

See these sections to view and print photos displayed on your product's LCD screen.

Viewing and Printing Photos From the LCD Screen
Cropping Photos Displayed on the LCD Screen
Photo Adjustment Options - Memory Card

Print Setting Options - Memory Card

Paper Type Settings - Memory Card

Parent topic: Printing from a Memory Card
Viewing and Printing Photos From the LCD Screen
You can select photos for printing as you view them on the LCD screen.
1. Press the  home button, if necessary.
2. Select Print Photos.

f 14-“ ~ iﬁ%
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3. Do one of the following to select your photos:

» To select individual photos, select the thumbnail image of the photo you want to print, then press
the + or — button to select the number of copies (up to 99). Press the left or right arrow button to
scroll through and select additional photos, or press the 3 Back button to return to the thumbnail
image view and select another photo.
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» To select all photos, select Options > Select Photos > Select All Photos, then press the + or —
button to select the number of copies (up to 99). Select Done when finished.

» To select photos based on the date they were taken, select Options > Browse > Browse by
Date, then select any of the dates shown. Select Proceed, select the thumbnail, then press the +
or — button to select the number of copies (up to 99).

4. To adjust your photos, do either of the following as necessary (adjustments modify only your printed
copy, not the original file):

» To crop, zoom into, or rotate a photo, select the thumbnail image of the photo you want to modify,
then select Edit > Crop/Zoom. Make the necessary adjustments, select the OK button, then
select the OK button again to confirm your changes.

» To change the appearance (e.g., brightness and contrast) of your printed photos, select the
thumbnail image of a photo, select Edit > Photo Adjustments, and select the necessary settings.
When you are finished, press the 3 Back button twice.

» To change a photo to black and white or add a sepia (brown) effect, select the thumbnail image of
a photo, select Edit > Filter, and select the necessary setting. When you are finished, press the
3 Back button twice.

5. To change the print settings, select Settings, then select the necessary settings. When you are
finished, press the 5 Back button.

6. When you are ready to print, press the <& Start button.
Note: To cancel printing, select Cancel.

Parent topic: Viewing and Printing Photos

Related references
Photo Adjustment Options - Memory Card
Print Setting Options - Memory Card

Related tasks
Cropping Photos Displayed on the LCD Screen

Cropping Photos Displayed on the LCD Screen

If you want to crop or rotate photos displayed on the LCD screen, select the thumbnail image of the
photo you want to modify, select Edit > Crop/Zoom, and select the necessary options.

* To crop the photo, press the + icon to move the yellow crop area inward or the — icon to move the crop
area outward.

* To move the crop area, select the arrows.
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» To rotate the crop area, select 9.

» To check the cropped image, select OK.

Parent topic: Viewing and Printing Photos
Photo Adjustment Options - Memory Card

Select the Photo Adjustment options you want to use when viewing and printing photos displayed on
the LCD screen. The modifications affect only the printed copy of the photo, not the original file.

Photo Adjustment |Available options Description
settings
Fix Photo Fix Photo On Automatically adjusts the brightness, contrast, and

saturation of the photo based on the Scene
Detection setting that is selected.

Fix Photo Off Turns off automatic adjustments; see Note below

P.I.LM. Uses your camera's PRINT Image Matching or Exif
Print adjustments

Scene Detection Automatic Optimizes the Fix Photo adjustments for specific
types of photos; select the option that best matches

People your photo content
Landscape
Night Scene
Fix Red-Eye Off - Current Automatically fixes the red-eye effect in photos

On - Current
Off - All Photos

On - All Photos
Brightness Various settings Adjust individual qualities in your photo
Contrast
Sharpness
Saturation

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
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face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the

special color effects.

Parent topic: Viewing and Printing Photos

Print Setting Options - Memory Card

Select the Print Settings options you want to use when printing photos displayed on the LCD screen.

types

Print settings Available Description
options
Paper Size Various paper Indicates the size of paper you have loaded
sizes
Paper Type Various paper Indicates the type of paper you have loaded; see the list of

paper types for copying (available options depend on the
selected Paper Size setting)

Paper Source

Cassette 1 Prints onto paper loaded in Cassette 1 (upper cassette)
Cassette 2 Prints onto paper loaded in Cassette 2 (lower cassette)
Cassette Prints onto paper loaded in Cassette 1 and then onto paper

1>Cassette 2

loaded in Cassette 2 when the first cassette is empty (load
the same size and type of paper in both cassettes when
selecting this option)

Rear Paper Prints onto paper loaded in the rear paper feed slot
Feed Slot
Borderless Borderless Expands the image to the edge of the paper (slight cropping
may occur)
With Border Leaves a small margin around the image
Quality Draft Provides lower quality for draft printing
Standard Provides good quality for most prints
Best Provides the highest quality for important prints
Expansion Standard Expands images correctly for most borderless prints
Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints (you may see

some white border)
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Print settings Available Description
options
Date Various date Prints the date the photo was taken on the photo in the
formats format you select
Print Info. On Camera Prints settings that you added in your camera
Photos Settings
Camera Text Prints text that you added in your camera
Landmark Prints location information embedded in a photo by cameras
that have a built-in GPS feature
Fit Frame On Automatically crops the photo to fit into the selected photo
layout
Off Turns off automatic cropping
Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality
Clear All Settings Yes Clears all print settings
No

Parent topic: Viewing and Printing Photos

Paper Type Settings - Memory Card

Select a Paper Type setting that matches the paper you loaded.

Paper type loaded

Paper Type setting

Plain paper

Epson Bright White Paper
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Plain Paper

Epson Presentation Paper Matte

Presentation Matte

Epson Premium Presentation Paper Matte
Epson Ultra Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-sided

Prem. Matte
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Paper type loaded Paper Type setting

Epson Premium Photo Paper Glossy Prem. Glossy
Epson Ultra Premium Photo Paper Luster

Epson Ultra Premium Photo Paper Glossy Ultra Glossy

Epson Photo Paper Glossy Glossy

Epson Premium Photo Paper Semi-gloss Prem. Semi-Gloss
Epson Velvet Fine Art Paper Velvet Fine Art Paper

Parent topic: Viewing and Printing Photos

Printing Photo Layouts from a Memory Card
You can print one or more photos from a memory card in special layouts on various sizes of photo paper.
1. Load photo paper in your product.
2. Press the M home button, if necessary.
3. Select More Functions.

More Functions

B0 Copy/Restore Photos

ﬂ Photo Layout Sheet

l. Greeting Card
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4. Select Photo Layout Sheet.

Print Layout

Picture Package .

2-Up E
=
e

5. Scroll down to view all of the layout options, then select the option you want.
6. Select the paper size, type, and source, then select Proceed.
7. If you see a screen asking you to choose between automatic and manual placement of photos, do

one of the following:

+ Select Automatic Layout if you want to allow your product to place the photos in the layout
automatically.

+ Select Place Photos Manually to place photos in the layout manually.

8. Select the photos you want to print and select Proceed. If you chose to place the photos manually,
follow the instructions on the LCD screen to select and place your photos on the layout, then select
Proceed.

9. Press the + or — buttons to select the number of layout sheets to print (up to 99), then select
Proceed.

10. Select additional print settings for your layout as necessary.
11. When you are ready to print, press the <& Start button.

Note: To cancel printing, select Cancel.

Photo Layout Options
Parent topic: Printing from a Memory Card
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Photo Layout Options
Select the layout you want to use when printing your photos in a layout.

Picture Package
Prints one photo in multiple sizes on one sheet.

2-up, 4-up, 8-up, or 20-up
Print 2, 4, 8, or 20 photos on one sheet.

Upper 1/2
Print one photo in the upper half of the sheet.

Lower 1/2
Print one photo in the lower half of the sheet.

Photo ID
Prints 4 ID-sized photos on one sheet.

Jewel Upper
Prints one photo on the upper half of a folded jewel case insert.

Jewel Index
Prints 24 to 48 thumbnail images on a folded jewel case insert.

Parent topic: Printing Photo Layouts from a Memory Card

Printing Photo Greeting Cards

You can create custom greeting cards using photos on your memory card or other device, and add your
own handwritten or printed text.

First you select your photo and print a template on plain paper. Then you fill out the template, add your
message, and print your cards.

Creating and Printing a Greeting Card Template
Printing a Greeting Card from a Template

Parent topic: Printing from a Memory Card
Creating and Printing a Greeting Card Template
Before you start, make sure plain paper is loaded and your memory card is inserted.
1. Press the M home button, if necessary.
2. Select More Functions.
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3. Select Greeting Card.

Greeting Card

select Photo and Pont lemplate

Print Greeting Cards
from Template

4. Select Select Photo and Print Template.
5. Select the photo you want and select Proceed.

6. Select Paper Size, then select Letter to print three cards on one letter-size sheet or 4x6in to print
one card.

7. Select Paper Type, then select the type of paper you plan to use.

8. Select the other print settings as necessary and select Proceed.

9. When you are ready to print your greeting card template on plain paper, press the & Start button.
Parent topic: Printing Photo Greeting Cards

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing a Greeting Card from a Template
After your greeting card template is printed, you fill it out to create your card and add your message.
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1.

Use a dark pen or pencil to fill in the circles and select the Text Style and Text Effects.

A 3D Text
O A 2D Text

Add your greeting card message within the box. You can write it in by hand, print a message and
paste it into the box, or draw a picture.

Tip: When adding text, place it in the direction that your photo faces.

Load photo paper either in Cassette 2 (lower) for this size: Letter (8.5 x 11 inches [216 x 279 mm]),
or in Cassette 1 (upper) for this size: 4 x 6 inches (102 x 152 mm).

Select Print Greeting Cards from Template. (If you do not see this option, press the f home
button and select More Functions > Greeting Card > Print Greeting Cards from Template.)

Follow the instructions on the LCD screen to place the template facedown on the scanner glass, with
the blue triangle facing into the front right corner.

Close the document cover and select Proceed.
To print more than one copy, select the + or — buttons to select the number (up to 99).
When you are ready to print, press the & Start button.

Note: To cancel printing, select Cancel.

When you finish printing, cut your greeting cards apart, if necessary.
Parent topic: Printing Photo Greeting Cards
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Related tasks
Creating and Printing a Greeting Card Template

Transferring Photos on a Memory Card
You can transfer photos to and from a memory card inserted into a memory card slot on your product.

Setting Up File Sharing for Photo Transfers From Your Computer
Transferring Photos from a Memory Card to Your Computer

Parent topic: Using Memory Cards With Your Product

Setting Up File Sharing for Photo Transfers From Your Computer

Before you transfer photos from a computer to a memory card inserted into a memory card slot on your
product, you may need to set up your product's file sharing settings.

Caution: Remove the memory card before you change this setting or you may lose data from the
memory card. Do not remove a memory card or turn off your product while the memory card access light
is flashing or you may lose data from the memory card.

Remove any memory cards from the product.
Press the M home button, if necessary.

Select Setup.
Scroll down and select File Sharing Setup.

o kw0 bd -~

Select the connection type between the printer and your computer.
Parent topic: Transferring Photos on a Memory Card

Related tasks
Removing a Memory Card

Transferring Photos from a Memory Card to Your Computer

You can transfer photos to and from a memory card inserted into a memory card slot on your product
and a computer connected to your product.

Note: Do not transfer photos to and from a memory card while you are printing from the memory card.

1. Make sure your product is connected to a computer.
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2. Insert a memory card into a memory card slot on your product.
3. Do one of the following to access your memory card files from your computer:

* Windows: Open the Computer, My Computer, Windows Explorer, or File Explorer utility, then
select the removable disk icon.

+ OS X with a USB connection: Look for the removable disk icon on your desktop or computer
window, then select it.

* OS X with a network connection: Select the hard drive icon on your desktop or computer
window, select your product in the SHARED section of the sidebar (you may need to widen the
sidebar to see the name), then select the MEMORYCARD icon.

4. Select the folder that contains your photos.
5. Drag the photos you want to transfer to the desired folder on your computer or on your memory card.

Note: Your product's LCD screen does not update to display new photos transferred to the memory
card. Wait until the memory card access light stops flashing, then remove and insert the memory card to
update the photos displayed.

Parent topic: Transferring Photos on a Memory Card

Related tasks
Inserting a Memory Card
Removing a Memory Card
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Using an External Device with Your Product

Follow the instructions in these sections to use your product with an external device, such as a camera,
smartphone, or other device.

Printing from a Camera
Viewing or Printing from a USB Flash Drive or External Device
Printing From a Home Network Device (DNLA)

Printing from a Camera

If you have a digital camera that supports PictBridge printing, you can print your photos directly from the
camera. Check your camera manual to see if it is compatible.

Note: Your photos must be in JPG format and sized from 80 x 80 to 10200 x 10200 pixels. Epson
cannot guarantee the compatibility of your camera. Some combinations of paper type, size, and layout
may not be supported, depending on your camera and the product settings.

Selecting Print and Photo Adjustment Settings
Connecting and Printing from a Camera
Printing from a Camera Wirelessly

Parent topic: Using an External Device with Your Product

Selecting Print and Photo Adjustment Settings

Before printing from your camera, you can make image adjustments and select the print settings for your
photos. Image adjustments affect only the printed copy of the photo, not the original file.

1. Press the f home button, if necessary.
2. Select Setup.
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3. Scroll down and select External Device Setup.

External Device Setup

u Print Settings

. Photo ddjustments

4. Select Print Settings.

Print Settings
Paper Sire
Letter
Paper |ype
Plain Paper

Faper Source
Lasselie 72

Layaul

5. Select the print settings you want to use.
6. When you are done, press the 3 Back button.
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7. Select Photo Adjustments.

Photo Adustment s

Fe Photo

Fix Photo Dn

acene Detection
Automatic L J

b Hed-Eye
i

Filker

8. Select the photo adjustments you want to use.
9. Press the f home button to exit.

After you select settings, you are ready to connect your camera and print your photos.
Print Settings - Camera
Photo Adjustments - Camera

Parent topic: Printing from a Camera
Print Settings - Camera
Select these print settings options when printing photos from your camera.

Print settings Available options Description
Paper Size Various paper sizes Indicates the size of paper you have loaded
Paper Type Various paper types Indicates the type of paper you have loaded; see

the list of paper types for copying (available
options depend on the selected Paper Size
setting)
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Print settings

Available options

Description

Paper Source

Cassette 1 Prints onto paper loaded in Cassette 1 (upper
cassette)
Cassette 2 Prints onto paper loaded in Cassette 2 (lower

cassette)

Cassette 1> Cassette 2

Prints onto paper loaded in Cassette 1 and then
onto paper loaded in Cassette 2 when the first
cassette is empty (load the same size and type of
paper in both cassettes when selecting this option)

Rear Paper Feed Siot

Prints onto paper loaded in the rear paper feed slot

Layout Borderless Expands the image to the edge of the paper (slight
cropping may occur)
With Border Leaves a small margin around the image
2-up, 4-up, 8-up, 20-up, | Prints the selected number of photos on one sheet
and 80-up or CD/DVD
Upper "2 or Lower > Prints one photo in the upper or lower half of the
sheet
Photo ID Prints 4 ID-sized photos on one sheet
Quality Draft Provides lower quality for draft printing
Standard Provides good quality for most prints
Best Provides the highest quality for important prints
Expansion Standard Expands images correctly for most borderless
prints
Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints
(you may see some white border)
Date Off Does not print the date on which the photo was
taken
On Prints the date on which the photo was taken
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Print settings

Available options Description

Print Info. on Photos

Camera Text

Prints text that you added in your camera

Landmark Prints location information embedded in a photo by
cameras that have a built-in GPS feature
Fit Frame On Automatically crops the photo to fit into the
selected photo layout
Off Turns off automatic cropping
Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality

CD Inner/Outer

Range of measurements | Selects inner and outer diameter for printing on

CDs/DVDs from your camera

CD Density

Standard

Adjusts the print density when printing on

Darker

CDs/DVDs from your camera

Darkest

Parent topic: Selecting Print and Photo Adjustment Settings

Photo Adjustments - Camera

Select these photo adjustment options when printing photos from your camera. The modifications affect
only the printed copy of the photo, not the original file.

Photo
Adjustments
settings

Available options

Description

Fix Photo

Fix Photo On Automatically adjusts the brightness, contrast, and
saturation of the photo based on the Scene Detection
setting that is selected

Fix Photo Off Turns off automatic adjustments; see Note below

P.I.M Uses your camera's PRINT Image Matching or Exif Print

adjustments
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Photo Available options Description

Adjustments

settings

Scene Detection | Automatic Optimizes the Fix Photo adjustments for specific types of
Peoble photos; select the option that best matches your photo

P content

Landscape
Night Scene

Fix Red-Eye Off Does not automatically fix the red-eye effect in photos
On Automatically fixes the red-eye effect in photos

Filter Off Turns off the filter setting
Sepia Applies a sepia tone filter to the viewed or printed photo
B&W Applies a black-and-white filter to the viewed or printed

photo

Brightness Various settings Adjust individual qualities in your photo

Contrast

Sharpness

Saturation

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Selecting Print and Photo Adjustment Settings

Connecting and Printing from a Camera
Before you connect your camera, make sure the product is turned on but not printing.
1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
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3. Connect the USB cable that came with your camera to the 24 USB port on the front of your product.

Note: You cannot use the USB port to transfer images from your camera to your computer.

4. Turn on your camera.

5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the product.
Parent topic: Printing from a Camera

Related tasks
Removing a Memory Card

Related topics
Loading Paper

Printing from a Camera Wirelessly

You can print photos from a digital camera using a wireless connection. Make sure your digital camera
can connect to a network and is PictBridge compatible (DPS over IP).

1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Turn on your camera.
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4. Setup the camera's wireless network connection. See the documentation that came with your
camera for details.

Note: Connect the camera to the same network that your product uses. You can print a Network
Status sheet to view your product's network settings.

5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the network.
Parent topic: Printing from a Camera

Viewing or Printing from a USB Flash Drive or External Device

You can view and print photos from a USB thumb drive or other external storage device, such as an
external hard drive or CD/DVD burner.

Note: Make sure the files on your device are compatible with the product.

USB Device File Specifications
Connecting and Using a USB Flash Drive or External Device

Parent topic: Using an External Device with Your Product

USB Device File Specifications
You can print external device files that meet these specifications.

File format JPEG with the Exif version 2.3 standard (taken with digital camera
using DCF (Design rule for Camera File system) version 1.0 or 2.0
compliant)

Image size 80 x 80 pixels to 10200 x 10200 pixels

File size Up to 2GB

Number of files Up to 9990

Note: DCF 2.0 files stored in a camera's built-in memory are not supported.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device
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Connecting and Using a USB Flash Drive or External Device
Before you connect your thumb drive or device, make sure the product is turned on but not printing.

Note: Epson cannot guarantee the compatibility of your drive.

Remove any memory cards from the product.
Load the paper you want to use for printing.

3. Insert your USB thumb drive or the USB cable that came with your device into the ¢ USB port on
the front of your product.

4. Insert storage media (such as a CD) into your drive, if necessary.
5. Select the photos to print from the LCD screen.

When you finish printing, make sure the access light on the drive is not flashing, then remove or
disconnect it from the product.

Caution: Do not remove the USB drive or turn off the product when the access light is flashing, or you
may lose photos on the drive.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device

Related topics
Printing from a Memory Card

Printing From a Home Network Device (DNLA)

You can print photos from devices, such as TVs and cameras, that are compatible with the DLNA (Digital
Living Network Association) standard. Before printing, select the print settings for the photo on your
product, as described here.

Note: For more information about printing from a DNLA-compatible device, check with the device
manufacturer.

1. Press the M home button, if necessary.
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2.

3
4
5
6.
7
8
9

Select Setup.

Setup

@ Ink Levels

* Hamtenance

Printer Setup

Scroll down and select Home NW Print Settings.
Select Print Settings.

Select the print settings you want to use.

When you are done, press the 3 Back button.
Select Photo Adjustments.

Select the photo adjustments you want to use.
Press the M home button to exit.

Parent topic: Using an External Device with Your Product

Related references

Photo Adjustment Options - Memory Card

Related tasks

Viewing and Printing Photos From the LCD Screen

266



Printing Personalized Projects

You can turn any photo or drawing into a coloring book page, or print lined paper, graph paper, or
stationery with a photo background.

Printing Coloring Book Pages

Printing Personalized Note Paper

Printing Lined Paper, Graph Paper, and Music Sheets
Printing Calendar Pages

Printing Coloring Book Pages

You can create a coloring book page from a photo on your memory card, or from a photo or drawing
placed on the scanner glass.

1. Load one of these types of paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7
inches [210 x 297 mm]) size:

* Plain paper

» Epson Bright White Paper

» Epson Presentation Paper Matte

* Epson Premium Presentation Paper Matte

+ Epson Velvet Fine Art Paper (letter-size only)
2. Pressthe M home button, if necessary.
3. Select More Functions.

More Functions

% Copy/Restore Photos

ﬂ Photo Layout Sheet

t Greeting Card
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4. Scroll down and select Coloring Book .

Coloring Book

Photo or Drawing
on Scanmer Glass

Fhioto gn Memary Card

5. Do one of the following:

» Select Photo or Drawing on Scanner Glass to print a design from an original placed facedown
on the scanner glass, in the front right corner.

+ Select Photo on Memory Card to print a design from a memory card inserted in your product,
then select a photo.

Select Proceed.
Select Paper Settings and select the size and type of paper that you loaded.
Select Paper Source and select where you loaded your paper.

© o N o

If necessary, adjust the following settings:

* Density to make the print lighter or darker

* Line Detection to change the amount of detail in the print
10. When you are ready to print, press the & Start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects

Related tasks
Inserting a Memory Card
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Related topics
Loading Paper
Placing Originals on the Product

Printing Personalized Note Paper
You can print lined or unlined note paper with one of your own photos in the background.

1. Load plain paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches
[210 x 297 mm)]) size.

Insert a memory card into your product's memory card slot.
Press the M home button, if necessary.
Select More Functions.

o &~ o bh

Scroll down and select Personal Stationery.

Personal Stationery

Lined Papers

Writing Papers

Calendar
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6. Select Writing Papers.

Writing Papers

1

Horirontal Rule
Vertical Fule

B Withoul Rule

5

7. Select one of the following settings:
* Horizontal Rule
* Vertical Rule
* Without Rule

Note: View the thumbnails next to each option to preview the design layout.

8. Select the size of paper you loaded.
9. Select the photo you want to use for your note paper and select Proceed.

Note: To rotate the layout, select Rotate.

10. When you see a message asking you to load paper, select Proceed.
11. To print more than one sheet, press the + or — button to select the number (up to 99).
12. When you are ready to print, press the & Start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
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Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing Lined Paper, Graph Paper, and Music Sheets

You can print music sheets and wide-rule or narrow-rule notebook paper and graph paper.

1. Load plain paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches
[210 x 297 mm]) size.

2. Press the M home button, if necessary.
3. Select More Functions.
4. Scroll down and select Personal Stationery.

Personal Stationery

Lined Papers

Writing Papers

Calendar
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5. Select Lined Papers.

Lined Papers

Wide Rule

[hir Rule

B

5

Lirapky Kuibg

6. Select one of the following settings:
* Wide Rule
* Thin Rule
* Graph Rule
* Music Paper

Note: View the thumbnails next to each option to preview the design layout.

7. Select the size of paper you loaded.

8. When you see a message asking you to load paper, select Proceed.

9. To print more than one sheet, press the + or — button to select the number (up to 99).
10. When you are ready to print, press the & Start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects

Related topics
Loading Paper
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Printing Calendar Pages
You can create and print a weekly or monthly calendar page from your product.

1. Load plain paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches
[210 x 297 mm)]) size.

2. Press the M home button, if necessary.
3. Select More Functions.
4. Scroll down and select Personal Stationery.

Personal Stationery

Lined Papers

Writing Papers

Calendar

5. Select Calendar.

6. Select one of the following settings:
» Weekly: prints a Sunday to Saturday week-long calendar with hourly divisions.
* Monthly: prints a monthly calendar for a chosen month and year.

Note: View the thumbnails next to each option to preview the design layout.

7. If you chose Monthly, enter the year and month and select Done.

8. Select the Paper Type and Paper Source settings for the paper you want to print on.
9. When you see a message asking you to load paper, select Proceed.

10. To print more than one sheet, press the + or — button to select the number (up to 99).
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11. When you are ready to print, press the < Start button.
Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects

Related topics
Loading Paper
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Printing on CDs/DVDs

Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.
CD/DVD Printing Features

Loading a CD/DVD

Removing a Printed CD/DVD

Placing a CD/DVD on the Scanner Glass

Copying onto a CD/DVD

Printing Photos from a Memory Card Onto a CD/DVD

Printing a Jewel Case Insert from a Memory Card

Printing on CDs/DVDs from a Computer

CD/DVD Printing Features

You can use any of the following features to print custom CD/DVD/Blu-ray Disc labels and accessories:
+ Copy an existing label onto a new CD/DVD/BIlu-ray Disc

» Use your product's control panel to print photos from a memory card onto a CD/DVD/Blu-ray Disc

» Print text and images from your computer using the Epson Print CD software

You can also use your product's control panel to create a jewel case insert with photos from a memory
card.

Parent topic: Printing on CDs/DVDs

Related tasks

Copying onto a CD/DVD

Printing a Jewel Case Insert from a Memory Card
Printing Photos from a Memory Card Onto a CD/DVD

Loading a CD/DVD

You can print on any compatible, ink jet-printable CDs or DVDs, including Blu-ray Discs.

Caution: Do notinsert the CD/DVD tray while the product is printing, copying, or performing other
operations. Otherwise, your product may be damaged or the surface of the CD/DVD may become dirty
or scratched.
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Note: If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the center
hole, you may need to adjust the inner diameter setting using the control panel or Epson Print CD
software.

1.
2.
3.

Burn your files, music, or video onto your disc before printing on it.
Send your file from your computer or from your product's control panel.

When you see a message that the product is preparing for CD loading, follow the instructions to load
a CD.

Raise the control panel all the way up.

6. Close the front cover.
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7. Remove the CD/DVD tray from the bottom of the product.

8. Place a CD or DVD on the CD/DVD tray with the printable side faceup.
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9. Insert the tray into the slot above the output tray as shown.

Note: Make sure the A marks on the tray and the ¥ marks on the product line up.

10. Select Ready and select OK.
Note: The CD/DVD tray ejects automatically after a certain period of time.

Caution: Do not turn off the product with a CD or DVD loaded in it. Always remove the disc first.

Parent topic: Printing on CDs/DVDs

Removing a Printed CD/DVD
After your CD or DVD is printed, the tray extends automatically.
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1. Remove the CD/DVD tray from the product and remove your disc from the tray.

2. Select OK.
3. Insert the CD/DVD tray into the storage slot on the bottom of the product.

After printing, handle the CD or DVD carefully. You may need to wait up to 24 hours for the ink to dry fully

before inserting it in a drive, depending on the type of disc you used. Keep printed discs away from
moisture and direct sunlight.

Parent topic: Printing on CDs/DVDs
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Placing a CD/DVD on the Scanner Glass
You can place a CD or DVD on the scanner glass and copy the label design onto another CD or DVD.
1. Open the document cover.
2. Place your CD or DVD facedown in the center of the scanner glass.

T
Tas Trr Tos—

3. Close the document cover gently to keep your disc in place.
Parent topic: Printing on CDs/DVDs

Copying onto a CD/DVD

You can copy a printed photo or CD/DVD label directly onto an ink jet-printable CD or DVD. If you want,
you can first print a test design on plain paper.

1. Press the M home button, if necessary.
2. Select More Functions.

3. Scroll down and select CD/DVD Copy.
4

Follow the instructions on the LCD screen to place your original CD, DVD, or photo on the scanner
glass and select Proceed.

5. If necessary, adjust the inner and outer diameter of your CD as shown on the screen and select
Proceed.
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You see this screen:

Print on a COADVD

Test Print om Letter /64

Select either test printing
ar printing on a GOS0V,

6. Select Print on a CD/DVD.

Note: You can also select Test Print on Letter/A4 and follow the instructions on the screen to print
on paper.

7. When the product is finished preparing to print, scroll down to view instructions and load a CD or
DVD in the product.

8. After loading the CD or DVD, select Ready.

9. When you see a message, select OK.

10. Select any copy settings as needed.

11. When you are ready to print, press the & Start button.

Note: To cancel copying, select Cancel.

Parent topic: Printing on CDs/DVDs
Related references

Copying Options

Related tasks

Loading a CD/DVD
Placing a CD/DVD on the Scanner Glass

281



Placing Originals on the Scanner Glass

Related topics
Loading Paper

Printing Photos from a Memory Card Onto a CD/DVD

You can print one or more photos from a memory card directly onto a CD or DVD. If you want, you can
first print a test design on plain paper.

1. Insert a memory card into the memory card slot on your product.
2. Press the M home button, if necessary.

3. Select More Functions.

4. Scroll down and select Print on CD/DVD.

Print Layout

CO/OVD 1-up
CO/OVD 4-up

LI DVD Warmety

5. Select a layout and select Proceed.
6. Follow the instructions on the screen to select your photo or photos.

7. When you see the screen to adjust the inner and outer diameter of your CD, adjust the settings if
necessary and select Proceed.
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You see this screen:

Print on a COADVD

Test Print om Letter /64

Select either test printing
ar printing on a GOS0V,

8. Select Print on a CD/DVD.

Note: You can also select Test Print on Letter/A4 and follow the instructions on the screen to print
on paper.

9. When the product is finished preparing to print, scroll down to view instructions, then load a CD or
DVD in the product.

10. After loading the CD or DVD, select Ready.

11. Adjust the CD Density setting, if necessary, and press the & Start button to print.

Note: To cancel printing, select Cancel.

Parent topic: Printing on CDs/DVDs

Related tasks
Loading a CD/DVD
Inserting a Memory Card

Related topics
Loading Paper
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Printing a Jewel Case Insert from a Memory Card

You can print a photo from a memory card, automatically sized to fit on a CD/DVD jewel case insert. You
can also print thumbnail images formatted to fit on a jewel case insert. After the insert is printed, you can
cut and fold it to fit.

1. Insert a memory card into a memory card slot on your product.
Load the paper you want to print on.

Press the M home button, if necessary.

Select More Functions.

Select Photo Layout Sheet.

A

Frint Layout

Ficture Packane

2-up

4-up

6. Scroll down and select one of the following:

+ Jewel Upper to print one photo on the upper half of the insert.

+ Jewel Index to print 24 or 48 thumbnail images on the insert.

Select your paper size, type, and source, then select Proceed.

Follow the instructions on the LCD screen to select your photos and set the number of copies.
9. When you see the Print Settings screen, change your print settings if necessary.
10. When you are ready to print, press the & Start button.

Note: To cancel printing, select Cancel.
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11. Cut and fold your insert along the crop lines.
Parent topic: Printing on CDs/DVDs

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing on CDs/DVDs from a Computer

Before printing directly on CDs or DVDs from your computer, make sure you have set up your product as
described on the Start Here sheet, and installed the Epson Print CD software.

Starting Epson Print CD - Windows
Printing Your CD/DVD Design - Windows
Starting Epson Print CD - OS X

Printing Your CD/DVD Design - OS X

Parent topic: Printing on CDs/DVDs

Related tasks
Loading a CD/DVD

Starting Epson Print CD - Windows

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special
effects.

1. Select the Epson Print CD icon on your Windows Desktop.
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You see a screen like this:

T - =N

2. Use the buttons on the left side of the screen to select a pre-designed template or add a background
image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.
Parent topic: Printing on CDs/DVDs from a Computer

Related tasks
Printing Your CD/DVD Design - Windows

Printing Your CD/DVD Design - Windows

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Open your file in Epson Print CD and click Print.
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You see a screen like this:

Print KX
Printar Epsan bl
Coples 1
hlieha Typse CLLvh W
Prind Color Comecion Ad Ering B H M
L5 Pring Position nng
Lightes Diefault Dok ~ '
3 .2 1 0 =1 +2 43
Prird Confirmation Patiem
Afjust Prink Position
= Mg
Print Density Confirmation Pattam Trai
(]
Manual Prant
Print Position Confemabon Pafem
Test Print
Print Canpl Help

2. Make sure your product is selected as the Printer setting.

3. To see how your design will look without printing on the disc, click Test Print and follow the
instructions on the screen.

4. When you are ready to print on the disc, click the Print button on the screen.
5. Click Print.

Note: If you need to adjust the print position or print quality, see the Epson Print CD Help utility for
instructions.

Parent topic: Printing on CDs/DVDs from a Computer

Related tasks
Starting Epson Print CD - Windows

Starting Epson Print CD - OS X

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special
effects.
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1. Open the Epson Print CD program in the Applications > Epson Software > Print CD folder on your
Mac.

You see a screen like this:

[ ] @ Untitled

g.' % : Tz ™ T G PR
\.
O

OG- -

2. Use the icons on the left side of the screen to add a background image, picture, text, or graphic
elements.

3. When you are finished creating your design, make sure you save it.
Parent topic: Printing on CDs/DVDs from a Computer

Related tasks
Printing Your CD/DVD Design - OS X

Printing Your CD/DVD Design - OS X

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Open your file in Epson Print CD and select Print from the File menu.
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You see a screen like this:

Print
Satact Printar hanual Print
Printar: EPSON XP-630 Saries 2 Tast Print
Copies: 4
Media Typa: COOVD =
Color Camsction Adpust Print Positicn

Light Standard Strang Horizontal 00 mm
- Vearbcal 0.0 M
4 2 1 0 A 42 4 Positlon Adjustmant
Print Chisck Pl
* | Mone
Print Dengity Check Pattem Ay
Position

Print Position Chack Pattern [ ]

Cancal Print

Make sure your product is selected as the Printer setting.

3. To see how your design will look without printing on the disc, select Test Print and follow the
instructions on the screen.

4. When you are ready to print on the disc, click the Print button on the screen.

Note: If you need to adjust the print position or print quality, see the Epson Print CD Help utility for
instructions.

Parent topic: Printing on CDs/DVDs from a Computer

Related tasks
Starting Epson Print CD - OS X
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Replacing Ink Cartridges

When an ink cartridge is expended, you need to replace it.

You may also need to replace a cartridge that is more than six months old, or if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges responsibly and in accordance with
local requirements. If you would like to return your used ink cartridges to Epson for proper disposal,
please go to epson.com/recycle for more information.

Check Cartridge Status

Purchase Epson Ink Cartridges

Removing and Installing Ink Cartridges

Printing with Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows

Check Cartridge Status

Your product and its printing software will let you know when an ink cartridge is low or expended.

Checking Cartridge Status on the LCD Screen
Checking Cartridge Status with Windows
Checking Cartridge Status with OS X

Parent topic: Replacing Ink Cartridges
Checking Cartridge Status on the LCD Screen

You can check the status of your ink cartridges using your product's LCD screen.
1. Press the M home button, if necessary.
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2. Select Setup.

Setup

@ Ink Levels

* Hamtenance

Printer Setup

3. SelectInk Levels.
The ink cartridge status is displayed.

Note: Displayed ink levels are approximate.

4. Select OK or press the M home button to exit.
Parent topic: Check Cartridge Status

Related tasks
Removing and Installing Ink Cartridges

Checking Cartridge Status with Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at
any time using a utility on your Windows computer.

1. To check your cartridge status, access the Windows Desktop and double-click the product icon in
the Windows taskbar.
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You see this window:

W  EPSON Status Monitor 3 = =
EPSON “*
It is ready b print.
ﬁ Support
F . mahlas Status
Black Cyan Telow Magents Phiofo Elack
410 410 410 410 410
410, 4100 410K 4105 410
Information
ot Come e Buy £ ==

2. Replace or reinstall any ink cartridge indicated on the screen.

Note: Depending on the color of the expended cartridge and how you are printing, you may be able
to continue printing temporarily.

Note: If any of the cartridges installed in the product are broken, incompatible with the product
model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. Todisable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
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You see this window:

Select Motification

Ewvent

B Error

O Communication Error
B Printer Selection Error
O Ink Low

Select Shortout Icon
[W]Register the shortcut icon to the taskbar

Double-dicking the Shortcut Icon
opens the Printer Status Window,

["] Allow monitoring of shared printers

[] See Low Irk Reminder alerts

[+] Display Epson Offers

[] Share my usage information with Epson

ok F Cancel

4. Deselectthe See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge Status

Related tasks

Removing and Installing Ink Cartridges
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Checking Cartridge Status with OS X
You can check your cartridge status using a utility on your Mac.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
You see a window like this:

o
EPSON

% EPSOM Status Maonitor

Cymn Tadow Wacrnin
A, dB d B, AL g, diEE

Dace
dnB, WidEL

nk Levels

A1, diimL

Infarmation

Updata 0K

3. Do the following as necessary:
* To update the ink cartridge status, click Update.
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* Replace or reinstall any ink cartridge indicated on the screen.

Note: Depending on the color of the expended cartridge and how you are printing, you may be able
to continue printing temporarily.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge Status

Related tasks
Removing and Installing Ink Cartridges

Purchase Epson Ink Cartridges

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridge included with the printer is designed for printer setup and not for resale. After some ink is
used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge Part Numbers
Parent topic: Replacing Ink Cartridges

Ink Cartridge Part Numbers

Use these part numbers when you order or purchase new ink cartridges.

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Ink color Part number
Standard-capacity High-capacity
Photo Black (PBK) 410 410XL
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Ink color Part number

Standard-capacity High-capacity
Black (BK) 410 410XL
Cyan 410 410XL
Magenta 410 410XL
Yellow 410 410XL

Parent topic: Purchase Epson Ink Cartridges

Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new

cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Make sure that the CD/DVD ftray is not inserted for printing.

2. Turn on your product.
» Ifanink cartridge is expended, you see a message on the LCD screen. Note which cartridges

need to be replaced and select Proceed. Then choose Yes, replace now.

+ If you are replacing a cartridge before you see a message on the LCD screen, select Setup >

Maintenance > Ink Cartridge(s) Replacement . Press the < Start button.
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3. Lift up the scanner unit.

N\
\_ AN J

Caution: Do not move the print head by hand; otherwise, you may damage your product. Do not
touch the flat white cable inside the printer.

4. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the bottom of the ink
cartridge to remove it.
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Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.

Recap the used ink cartridge using the cap that came with it.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

If you are replacing the Black (BK) ink cartridge, shake the new cartridge gently four or five times
before unwrapping it. You do not need to shake the Photo Black (PBK) cartridge or any of the other
color ink cartridges.

Caution: Do not shake the cartridges after opening the packages, or ink may leak.
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7. Remove the cartridge from the package.

Caution: Do not touch the areas shown above. Doing so may prevent normal operation and printing.

8. Remove the cap from the cartridge and save it so you can recap the ink cartridges before storing or
disposing of them.

Caution: Do not remove any other labels or seals, or ink will leak.
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9. Insert the ink cartridge head first into the ink cartridge holder. Then press the bottom of the ink
cartridge down until it clicks into place.

10. Once you replace all the cartridges that need replacing, close the scanner unit.

The product starts charging the ink. This takes a few minutes. When you see a completion message
on the LCD screen, ink replacement is complete.
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Note: Do not turn off the product while it is charging or you will waste ink. If you see an error screen
telling you an ink cartridge is installed incorrectly, lift up the scanner unit and press the ink cartridge
down until it clicks into place. When you're finished, close the scanner unit.

If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

Caution: If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came
with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.
Store the ink cartridge in the same environment as the product. Do not leave the product with the ink
cartridges removed for an extended period of time. Otherwise, ink remaining in the print head nozzles
may dry out and you may not be able to print.

Parent topic: Replacing Ink Cartridges

Related references
Ink Cartridge Part Numbers

Related tasks
Removing and Installing Ink Cartridges

Printing with Black Ink and Expended Color Cartridges

When a color or photo black ink cartridge is expended, you can temporarily continue printing from your
computer using black ink. Replace the expended cartridge as soon as possible for future printing.

Note: You cannot print with expended color ink cartridges using your product's control panel.

Printing with Expended Color Cartridges - Windows
Printing with Expended Color Cartridges - OS X

Parent topic: Replacing Ink Cartridges

Printing with Expended Color Cartridges - Windows

If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

Note: To use this feature, Epson Status Monitor must be enabled.
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9.

©® N o ok wDN

Click Cancel or Cancel Print to cancel your print job.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

Load plain paper or an envelope in your product.

Access the print settings in your print application.

Click the Main tab.

Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
Select the Black/Grayscale checkbox.

Click OK.

Print your document.

Epson Status Monitor 3 displays a print message.

Click Print in Black to print your document.

Parent topic: Printing with Black Ink and Expended Color Cartridges
Printing with Expended Color Cartridges - OS X

If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.

1.
2.

Click the printer icon in the Dock.
If you see a message telling you that you can temporarily print with only black ink, click the Delete or
button to cancel your print job. If you see an error message, click OK.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

In the Apple menu or the Dock, select System Preferences.

Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

Select Driver or Options.
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You see a screen like this:

General Supply Levels  Utility

To take full advantage of your printers cptions, confirm that they are accurately
sheown here. For information on your printer and its optional hardware, check the
PrIFEErs GOCuUrmeration

Thick paper and envelopes: | OF

Skip Blank Page: | OH

Quilet Mode: | O

Perenit temporary black pringing: | O
Automatic Casserte Switching: | Off
High Speed Printing: | On

Warning hotifications: | On

Establish bidirectional communication: | On

Cancel | | OK |

6. Select On as the Permit temporary black printing setting.

7. Click OKOK or OK.

8. Close the utility window.

9. Load plain paper or an envelope in your product.

10. Access the print settings in your print application.

11. Select Print Settings from the pop-up menu.

12. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
13. Select the Grayscale option.

14. Click Print to print your document.

Parent topic: Printing with Black Ink and Expended Color Cartridges
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Conserving Low Black Ink with Windows
The following window appears when black ink runs low and there is more color ink.

(EPSON Status Menitor 3

Bladk ink Is low.

Te keep printing untl you replace the cartridge, you can print wsing phote
black and other colors.

Do you want to do this for the current grint job?

Yes |

™ |

Duzahle this feature |

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor
must be enabled.

» Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

+ Click Disable this feature to continue using the remaining black ink.
Note: If you disable this feature, it remains disabled until you install a new black ink cartridge.

Parent topic: Replacing Ink Cartridges
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Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to replace the ink cartridges.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality

Related topics
Replacing Ink Cartridges

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.

1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and
the output tray is extended.

2. Load afew sheets of plain paper in the product.
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3. Press the M home button, if necessary.
4. Select Setup.
5. Select Maintenance.

Haint enance

Hozsle Check

Head Cleaning

Print Head Alignment

6. Select Nozzle Check.

Hozzle Check

7. Press the < Start button.
The nozzle check pattern is printed.
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8. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

9. Do one of the following:

+ If there are no gaps, the print head is clean. Select Done.

+ If there are gaps or the pattern is faint, select Clean the Print Head.
10. Follow the instructions on the screen to clean the print head.

If you don’t see any improvement after cleaning the print head up to 2 times, turn the product off and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Nozzle Check

Related tasks
Cleaning the Print Head Using the Product Control Panel
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
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1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and
the output tray is extended.

2. Load a few sheets of plain paper in the product.
3. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

» OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
You see a window like this:

To perform a norde check, make sure that the printer is on and
connectad to the computer, Make sure that the CD/DVD tray is

removed and the output tray is ejected; otherwise "Nozzle Chedd™
cannot be performed, Also make sure that A4 or Letter size plain
paper is loaded in the cassette 2. Click [Print] to print & nozze chedk
pattern or didk [Cancel] to quit.

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

7. Ifthere are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.
Parent topic: Print Head Nozzle Check

Related tasks
Cleaning the Print Head Using a Computer Utility
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
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Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance

Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and
the output tray is extended.

Load a few sheets of plain paper in the product.
Press the f home button, if necessary.
Select Setup.

o K 0N

Select Maintenance.

Haint enance

Hozsle Check

Head Cleaning

Pr ir|1 I II:!E|I:| |'!||i!'|r|. et
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6. Select Head Cleaning.

Head Cleaning

Clean the print head
to correct missing dots.
Press @ .

7. Press the & Start button to clean the print head. You see a message on the LCD screen during the
cleaning cycle.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

When the cleaning cycle is finished, you see a message on the LCD screen.

8. Select Print nozzle check pattern and press the <& Start button to run a nozzle check and confirm
that the print head is clean.

If you don’t see any improvement after cleaning the print head up to 2 times, turn the product off and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Checking the Nozzles Using the Product Control Panel
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows computer or Mac.
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1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and
the output tray is extended.

2. Load a few sheets of plain paper in the product.
3. Do one of the following:
* Windows: Right-click the product icon in the Windows taskbar.

» OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
You see a window like this:

Make sure that the CO/DVD tray is removed and the output tray i
ejected; otherwise Head Cleaning” carmot be performed. Click [Start]

to dean the print head nozzes. Because deaning consumes some ink,
only cdean the print head when faint areas or gaps appear in your
printout, Lise the "Nozze Check™ utibty first to confirm that the print
head needs to be deaned. If the ink is low or expendad, replace the
cartridge first.

Caution: Do not insert CD/OVD tray untl deaning has finiched,

5. Click Start to begin the cleaning cycle.
You see a message on the LCD screen during the cleaning cycle.
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Caution: Never turn off the product during a cleaning cycle or you may damage it.
6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

* If there are no gaps, click Finish.
+ If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Checking the Nozzles Using a Computer Utility
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges
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Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Aligning the Print Head Using a Computer Utility

Parent topic: Adjusting Print Quality

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen, the CD/DVD tray is not inserted for printing, and
the output tray is extended.

Load a few sheets of plain paper in the product.
Press the M home button, if necessary.
Select Setup.

o &~ o bh

Select Maintenance.

Haint enance

Hozele Check

Head Cleaning

Print Head |'!||i!'|r|. enit

314



6. Select Print Head Alignment.

Print Head Alignment

Load Letter/Ad size

Main Faper

in the Cassette 2

to print head algrment pattern.
Press 4.

15T

O

7. Press the & Start button to print an alignment sheet.
Note: Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and select the number representing the best printed pattern for each set.
9. Select Done when you are finished.
Parent topic: Print Head Alignment

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows or Mac computer.

1. Make sure the CD/DVD tray is not inserted for printing. Make sure there are no errors on the LCD
screen, the CD/DVD tray is not inserted for printing, and the output tray is extended.

Load a few sheets of plain paper in the product.
3. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

* OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Print Head Alignment.
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5. Click Next, then click Print to print an alignment sheet.
Note: Do not cancel printing while you are printing a head alignment pattern.

You see a window like this:

aoh Print Head Alignment | < ||

Lack at the aligiment sheet.

BArA Find the square without any visble bands in sets =1 through 25, Select
the number that coresponds to that square from the list below for all
sets, Then chck [Next =].

If every square containg a band, select the square with the thinmest
band or bands, Then didk [Realignment].

21 |3 w
&2 4 w
23 |4 v
#4 4 “
#5 |9 W
Realgnment Cancel . Mext =

6. Check the printed pattern and follow the instructions on the screen to choose the number of the best
printed pattern for each set.

 After choosing a pattern number, click Next.

* If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

7. When you are done, click Finish.
Parent topic: Print Head Alignment
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Cleaning the Paper Path

If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.

Caution: Do not use tissues to clean the rollers inside the product; lint from tissue may clog the print
head nozzles.

Load a few sheets of plain paper in the product.
2. Use the product control panel to make a copy, but without placing a document on the scanner glass.

Note: Make sure there is no dust or stains on the scanner glass or document cover.

3. Check the back of the ejected paper to see if it is clean.
4. Repeat as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.
Close the output tray and front cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

Turn off the product.

Unplug the power cable.

Disconnect any connected cables.

Open the ADF cover.

b=
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5. Use a soft, dry, lint-free cloth (microfiber is recommended) to clean the rollers and the interior of the
ADF.

6. Close the ADF cover.
7. Open the document cover.
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Clean the scanner glass and the glass area on the left with a soft, lint-free cloth (microfiber is
recommended), moistened with a little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.
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9. Press the tabs and remove the document mat.

10. Use a soft, dry, lint-free cloth (microfiber is recommended) to clean the transparent part on the
underside of the document mat.

|

11. Replace the document mat by reversing the steps to remove it. Close the document cover.
12. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product
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Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:
* Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

» Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
the product from printing.

* Do not carry the product by its control panel; this may damage the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

Turn off the product.

2. Lift up the scanner unit and check to see if the print head is in the far right position (the home
position). If not, turn on the product, wait for the print head to move, then turn the product off again.

3. Secure the ink cartridge holder to the case with tape.

(~ )
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Caution: Do not place tape on the white flat cable inside the product; otherwise, you may damage
your product.

Lower the scanner unit.

Remove all the paper from the product.

Remove any memory cards inserted in the product.
Unplug the power cable.

Disconnect any connected cables.

© o N o o bk

Close the rear paper feed slot cover, the output tray, the ADF input tray, and the ADF output tray
extension. Then lower the control panel.

10. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Keep the product level during transportation. Be sure to remove the tape from the ink cartridge holder
before turning on your product. If print quality has declined when you print again, clean and align the
print head.

Parent topic: Cleaning and Transporting Your Product

Related concepts
Print Head Alignment
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Print Head Cleaning
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Status Messages

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Copying Problems

Solving Paper Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Solving Scanning Problems

Solving Scanned Image Quality Problems
Solving Memory Card Problems

Solving CD/DVD Problems

Solving Faxing Problems

Uninstall Your Product Software

Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
You can select Download the Latest Software from the Home screen of this manual or visit Epson's
driver download site (U.S. downloads or Canadian downloads).

* Windows: Your printer software automatically checks for updates. You can also manually update the
software by selecting Software Update here:

+ Accessing the Windows Desktop and right-clicking the product icon in the Windows taskbar
+ On the Maintenance tab in the printer settings window

You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.
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* OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

Parent topic: Solving Problems

Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen. You
can also see help information and how-to instructions on the screen. Press the A home button, if
necessary, press the left or right arrow button, and then select Help .

LCD screen message

Condition/solution

Printer error. Turn the
power off and on again.
For details, see your
documentation.

A fatal error has occurred. Turn the product off and then back on again. If the
error continues, check for a paper jam. If there is no paper jam, contact
Epson for support.

Operation canceled. An
error occurred while
saving.

The memory card or external device may be damaged. Check the device and
replace it if necessary.

Ink is low.

Ink in a cartridge is low. You can continue printing or replace the cartridge.

You need to replace the
following ink
cartridge(s).

Replace the ink cartridge indicated on the LCD screen.

Paper Configuration is
disabled. Some features
may not be available.
For details, see your
documentation.

If Paper Configuration is disabled, you cannot use AirPrint. Also, you will not
see warnings about paper size or type mismatches. Keep Paper
Configuration enabled unless you always use the same size and type of
paper.

Communication error.
Check if a computer is
connected.

Make sure the computer is connected to your product and your software is
installed correctly.

A printer's ink pad is
nearing the end of its
service life. Please
contact Epson Support.

The ink pads are near the end of their service life and the message will be
displayed until the ink pad is replaced. Contact Epson for support. (To
resume printing, press the <& Start button.)
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LCD screen message

Condition/solution

A printer's ink pad is at
the end of its service life.
Please contact Epson
Support.

The ink pad is at the end of its service life. Turn off the product and contact
Epson for support.

Combination of IP

address and subnet
mask is invalid. See
your documentation.

There is a problem with the network connection to your product. Check the
solutions in this guide.

Recovery mode

An error has occurred during firmware updating. Connect your product using
a USB cable and try updating the firmware again. If you still receive this error
message, contact Epson for support.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages.
During the life of your product it may reach a condition where either satisfactory print quality cannot be

maintained or the ink pads
LCD screen, or lights on th

have reached the end of their usable life. The Epson Status Monitor, your
e control panel will advise you when these parts need replacing. If this

happens during the standard warranty of the product, the exchange of the product or replacement of the
pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced
by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

Parent topic: Solving Problems

Related references
Where to Get Help

Related tasks

Selecting the Paper Settings for Each Source - Control Panel

Related topics
Solving Network Problems

Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.

2. Load plain paper in the product.

3. Press the M home button, if necessary.
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4. Select Setup.
5. Select Maintenance.

Haint enance

Hozele Check

Head Cleaning

Print Head Alignment

6. Select Nozzle Check.

Hozle Chieck

Load Letter fd siro

i the

tior prant r:!-l:r.lr:rl:k. pattern.
Prass -,

15T

O

7. Press the & Start button.
The nozzle check pattern is printed.
8. Do one of the following, depending on the results of the product check:

 If the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
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settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

« If the page prints but the nozzle check pattern has gaps, clean or align the print head.

+ If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Uninstall Your Product Software
Print Head Cleaning

Print Head Alignment

Related references
Where to Get Help

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

1. Press the f home button, if necessary.
2. Select Setup.
3. Scroll down and select Restore Default Settings.

Kestore Default Settings

Fax Send/Becene Settngs

Fax Data Settings

Hetwork Settings
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4. Select one of these options:

* Fax Send/Receive Settings: Resets all settings on the Send Settings, Receive Settings, and
Communication screens.

+ Fax Data Settings: Erases the speed dial list, group dial list, header, and fax log.
* Network Settings: Resets all network settings.

* All except Network & Fax Settings: Resets all control panel settings, except for network and fax
settings.

» All Settings: Resets all control panel settings.

You see a confirmation screen.
5. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.

Noise After Ink Installation
Software Installation Problems
Control Panel Setup Problems

Parent topic: Solving Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

» The first time you install ink cartridges, the product must charge its print head. Wait until charging
finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the O power light stops flashing.

* If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Related references
Where to Get Help
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Software Installation Problems
If you have problems while installing your product software, try these solutions:

» Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

» Close any other programs, including screen savers and virus protection software, and install your
product software again.

* In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

 If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
OS X System Requirements

Control Panel Setup Problems
If you have problems setting up the control panel, try these solutions:
+ Toview LCD screen text in a different language, select a different language setting for the panel.
» To adjust the position of the control panel, carefully raise or lower it.
Parent topic: Solving Setup Problems

Related tasks
Adjusting Control Panel Position
Changing LCD Screen Language

Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.
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Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in OS X Printer Window

Cannot Print Over a Network

Cannot Scan Over a Network

Parent topic: Solving Problems

Related references
Product Status Messages

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

+ If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

» Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

« Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

» Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

* If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.
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« If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

» Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

* If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

« If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

» Make sure your product is turned on and connected to your network. Verify connection using your
product control panel.

» Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

» Make sure your product is not connected to a guest network.

* If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

« If you have replaced your router, reinstall your product software to connect to the new router.

333



Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in OS X Printer Window
If your product does not appear in the OS X printer window, try these solutions:
» Turn your product off, wait 30 seconds, then turn it back on again.

* If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

* If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear lit
on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall
your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems

Related tasks
Uninstalling Product Software - OS X

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
* Make sure that your product is turned on.
» Make sure you install your product's network software as described in your product documentation.

* Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

« If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.
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Make sure your computer and product are both using the same wireless network.

If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD is not lit, make sure you select one of the WPS options from the product control panel
within 2 minutes of pressing the WPS button on your router.

Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to your product and to your router, access
point, switch, or hub.

» Try connecting your product to a different port or a different router, access point, switch, or hub.
» Try connecting with a different Ethernet cable.
* Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the
LCD, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks

Printing a Network Status Sheet
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Cannot Scan Over a Network
If you cannot start Epson Scan for scanning over a network, try these solutions:

« If you cannot scan from your product control panel, make sure you restarted your computer after
installing the product software. Make sure the Event Manager program is not being blocked by your
firewall or security software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

 If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

 If network communication was interrupted while starting Epson Scan, exit Epson Scan, wait a few
seconds, and restart it. If Epson Scan cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan again.

» Check the connection setting and test the connection using Epson Scan Settings:
Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the
Connection setting is set to Network, then click the Test button.

Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the Connection setting is set to Network, then click the
Test button.

OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the Connection setting is set to Network, then click the Test button.

* Make sure the option selected as the Timeout Setting in the Epson Scan Settings program is long
enough to complete scanning over a network.

* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Network Problems

Related topics
Scanning
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Solving Copying Problems
Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Originals Do Not Feed From the Automatic Document Feeder

Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

« If the nozzle check page does not print, but the product's power is on, make sure your product
software is installed correctly.

* Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems

Related concepts
Print Head Cleaning
Print Head Nozzle Check

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Originals Do Not Feed From the Automatic Document Feeder
If your originals do not feed when placed in the ADF, try these solutions:
» Make sure the ADF icon appears on the LCD screen. If not, reload the originals.
* Make sure the size, weight, and number of your originals are supported by the ADF.
* Make sure the originals are loaded correctly.
» Try cleaning the inside of the ADF.
Parent topic: Solving Copying Problems
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Related references
Automatic Document Feeder (ADF) Specifications

Related tasks
Cleaning Your Product
Placing Originals in the Automatic Document Feeder

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette

Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper Jams in the Automatic Document Feeder

Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:

« If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette. Make sure to load only one sheet at a time in the rear feed slot.

* Be sure to insert the paper cassette all the way into your product.

» If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
* Do not load more than the recommended number of sheets.

» Make sure your paper meets the specifications for your product.

+ If paper jams when you print on both sides of the paper, try loading fewer sheets.

« If paper is ejected from the rear feed slot without being printed, first start your print job, then load the
sheet of paper.

» For best results, follow these guidelines:
» Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
* Load paper in the cassette printable side down.
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» Follow any special loading instructions that came with the paper.
Parent topic: Solving Paper Problems

Related references

Paper Loading Capacity

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette

Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper Jams in the Automatic Document Feeder

Related topics
Loading Paper

Paper Jam Problems Inside the Product

If you see a message that paper has jammed inside the product, follow the steps here or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.
2. Remove any jammed paper from the rear paper feed slot.
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3. Lift the scanner unit and remove any jammed paper inside.

Caution: Do not touch the flat white cable inside the printer.

4. Close the scanner unit.

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

340



Related references

Paper Jam Problems in the Paper Cassette

Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper Jams in the Automatic Document Feeder

Paper Jam Problems in the Paper Cassette

If you see a message that paper has jammed in the paper cassette, follow the steps here or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.
2. Pull out both paper cassettes, then carefully remove any jammed paper.

3. Make sure the paper you loaded is under the edge guides.

4. Keep the cassette flat as you insert it. If inserting Cassette 1 (upper cassette), insert it until the arrows
on the right side line up.

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

341



Related references

Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper Jam Problems Inside the Product

Paper Jams in the Automatic Document Feeder

Paper Jam Problems in the Auto Duplexer or Rear Cover

If you see a message that paper has jammed in the auto duplexer or rear cover, follow the steps here or
on the LCD screen to clear the jam.

1. Cancel the print job, if necessary.

2. Press the buttons to release the auto duplexer and remove it from your product. Carefully remove any
jammed paper from inside the product.
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4. Open the duplexer and remove any jammed paper from inside it.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Paper Cassette
Paper Jam Problems Inside the Product

Paper Jams in the Automatic Document Feeder
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Paper Jams in the Automatic Document Feeder

If you have problems with paper jams in the automatic document feeder (ADF), follow the steps below or
on the LCD screen to clear the jam.

1. Cancel the print job, if necessary.
2. Remove your originals from the ADF.
3. Open the ADF cover, then carefully remove any jammed paper.

Caution: Make sure you open the ADF cover before removing any jammed paper. Otherwise the
product may be damaged.
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4. Leave the ADF cover open, then raise the scanner unit.

5. Press the tabs and remove the document mat.

4 )
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6. Carefully remove any jammed paper.

4 )

7. Reattach the document mat, lower the scanner unit, and close the ADF cover.
8. Open the ADF input tray as shown.
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9. Carefully remove any jammed paper from beneath the ADF input tray.

10. Close the ADF input tray.
11. Reload your originals.

Caution: Do not load the ADF beyond its capacity for your paper size. Also make sure your originals
are not bent, folded, or curled and do not have tape, staples, or other materials that could obstruct the
feeder.

12. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper Jam Problems in the Paper Cassette

Paper Jam Problems Inside the Product

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems
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Related references

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette

Paper Jam Problems in the Auto Duplexer or Rear Cover
Paper Jams in the Automatic Document Feeder

Paper or Media Type Settings - Printer Software

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Nothing Prints

Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement

Printing is Slow

Parent topic: Solving Problems

Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

Make sure your product is turned on.
Make sure any interface cables are connected securely at both ends.

If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

In Windows, make sure your product is selected as the default printer.
In Windows, clear any stalled print jobs from the Windows Spooler:

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select See what's printing, and select your
product name again if necessary. Right-click the stalled print job, click Cancel, and click Yes.
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* Windows 7: Click E" and select Devices and Printers. Right-click your product name, select See
what's printing, and select your product name again, if necessary. Right-click the stalled print job,
click Cancel, and click Yes.

* Windows Vista: Click E' and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Open. Right click the stalled print job, click Cancel, and
click Yes.

» Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

Parent topic: Solving Problems Printing from a Computer

Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:
+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers.
* Windows 7: Click E]' and select Devices and Printers.

* Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.

* Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and Printers and Faxes.)

2. Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.

Click the Extended Settings button.

Select Enable EPSON Status Monitor 3, then click OK.

Click the Monitoring Preferences button.

Click the checkbox for the option that adds the shortcut icon to the taskbar.

® N o Ok w

Click OK to close the open program windows.
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Parent topic: Solving Problems Printing from a Computer

Error After Cartridge Replacement

If you see an error light or error message after you replace an ink cartridge, follow these steps:

1.

2.
3.

Make sure the print head is in the ink cartridge replacement position.

Note: If the print head is not in the ink cartridge replacement position, follow the instructions on
replacing an ink cartridge in this manual to move it.

Remove and reinsert the replaced ink cartridge, making sure to push it all the way into its slot.
Complete the ink cartridge installation steps.

Parent topic: Solving Problems Printing from a Computer

Related topics
Replacing Ink Cartridges

Printing is Slow
If printing becomes slow, try these solutions:

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

If you are using Windows 7, close the Devices and Printers window before you print.
Make sure Quiet Mode is turned off.

Clear space on your hard drive or run a defragmentation utility to free up existing space.
Close any programs you are not using when you print.

If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:

Make sure the paper type setting matches the type of paper you loaded.
Turn on any high speed settings in your product software.
Select a lower print quality setting.
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* Make sure the ink drying time has not been increased for double-sided printing.
* Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:
* High Speed Copies
« Always Spool RAW Datatype
* Page Rendering Mode
* Print as Bitmap
Parent topic: Solving Problems Printing from a Computer

Related references

Paper or Media Type Settings - Printer Software
Windows System Requirements

OS X System Requirements

Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image

Too Many Copies Print

Blank Pages Print

Incorrect Margins on Printout

Border Appears on Borderless Prints
Incorrect Characters Print

Incorrect Image Size or Position
Slanted Printout
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Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
* Make sure you selected the correct paper size settings in your printing program and printer software.

 If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software.

* Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

* Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Cleaning
Print Head Nozzle Check
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Related tasks

Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
* Make sure you selected the correct paper size settings in your printing program and printer software.
* Make sure you selected the correct margins for your paper size in your printing program.
» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
» Make sure you are printing on a compatible borderless paper type and size.

Note: For custom paper sizes, make sure you select a supported borderless page width.

* Windows: Make sure you selected the Borderless setting in your printer software.

» 0OS X: Make sure you selected the Borderless checkbox or a paper size with a Borderless option in
your printer software.

» Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless
prints.

* Make sure the image size and the paper size are set correctly; if the image is small, the enlargement
may not be enough to cover the paper.

Parent topic: Solving Page Layout and Content Problems
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Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
* Make sure any cables are securely connected at both ends.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

* If your product is connected to a USB hub, connect it directly to your computer instead.
« Ifincorrect characters still appear in your prints, try connecting your product using a different cable.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

» Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X

Related topics
Loading Paper

Slanted Printout

If your printouts are slanted, try these solutions:
» Slide the edge guides against the edges of the paper.
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» Select a higher print quality setting in your printer software.

» Turn off any high speed settings in your product software.

» Align the print head.

* Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Alignment

Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* Make sure the paper type setting matches the type of paper you loaded.
» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.
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Align the print head.
You may need to replace the ink cartridges.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references

Paper or Media Type Settings - Printer Software
Related tasks

Selecting Printing Preferences - OS X

Selecting Additional Layout and Print Options - Windows

Related topics
Loading Paper
Replacing Ink Cartridges

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:

Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.

Use a support sheet with special paper, or load special paper one sheet at a time.

Make sure your paper meets the specifications for your product.

Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.

Make sure the paper type setting in your product software matches the type of paper you loaded.
Make sure you loaded the printable side of the paper correctly for your product.

If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel
or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

Remove each sheet from the output tray as it is printed.
Avoid handling printouts on glossy paper right after printing to allow the ink to set.
Turn off any high speed settings in your product software.
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« If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the Print Density and/or Increase Ink Drying Time settings.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» Align the print head.
* Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Paper Specifications

Related tasks

Selecting Basic Print Settings - Windows

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Selecting Double-sided Printing Settings - OS X
Selecting Printing Preferences - OS X

Cleaning the Paper Path

Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* Theink cartridges may be old or low on ink, and you may need to replace them.
* Make sure the paper type setting matches the type of paper you loaded.
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» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
+ Align the print head.

» Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Paper or Media Type Settings - Printer Software

Related tasks
Cleaning the Paper Path

Related topics
Loading Paper
Replacing Ink Cartridges

Grainy Printout
If your printouts are grainy, try these solutions:
» Make sure you loaded the printable side of the paper correctly for your product.
» Select a higher print quality setting and turn off any high speed settings in your product software.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

+ Align the print head.
* You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

+ If you enlarged the image in an image-editing program, you need to increase the resolution setting to
retain a high image quality. Increase the resolution by the same amount you increased the image size.
For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later,
change the resolution setting to 600 dpi.
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Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check

Print Head Cleaning

Print Head Alignment

Related tasks

Selecting Basic Print Settings - Windows

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Selecting Printing Preferences - OS X

Incorrect Colors

If your printouts have incorrect colors, try these solutions:

Make sure the paper type setting matches the paper you loaded.
Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

The ink cartridges may be old or low on ink, and you may need to replace them.

After you print, the colors in your printout need time to set as the ink dries. During this time, the colors
may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.

Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

For best results, use genuine Epson ink and paper.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
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Related tasks

Selecting Basic Print Settings - Windows

Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Managing Color - OS X

Related topics
Replacing Ink Cartridges

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan

Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

» Make sure your computer has adequate memory and meets the system requirements for your
operating system.

» Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart your scanning software.

« If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).

Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
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OS X System Requirements

Related tasks
Scanning with OS X Using Image Capture

Cannot Start Epson Scan

If you cannot start Epson Scan, try these solutions:

Make sure your product is turned on and any interface cables are securely connected at both ends.
Make sure Epson Scan is selected in your scanning program.

Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart Epson Scan.

Check the connection setting and test the connection using Epson Scan Settings:
Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the correct
Connection setting is selected, then click the Test button.

Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the
Test button.

OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the correct Connection setting is selected, then click the Test button.

Make sure you do not have multiple versions of Epson Scan installed. If you do, uninstall both versions
and install one version.

If you upgraded your operating system but did not reinstall Epson Scan, try reinstalling it.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems

Related tasks
Scanning with OS X Using Image Capture

Related topics
Starting a Scan
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Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Image Consists of a Few Dots Only

Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked

Image is Distorted or Blurry

Image Colors are Patchy at the Edges

Image is Too Dark

Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image

Scanned Image Colors Do Not Match Original Colors
Scan Area is Not Adjustable in Thumbnail Preview
Scanned Image Edges are Cropped

Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
» Make sure you placed your original for scanning facing the correct way.

« If you are scanning using the Epson Scan Black & White setting, adjust the Threshold setting and
scan again.

Parent topic: Solving Scanned Image Quality Problems

Related references

Available Image Adjustments - Office Mode
Available Image Adjustments - Home Mode
Available Image Adjustments - Professional Mode

Related topics
Placing Originals on the Product

Line of Dots Appears in All Scanned Images

If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free
cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not
recommended.
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Caution: Do not spray glass cleaner directly on the scanner glass.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked

If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product

Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:

» Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the
scanner glass.

* Do not move your original or your product during scanning.

* Your product will not operate properly while tilted at an angle. Place your product on a flat, stable
surface that extends beyond its base in all directions.

+ Adjust these Epson Scan settings (if available) and try scanning again:
» Select the Unsharp Mask setting.
» Adjust the Auto Exposure setting.
* Increase the Resolution setting.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Image Colors are Patchy at the Edges

If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.

Parent topic: Solving Scanned Image Quality Problems
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Image is Too Dark

If your scanned image is too dark, try these solutions:

+ Adjust these Epson Scan settings (if available) and try scanning again:
» Auto Exposure
* Brightness
* Histogram Adjustment

» Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, place a piece of black paper
on the back of the original and scan it again.

Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan settings (if available) and try scanning again:

+ Select the Descreening setting.
» Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.
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To adjust the colors in your scanned image, adjust these Epson Scan settings (if available) and try
scanning again:

+ Change the Image Type setting and experiment with different combinations of the next settings.
» Adjust the Tone Correction setting.

+ Adjust the Auto Exposure setting.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Scan Area is Not Adjustable in Thumbnail Preview
If you cannot adjust the scan area while viewing a Thumbnail preview in Epson Scan, try these solutions:
» Create a scan area by drawing a marquee on your preview image and adjusting it as necessary.
+ Switch to Normal preview mode, if available, and preview your image again.
Parent topic: Solving Scanned Image Quality Problems

Related concepts
Image Preview Guidelines

Related tasks

Selecting a Scan Area - Professional Mode
Selecting a Scan Area - Home Mode
Selecting a Scan Area - Office Mode

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product

Solving Memory Card Problems
Check these solutions if you have problems using memory cards with your product.
Memory Card Does Not Fit Into a Slot
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Cannot View or Print Photos from a Memory Card or Device
Cannot Access Memory Card From a Networked Mac
Cannot Transfer Photos To or From a Memory Card or Device

Parent topic: Solving Problems

Memory Card Does Not Fit Into a Slot

If a memory card does not fit properly in a slot, do not force it in. You may need to use an adapter with
your memory card.

Parent topic: Solving Memory Card Problems

Related references
Memory Card Types

Related tasks
Inserting a Memory Card

Cannot View or Print Photos from a Memory Card or Device

If you cannot view or print photos from a memory card or USB device inserted in your product, try these
solutions:

* Make sure your memory card or device is compatible with the product.
* Make sure the files on your memory card or device are in the correct format.

* If you have too many photos on your memory card or device, you may not see all the photos you
expect or may be prompted to select a group of photos by date. Reduce the number of photos on your
card or select one group of photos at a time. Check the specifications for the maximum number of
photos.

Parent topic: Solving Memory Card Problems

Related references
Memory Card File Specifications
Memory Card Types

Related tasks
Inserting a Memory Card
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Cannot Access Memory Card From a Networked Mac

If you cannot access a memory card inserted in your product from a Mac connected to your product over
a network, you may have dragged the Memory Card application icon to the Trash. Check the Trash
contents and restore the icon, if possible.

Parent topic: Solving Memory Card Problems

Cannot Transfer Photos To or From a Memory Card or Device

If you have problems transferring photos to or from a memory card or USB device inserted in your
product, try these solutions:

» Make sure your memory card or device is compatible with the product.
» Make sure your product is securely connected to your computer.

« If you are transferring photos to a memory card, check the memory card's write-protect tab to make
sure it is set to allow writing to the card.

» Make sure that the file sharing setting for your product is set correctly.
Parent topic: Solving Memory Card Problems

Related references

Memory Card File Specifications
Memory Card Types

Related topics

Transferring Photos on a Memory Card

Solving CD/DVD Problems

Check these sections if you have problems printing on a CD/DVD with your product.
CD/DVD Jam Problems

Image Not Centered on CD/DVD

Image Does Not Cover Printable Area of Disc

Ink Smears on CD/DVD

Faint Image on CD/DVD

Parent topic: Solving Problems

367



CD/DVD Jam Problems

If a CD/DVD has jammed in the product and an error message is displayed, follow these steps to remove
the CD/DVD ftray:

1. Cancel the print job from your computer, if necessary.

Slowly pull the CD/DVD tray out of the product.

Clear the error message.

If an error is still displayed, turn off the product, then turn it back on.

SRS

. If you are unable to remove the CD/DVD tray, contact Epson for support.
Parent topic: Solving CD/DVD Problems

Image Not Centered on CD/DVD

If your printed image is not centered on the disc, adjust the print position using the Epson Print CD
software. See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Related tasks

Printing Your CD/DVD Design - Windows

Printing Your CD/DVD Design - OS X

Printing Photos from a Memory Card Onto a CD/DVD

Image Does Not Cover Printable Area of Disc

If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the edge of the
center hole, you may need to adjust the Inner/Outer Diameter Setting in the Epson Print CD software.
See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Related tasks
Printing Your CD/DVD Design - Windows
Printing Your CD/DVD Design - OS X

Ink Smears on CD/DVD

If you notice smeared ink on your disc, try these solutions:
» Make sure you are printing on ink jet-printable CDs or DVDs and that the surface of the disc is dry.
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* Handle printed discs carefully and let them dry for 24 hours before inserting them in a drive.

» Adjust the print quality using the Epson Print CD software. See the Epson Print CD help utility for
details.

Parent topic: Solving CD/DVD Problems

Related tasks
Printing Your CD/DVD Design - Windows
Printing Your CD/DVD Design - OS X

Faint Image on CD/DVD

If your printed image is faint, adjust the print quality using the Epson Print CD software. See the Epson
Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Related tasks
Printing Your CD/DVD Design - Windows
Printing Your CD/DVD Design - OS X

Solving Faxing Problems
Check these solutions if you have problems faxing with your product.

Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product

Parent topic: Solving Problems

Cannot Send or Receive Faxes
If you cannot send or receive faxes, try these solutions:
* Make sure the recipient's fax machine is turned on and working.
» Make sure paper is loaded correctly in your product.

» Make sure you have set up your header information and have not blocked your caller ID. Otherwise,
your faxes might be rejected by the recipient's fax machine.

* Make sure Auto Answer mode is turned on to receive faxes automatically. Check your product control
panel to see if this mode is turned on.

» Check that the cable connecting your telephone wall jack to your product's LINE port is secure.
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» Print a fax connection report using your product control panel or fax software to help diagnose the
problem.

» Verify that the telephone wall jack works by connecting a phone to it and testing it.

« Ifthere is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line
or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
turn off the product's dial tone detection setting. (Turning off the dial tone setting may cause the
product to drop the first digit of a fax number.)

+ If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to
enable faxing over the line. Contact your DSL provider for the necessary filter.

« If your telephone line has static, turn off your product's error correction mode fax communication
setting and try faxing again.
» Try lowering your product's fax speed setting.

» Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a
color fax.

« If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to
prevent disruption of incoming faxes.

* If you have subscribed to a call forwarding service, the product may not be able to receive faxes.
Contact your service provider for assistance.

Note: If your product is connected to a VolP (Voice over Internet Protocol) phone line, keep in mind that
fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax
transmission will work when using VolP.

If your phone line includes voice mail answering services, calls or faxes may be inadvertently received
by your voice mail service.

Parent topic: Solving Faxing Problems

Related tasks

Connecting a Telephone or Answering Machine
Receiving Faxes Automatically (Auto Answer)
Viewing Faxes on the LCD Screen

Selecting Fax Communication Settings

Printing Fax Reports

Loading Paper in Cassette 2 (Lower Cassette)
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Cannot Receive Faxes with a Telephone Connected to Your Product
If you cannot receive faxes when a telephone is connected to your product, try these solutions:
* Make sure your telephone is connected to your product's EXT port.
* Make sure the Receive Mode is set to Manual.

Note: When answering a call that is a fax, wait until the product's LCD screen displays a message that a
connection has been made before you hang up.

Parent topic: Solving Faxing Problems

Related tasks
Connecting a Telephone or Answering Machine

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - OS X

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.
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* Windows (other versions): Click E" or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
* Windows 8.x: Select Epson Event Manager and click Uninstall.

* Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and
Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

* Windows XP: Open the Windows Control Panel utility. Double-click Add or Remove Programs.
Select Epson Event Manager and click Change/Remove.

5. Do one of the following to uninstall Epson Scan, then follow any on-screen instructions:
* Windows 8.x/Windows 7/Windows Vista: Select EPSON Scan and click Uninstall/Change.
* Windows XP: Select EPSON Scan and click Change/Remove.

6. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
Double-click the Uninstaller icon.
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Select the checkbox for each software program you want to uninstall.
Click Uninstall.
Follow the on-screen instructions to uninstall the software.

® N o O

To reinstall your product software, see the Start Here sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

+ U.S.: (562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday

» Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
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Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life products. Please go to this site for information on
how to return your products for proper disposal.

Windows System Requirements
OS X System Requirements
Automatic Document Feeder (ADF) Specifications
Scanning Specifications

Paper Specifications

Printable Area Specifications

Ink Cartridge Specifications

Fax Specifications

Memory Card Specifications
External USB Device Specifications
Dimension Specifications

Electrical Specifications
Environmental Specifications
Interface Specifications

Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 10

* Windows 8.x

* Windows 7

* Windows Vista

* Windows XP Professional x64 Edition
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¢ Windows XP SP3

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

OS X System Requirements
To use your product and its software, your Mac should use one of these operating systems:
+ OS X 10.10.x

OS X 10.9.x

OS X 10.8.x

OS X 10.7.x

0S X10.6.8

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications

Paper size US letter, legal, or A4 size

Paper type Plain paper

Paper weight 17 Ib (64 g/m?) to 64 Ib (95 g/m?)
Sheet feeding capacity Total thickness: 0.12 inch (3 mm)

Approximately 30 sheets (US letter or A4) or 10 sheets (legal)
Parent topic: Technical Specifications

Scanning Specifications

Scanner type Flatbed
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Photoelectric device

Maximum document size

Scanning resolution

Color depth

Light source

CIS

8.5 x 11.7 inches (216 x 297 mm)

US letter or A4

4800 dpi (main scan)

4800 dpi (sub scan)

Color:

48 bits per pixel internal (16 bits per pixel per color internal)
24 bits per pixel external (8 bits per pixel per color external)
Grayscale:

16 bits per pixel internal

8 bits per pixel external

Black-and-white:

16 bits per pixel internal

1 bit per pixel external

LED

Parent topic: Technical Specifications

Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a

sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Paper types
Weight

Envelopes

Size

Plain paper and paper distributed by Epson
Plain paper: 17 Ib (64 g/m?) to 24 Ib (90 g/m?)

No. 10 (4.1 x 9.5 inches [105 x 241 mm])
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Weight 20 Ib (75 g/m?) to 24 Ib (90 g/m?)
Parent topic: Technical Specifications
Printable Area Specifications
Note: Print quality may decline in the shaded areas shown here due to the printer mechanism.

Single sheets - normal printing

- Nrzz) | —

7221
' It

1 Margin: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 1.61 inch (41 mm) minimum
3  Reduced print quality area/bottom: 1.46 inch (37 mm) minimum
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Single sheets - borderless printing

000,

D220

1 Reduced print quality area/top: 1.73 inch (44 mm) minimum
2 Reduced print quality area/bottom: 1.57 inch (40 mm) minimum

Envelopes

—'L'V// I—

 \)—

H H

1 Left/right margins: 0.12 inch (3 mm) minimum
2  Top/bottom margins: 0.20 inch (5 mm) minimum
3 Reduced print quality area/right: 0.71 inch (18 mm) minimum
4  Reduced print quality area/left: 1.61 inch (41 mm) minimum
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CD/DVD

1 Minimum inner margin: 0.71 inch (18 mm)

2 Inner reduced print quality area: 1.69 inch (43 mm)
3 Outer reduced print quality area: 4.57 inch (116 mm)
4 Maximum outer margin: 4.72 inch (120 mm)

Parent topic: Technical Specifications
Ink Cartridge Specifications

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black, Photo Black, Cyan, Magenta, Yellow
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Cartridge life

Temperature

Opened package: 6 months

Unopened package: do not use if the date on the package has
expired

Storage: —22 to 104 °F (=30 to 40 °C)

1 month at 104 °F (40 °C)

Ink freezes at 3.2 °F (—16 °C)

Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Fax Specifications

Fax type
Support line

Speed
Resolution

Page memory
Redial

Interface

Walk-up black-and-white and color fax capability (ITU-T Super
Group 3)

Standard analog telephone lines and PBX (Private Branch
Exchange) telephone systems

Up to 33.6 kbps

Monochrome

Standard: 203 pixels per inch x 98 lines per inch

Fine: 203 pixels per inch x 196 lines per inch

Photo: 203 pixels perinch x 196 lines perinch

Color

Fine: 200 x 200 dpi

Photo: 200 x 200 dpi

Up to 180 pages (ITU-T No. 1 chart in monochrome draft mode )

2 times (with 1 minute intervals); specifications depend on country
and region

RJ-11 Phone Line
RJ-11 Telephone set connection

381



Parent topic: Technical Specifications

Memory Card Specifications

Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.

Compatible types/Maximum miniSD*: 2GB
capacities mMiniISDHC*: 32GB
microSD*: 2GB
microSDHC*: 32GB
microSDXC*: 64GB
SD: 2GB
SDHC: 32GB
SDXC: 64GB
Voltage requirements 3.3 V type, dual voltage type (3.3 V and 5V); supply voltage 3.3V
Maximum current: 200 mA

Parent topic: Technical Specifications

External USB Device Specifications
Do not use devices with the following requirements:
» Dedicated driver
» Security settings, such as password or encryption, etc.
* Built-in USB hub

Note: Use only external storage devices with independent AC power sources. External storage devices
that are powered via USB are not recommended. Epson cannot guarantee the operation of externally
connected devices.

CD-ROM/CD-R drive 700MB maximum capacity
CD-RW is not supported
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DVD-ROM/DVD-R drive 4.7GB maximum capacity
DVD-RW, DVD+R, DVD+RW, DVD-RAM, and Blu-ray Disc are not

supported
Magneto-optical drive 1.3GB
Hard disk and USB flash 2TB

drives Formatted in FAT, FAT32, or exFAT.

Parent topic: Technical Specifications

Dimension Specifications

Height Stored: 7.5 inches (191mm)
Printing: 8.1 inches (207mm)
Width Stored: 15.4 inches (390 mm)
Printing: 17.2 inches (438mm)
Depth Stored: 13.3 inches (339 mm)
Printing: 23.5 inches (598mm)
Weight 18.11b (8.2 kg)

(without ink cartridges, power
cord, and CD/DVD tray)

Parent topic: Technical Specifications

Electrical Specifications

Power supply rating 100to 120 V
Rated frequency range 50/60 Hz
Rated current 0.7A
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Power consumption Standalone copying: Approximately 16 W (ISO/IEC24712)
(USB connection) Ready mode: Approximately 8.3 W

Sleep mode: Approximately 1.4 W

Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications
Environmental Specifications

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (—20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

For computer Hi-Speed USB

For external USB and Hi-Speed USB
PictBridge devices

Note: Epson cannot guarantee the operation of externally connected devices.
Parent topic: Technical Specifications

Network Interface Specifications
Wi-Fi

Standards IEEE 802.11 b/g/n
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Security

Frequency range
Coordination modes

Ethernet

Standard

Communication mode

Connector

Security Protocol

WEP (64/128 bit)

WPA-PSK (AES); complies with WPA2 with support for WPA/WPA2
Personal

2.4 GHz

Infrastructure mode

Ad hoc mode (not supported for IEEE 802.11n)
Wi-Fi Direct (not supported for IEEE 802.11b)

Note: Simple AP mode is compatible with Wi-Fi infrastructure mode
and Ethernet connections.

IEEE802.3i/u (10BASE-T)
IEEE802.3u (100BASE-TX)

IEEE802.3az (Energy Efficient Ethernet; connected device should
be IEEE802.3az compliant)

Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100 Mbps Full
duplex, 100Mbps Half duplex

RJ-45

SSL/TLS: HTTPS Server/Client, IPPS
Parent topic: Technical Specifications

Safety and Approvals Specifications

United States

Canada

Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEV/IEC CISPR 22 Class B
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This equipment contains the following wireless module:
» Manufacturer: Askey Computer Corporation.
* Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life products. Please go to this site for information on
how to return your products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks

Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions

Ink Cartridge Safety Instructions
Wireless Connection Safety Instructions
Telephone Equipment Safety Instructions
LCD Screen Safety Instructions

Parent topic: Notices

General Product Safety Instructions
» Be sure to follow all warnings and instructions marked on the product.
» Use only the type of power source indicated on the product's label.

» Use only the power cord that comes with the product. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

» Place the product near a wall outlet where the plug can be easily unplugged.

* Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system
that regularly switches on and off, or on an outlet controlled by a wall switch or timer.

» Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,
crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.
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If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

Place the product on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Allow space behind the product for the cables, and space above the product so that you can fully raise
the document cover.

Leave enough space in front of the product for the paper to be fully ejected.

Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place or store the product outdoors.

Do not place the product near excessive heat sources or in direct sunlight.

Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the product away from potential sources of electromagnetic interference, such as loudspeakers
or the base units of cordless telephones.

When connecting the product to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

Do not touch the flat white cable inside the product.
Do not move the print head by hand; this may damage the product.
Do not spill liquid on the product or use the product with wet hands.

Do not use aerosol products that contain flammable gases inside or around the product. Doing so may
cause fire.

Do not press too hard on the document table when placing originals.

Do not open the scanner section while the product is copying, printing, scanning, or performing any
other functions.

Be careful not to trap your fingers when closing the document cover or scanner.
Except as specifically explained in your documentation, do not attempt to service the product yourself.
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Unplug the product and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged,; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the product from printing.

Before transporting the product, make sure that the print head is in the home (far right) position and
the ink cartridges are in place.

When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Do not put your hand inside the product or touch any cartridges during printing.

Install a new ink cartridge immediately after removing an expended one. Leaving cartridges
uninstalled can dry out the print head and may prevent the product from printing.

Do not remove or tear the label on the cartridge; this can cause leakage.

Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to
become unusable.

Do not break the hooks on the side of the cartridge when removing it from the packaging.
Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
Do not shake cartridges after opening their packages; this can cause them to leak.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in
the same environment as the product. Note that there is a valve in the ink supply port, making covers
or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge
touches. Do not touch the ink cartridge ink supply port or surrounding area.

Use an ink cartridge before the date printed on its package.
Do not dismantle an ink cartridge. This could damage the print head.
Store ink cartridges in a cool, dark place.
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+ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.

» Store ink cartridges with their labels facing upward. Do not store cartridges upside down.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk
of fire, electric shock, and personal injury, including the following:

* Do not use the Epson product near water.

+ Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from
lightning.

» Do not use a telephone to report a gas leak in the vicinity of the leak.
Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.
Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
» Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

» Ifthe LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

» Do not press too hard on the LCD screen.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: Important Safety Instructions
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FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line.
Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number
of devices that may be connected to a line, as determined by the total RENs, contact the local telephone
company. For products approved after July 23, 2001 , the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a
decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. But if advance notice isn't practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit
www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this
equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you
disconnect the equipment until the problem is resolved.
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This equipment may not be used on coin service provided by the telephone company. Connection to
party line service is subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the
installation of this equipment does not disable your alarm equipment. If you have questions about what
will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including fax machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. (The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, click the link below for instructions on entering
fax header information.

According to the FCC's electrical safety advisory, we recommend that you may install an AC surge
arrester in the AC outlet to which this equipment is connected. Telephone companies report that
electrical surges, typically lightning transients, are very destructive to customer terminal equipment
connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
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equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

1. This product meets the applicable Industry Canada technical specifications.

2. The Ringer Equivalence Number is an indication of the maximum number of devices allowed to be
connected to a telephone interface. The termination on an interface may consist of any combination of
devices subject only to the requirement that the sum of the RENSs of all the devices does not exceed five.

CAN ICES-3(B)/NMB-3(B)
Le présent matériel est conforme aux spécifications techniques applicables d’Industrie Canada.

L’indice d’équivalence de la sonnerie (IES) sert a indiquer le nombre maximal de terminaux qui peuvent
étre raccordés a une interface téléphonique. La terminaison d’une interface peut consister en une
combinaison quelconque de dispositifs, a la seule condition que la somme d’indices d’équivalence de la
sonnerie de tous les dispositifs n’excéde pas 5.

CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Related tasks
Entering Fax Header Information

Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
Connect™, Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Epson Store®™ is a service mark of Epson America, Inc.

Apple, iPad, iPhone, iPod touch, Mac, and OS X are trademarks of Apple Inc., registered in the U.S. and
other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

Google® is a registered trademark and Android™, Chromebook™, Google Chrome™, Google Cloud
Print™, and Picasa™ are trademarks of Google Inc.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
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General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
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certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets

Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution
© 2015 Epson America, Inc.
9/15
CPD-42851R1
Parent topic: Copyright Notice
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